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Notice

The material contained in this manual is believed adequate for the in-
tended use of this instrument. If the instrument or procedures are used
for purposes other than those specified herein, confirmation of their
suitability must be obtained from TA Instruments. Otherwise, TA
Instruments does not guarantee any results and assumes no obligation or
liability. This publication is not a license to operate under or a recommen-
dation to infringe upon any process patents.

TA Instruments Instrument, Data Analysis, and Utility Software and their
associated manuals are proprietary and copyrighted by TA Instruments,
Inc. Purchasers are granted a license to use these software programs on
the instrument and controller with which they were purchased. These
programs may not be duplicated by the purchaser without the prior
written consent of TA Instruments. Each licensed program shall remain
the exclusive property of TA Instruments, and no rights or licenses are
granted to the purchaser other than as specified above.
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TA Instruments License Agreement

This License Agreement is your proof of license. Please treat it as valuable property.

This is a legal agreement between you (either an individual or an entity) and TA Instruments. By breaking the
seal on your disk/CD-ROM package and/or loading this software, you agree to abide by the terms and condi-
tions of this agreement. Failure to comply with the terms of this license terminates the agreement and your rights
to use this software.

TA Instruments Software License

L.

GRANT OF LICENSE. This TA Instruments License Agreement (“License”) permits you to use one copy of the
specified version of the TA Instruments instrument control software product identified above (“SOFTWARE”),
provided the SOFTWARE is in use on only one computer at any time. If you have multiple Licenses for the
SOFTWARE, then at any time you may have as many copies of the SOFTWARE in use as you have Licenses.
If the anticipated number of users of the SOFTWARE will exceed the number of applicable Licenses, then you
must have a reasonable mechanism or process in place to assure that the number of persons using the
SOFTWARE concurrently does not exceed the number of Licenses.

Universal Analysis and Rheology Advantage data analysis software is not restricted to use on only one
computer. These programs may be installed on multiple computers for use provided it is for analysis of data
generated by the "licensed" controller.

COPYRIGHT. The SOFTWARE is owned by TA Instruments or its suppliers and is protected by United States
copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE like any other
copyrighted material (e.g., a book or musical recording).

OTHER RESTRICTIONS. This TA Instruments License Agreement is your proof of license to exercise the
rights granted herein and must be retained by you. You may not rent or lease the SOFTWARE, but you may
transfer your rights under this License Agreement on a permanent basis provided you transfer this License
Agreement, the SOFTWARE, security key(s), and all accompanying written materials and retain no copies, and
the recipient agrees to the terms of this Agreement. You may not reverse engineer, decompile, or disassemble
the SOFTWARE. Any transfer of the SOFTWARE must include the most recent update and all prior versions.

NO WARRANTY: The software and documentation are provided on an “as is” basis and all risk is with you.
TA Instruments makes no warranties, express, implied, or statutory, as to any matter whatsoever. In particular,
any and all warranties of merchantability, fitness for a particular purpose or non-infringement of third parties
rights are expressly excluded. Further, TA Instruments makes no representations or warranties that the soft-
ware and documentation provided are free of errors or viruses or that the software and documentation are
suitable for your intended use.

LIMITATION OF LIABILITY: In no event shall TA Instruments or its suppliers be liable to you or any other
party for any incidental, special, or consequential damages, loss of data, or data being rendered inaccurate, loss
of profits or revenue, or interruption of business in any way arising out of or related to the use or inability to use
the software and/or documentation, regardless of the form of action, whether in contract, tort (including
negligence), strict product liability or otherwise, even if any representative of TA Instruments or its suppliers
has been advised of the possibility of such damages.

The Oracle® software, used in conjunction with the Advantage Integrity software, is not included as part of the
TA Instruments' Advantage Integrity license agreement. Users of Oracle database software must abide by the

terms and conditions as specified by the Oracle Corporation.

This License Agreement represents the entire agreement concerning SOFTWARE between you and TA Instruments.
It supersedes any prior proposal, representation, or understanding between the parties.
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Trademarks and Patents

The following references apply to the information presented in this
document:

TA Instruments Trademarks and Patents

Q Series™ is a trademark of TA Instruments Waters—LLC, 109 Lukens
Drive, New Castle, DE 19720.

Modulated DSC® and MDSC® are registered trademarks of TA
Instruments Waters—LLC, 109 Lukens Drive, New Castle, DE 19720

Modulated DSC® and MDSC® are terms which describe proprietary
technology invented by Dr. Mike Reading of ICI Paints (Slough UK) and
patented by TA Instruments Waters—LLC (U.S. Patent Nos. B1
5,224,775;5,248,199; 5,335,993; 5,346,300).

Tzero™ is a trademark of TA Instruments Waters—LLC, 109 Lukens
Drive, New Castle, DE 19720.

Tzero™ describes proprietary technology invented by Robert Danley of
TA Instruments—Waters LLC and patented by TA Instruments—
Waters LLC (U.S. Patent No. 6,431,747).

Hi-Res™ is a trademark of TA Instruments Waters—LLC, 109 Lukens
Drive, New Castle, DE 19720.

Other Trademarks

Windows® NT, 2000, XP, 98, 98SE, Me, Microsoft Excel® and
Microsoft Word 97® are registered trademarks of the Microsoft Corpo-
ration.

Oracle® and Oracle9i™ are trademarks or registered trademarks of the
Oracle Corporation.
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Notes, Cautions, and \Warnings

NOTE:

¢ CAUTION:

wARNING

16

The following conventions are used throughout this guide to point out
items of importance to you as you read through the instructions.

ANQOTE highlights important information about equipment or procedures.

A CAUTION emphasizes a procedure that may damage equipment or
cause loss of data if not followed correctly.

AWARNING indicates a procedure that may be hazardous to the operator
or to the environment if not followed correctly.
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Chapter 1

Introducing the
Universal Analysis 2000 Program

Introducing
Universal Analysis

The TA Instruments Universal Analysis program for Windows NT® and
Windows 95/98/2000® is a powerful data analysis program that can be
used to analyze data from any of the following instruments:

»  DSC (Differential Scanning Calorimeter)

* High-Temperature DTA (Differential Thermal Analyzer)
*  SDT (Simultaneous Differential Technique) Analyzer

*  TGA (Thermogravimetric Analyzer)

*  DMA (Dynamic Mechanical Analyzer)

¢ TMA (Thermomechanical Analyzer)

* DEA (Dielectric Analyzer)

e uTA (Micro Thermal Analysis).

Any combination of signals can be plotted and analyzed using Universal
Analysis, with the signal type and units easily selected.

The program allows you to select the type and number of curves, region
to be graphed and analyzed, the type of transition analysis, and which
transitions to be analyzed. Each time you select a graphing or analysis
option, the program performs the necessary calculations and displays the
graph.

Windows 95® and Windows NT® are a registered trademarks of the
Microsoft Corporation.
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Introducing Universal Analysis

Learning the
Parts of the \Windows

When you open the Universal Analysis program, the first window that
appears contains an abbreviated menu and tool bar. After you open one
or more data files, the full menu, tool bar, etc. are displayed as shown in
the figure below. You can open up to ten Data File windows and one
curve overlay plot in Universal Analysis at one time.

To learn more information about the parts of the window, refer to the
table shown on the next page.

Minimize /Maximize /Close
Buttons

Title Bar Icon Window Title Bar

Main Menu

Universal Analysis
File Edit Rescale Graph Analyze Tools Yiew Window Help

ToolBer — S EESBAN L GEU ERMVVYAACL 4R

B2k
= - ol x]|
Data File Title Bar —— = - Trjsmm—gmy M= E
Zanple: FET uenched 1om be el D2 Flle ECT=0aky 0 Do LID

He atFEw i
1

Data File Graph Area

10 =0 X0

(==Y Tempr-ahge o

Urdwerral C2OF

Figure 1.1
Parts of the Window
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Table 1.1
Parts of the UA Window

Item

Description

Title Bar
Icon

Window
Title Bar

Minimize/
Maximize/
Close Buttons

Tool Bar

Data File
Title Bar

Data File
Graph Area

Main Menu

Pop-Up Menu

Use this icon to display a drop-down menu that
gives you control over the entire window. Double-
click on this icon to close a window.

Displays the title of the window and program.

The Minimize button allows the window to remain
open, but hides it from view (restore the window
from the Windows menu). The Maximize button
is used to size a window to its maximum size
(defined by the size of the controller window). The
Close button is used to shut the window.

The tool bar buttons perform various functions that
can also be found in the menus. They are a quick
way to access the operation desired. Position the
mouse over the button to display the fly-over
buttontitle.

The title bar of the Data File window displays the
name of the data file.

The graph area displays the plot of the points
contained in the data file. You can right click in this
area to display a pop-up menu.

The main menu contains the drop-down menu
items needed to operate the program.

(Not shown) To display a pop-up menu click the
right mouse button. There are several different
menus available throughout the program.
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Introducing Universal Analysis

Understanding
the Tool Bar

At the top of the Universal Analysis main window is a tool bar that allows
you to perform the same operations found in the menus with the click of a
button.

| B Universal Analysis [_ O] =]
i FEile Edit Bescale Graph Analyze Toolz Wiew ‘wWindow Help

BN EL SR L RERYVAATC SR ESR

Figure 1.2
General Tool Bar Buttons

The figure above shows the general tool bar setup. If you have trouble
remembering what the icons represent, just position the cursor over the
button and a small rectangle with the name of the button is displayed.
This is called “fly-over help,” and is also set up on the Main Options
window.

Customizing
the Tool Bar

You can customize the tool bar to reflect those options that you use most

frequently by selecting File/Options from the menu (or click the

button) to display the Main Options window. Click on the Tool Bar
page and set up the desired tool bar items.
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Understanding
the Main Menu

The main menu is used to access the

. . Univerzal Analpzis
various functions that can be performed

on the data file. When you first open
Universal Analysis, a limited menu =
(shown here) is available.

File ‘Window Help

u

After you have opened a data file, the
rest of the main menu options, shown in
the figure and listed in the table below,

are available.

- - [ i
s Universal Analysis o

File Edit BRescale Graph Analze Toolz: Miew Macros Window  Help

Description

Figure 1.3

Main Menu

Table 1.2

Main Menu Items
Menu Item
File
Edit
Rescale
Graph

Use the File menu to open a data file and perform
various functions such as closing any open win-
dows, saving analyses, exporting data, printing, etc.

Use the Edit menu to perform various editing
functions on the current graph such as deleting and
adjusting results, adding a scale bar and annotating
graphs.

Use the Rescale menu options to change the axis
scaling and zoom in on the portion of the graph that
will be analyzed.

Use the Graph menu to select options that allow
you to set up your graphs by changing signals,
units, parameters, data limits, overlaying curves,
etc. You can also switch to spreadsheet view.
(continued on next page)
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Introducing Universal Analysis

Table 1.2
(continued)

Menu Item

Description

Analyze

Tools

Macros

View

Window

Help

Use the Analyze menu to choose the type of
analysis that you want to perform on the current
data file. This menu reflects the type of analyses
available for the particular type of data file and
curve that is currently active.

Use the Tools menu to select from a list of differ-
ent types of functions that can be performed on the
current graph. You can smooth, shift, and/or rotate
the curve and perform a linear transformation on
either axis. If you change your mind you can
remove the curve shifts. You can also select a
baseline file using this menu.

This menu item is only available if the Auto-
analysis option is installed. Use the Macro menu
to choose from a menu of functions that can be
used to create and edit macros, which are used to
perform data analysis automatically. See also:
Using the Macros Menu.

Use the View menu to view and edit reports.

Use the Windows menu to arrange the currently
open windows in different configurations.

Use the Help menu to access help topics, an online
manual, and product information.

The first two items on the main menu, the File and Edit menus will be
discussed in this chapter. For information on the remaining menus, refer
to the appropriate chapter (see the Table of Contents).

22
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U S | n g th e Cpen... Zhr|4i0

Eeopen k
File Menu Close
Close Al
The File menu (shown here) is used to Remove Analysis. ..
open a data file and perform various Save Analysis s
functions, such as closing any open Save Sessian. ..
windows, saving analyses, remove Edit Pararn Block...
analysis results, etc. Options. .
. . . Export Plot, ..
For fu.rther 1nforma.t10n on each item Expoart PDF File. .
contained on the File menu, refer to the Export Data File N
table below.
Prirt. ., CErl4-P
Print Setup...
Print Presiew
Login...
Table 1.3 Exit
File Menu Options
Menu Item Description
Open Use the Open menu item to open a TA Instru-

ments data file for analysis using the Universal
Analysis program. See Chapter 2 for details.

Reopen Use the Reopen menu item to reopen a data file
that was recently closed.

Close Use the Close option to close the current window.

Close All Use the Close All option to close all of the open
windows.

Remove Use the Remove Analysis option to delete the

Analysis saved analysis record stored in the data file. See

Chapter 5 for more information.

Save Analysis | Use the Save Analysis option to save the current
analyses in the data file for future recall. See
Chapter 5 for more information.

Save Session | Use the Save Session option to save the current
state of the Universal Analysis program to a file
for future recall (i.e., curve overlay plot can be
saved). See Chapter 2 for more information.
(continued on next page)
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Introducing Universal Analysis

Table 1.3
File Menu Options

(continued)
Menu Item

Description

Edit Param
Block

Options (Main)

Export Plot

Export PDF
File

Export
Data File

Print

24

Use the Edit Parameter Block function to open a
window that allows you to edit the data file param-
eter block, then create and save it as a new data
file. We recommend that you do not overwrite the
original data file after editing the parameter block
information. The altered file may not open properly
if you edit the parameter block information incor-
rectly. If the file is not overwritten, you can go
back to the original data file without a problem.

Use the Options function to set up the main
program options available. See Chapter 3 for more
information.

Use the Export Plot option to export the current
graph to the clipboard for retrieval in another
program, or to export the graph to a file, plotter, or
printer. See Chapter 4 for more information.

Use the Export PDF File option to export the plot
in the form of an Adobe Portable Document
Format (PDF) file, which can be read by Acrobat
Reader.

Use the Export Data File option to export the file
signals and/or the plot signals in the form of a
binary data file, an ASCII data file, or a spread
sheet text file. See Chapter 2 for details.

Use this command to print a document. This
command presents a Print dialog box where you
may specify the range of pages to be printed, the
number of copies, the destination printer, and other
printer setup options. The format of the printed
plot is determined by the current settings for the
printer destination on the Export Plot window.
See “Exporting Plots” in Chapter 4 for more
details.

When the Print button, & , is used, the Print
dialog box is not shown. The print job is sent
directly to the system default printer.

(continued on next page)
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Table 1.3
File Menu Options

(continued)
Menu Item

Description

Print Setup

Print Preview

Login

Exit

Use this command to select a printer and a printer
connection. This command presents a Print
Setup dialog box, where you specify the printer
and its connection.

Use this command to display the active document
as it would appear when printed. When you
choose this command, the Print Preview window
is displayed. You can print from this window using
the File/Print command or close the window
without printing it.

Applicable only to 21 CFR 11 systems, this is used
to log into the 21 CFR 11 database management
system. See the online help or the 2/ CFR 11
Getting Started Guide for information.

Use this command to end your Universal Analysis
session.
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Introducing Universal Analysis

Using the
Edit Menu

The Edit menu (example shown Annotate. ..

here) is used to perform various Add Scale Bar...

editing functions on the current Adjust Last Result, ..

graph. The items appearing in the Delete Results »
menu will vary depending upon the Exclude Data...

signals plotted on the graph. Cycle List...

For further information on each item R T —————
contained on the Edit menu, refer to
the table below.

Table 1.4

Copy Plak k|12
Select Al Labels Chrl+8

File Infarmation. ..

Analysis Log Comment. ..

Edit Menu Options
Menu Item

Description

Copy Plot

Select

All Labels

File
Information

26

Use the Copy Plot option to copy the plot displayed
to the clipboard for retrieval by other applications.
The format for the copied plot is determined by the
current settings for the clipboard destination on the
Export Plot window. See “Exporting Plots” in
Chapter 4 for more information.

Use the Select All Labels option to highlight all of
the analysis result labels displayed. You can then
move them as a group to a different position on the
graph or delete them.

Use the File Information option to modify the
parameters on the Data File Information win-
dow. If only text items are changed, the data in
memory is not reloaded (i.e., current analyses are
not lost). If any other items are changed, the data
is reread from the file so the new values (e.g.,size,
cell constant) can be applied. These changes are
not saved to the original data file.

At the top of the File Information Window is the
data file’s run date, number of data points read
from the file, number of data points used to plot the
data (points saved in the data buffer), number of
data cycles in the file, and the data compression
ratio (points read divided by points used).
(continued on next page)
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Table 1.4

Edit Menu Options
Menu Item

Description

Annotate

Add Scale Bar

Adjust Results

Delete Results

/Last

/Select

/All

/Axis-1,2,3...

Use the Annotate option to access the Annotation
window, which allows you to place text on the
graph. See Chapter 4 for more information.

Use the Add Scale Bar function to add a labeled I-
bar to denote a unit of distance to the plot. When
you select this item the Scale Bar window is
displayed.

Use the Adjust Results option to fine tune the
position of the analysis tangent lines. This option is
available after you have performed one of the
following analyses: Integrate Peak, Glass
Transition, Step Transition, Onset Point,
Slope, Oxidation Time/Temperature, or Alpha
Fit X1 to X2. See Chapter 5 for details.

Use the Delete Results option to remove analysis
results from the graph displayed. See Chapter 5
for more information.

Use the Delete Results/Last option to delete the
last data analysis results placed on the plot.

Use the Delete Results/Select option to select an
analysis result for deletion. A dialog box is dis-
played for each analysis performed, allowing you
to decide whether or not you want to delete that
particular analysis.

Use the Delete Results/All option to delete all of
the current analysis results from the plot.

Use this Delete Results option to remove all of the
analysis results from the selected (active) Y axis.

(continued on next page)
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Introducing Universal Analysis

Table 1.4
Edit Menu Options

28

Menu Item

Description

Exclude Data

Edit/
Frequency/
Amplitude/
Location/Cycle
List

Analysis Log
Comment

Audit Trail
Comment

Use the Exclude Data option to remove or replace
the selected range of data points from the data
used for your analysis. It does not alter the data
file. Exclude Data can provide a way to create
very small data breaks between thermal cycles,
which allows each cycle to be distinguished using a
different symbol. See Chapter 2 for details.

Use this menu item to select the frequencies
(DMA and DEA), amplitudes (DMA), locations
(nTA), or cycles from the list of those contained
in the data file. The list of frequences, amplitudes,
or locations are displayed on the Frequency/
Amplitude/Location Selection window. See
Chapter 2 for more information.

Use this menu item to access the Analysis Log
Comment window, which allows you to add a
comment to the analysis log file for the current
data file. The comment is identified in the log

by “//” in front of the entered text.

Applicable only to Advantage Integrity systems.
See the online help or Advantage Integrity
Getting Started Guide for information.
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Opening a Data File

NOTE:

Figure 2.1

Chapter 2

Handling Data Files

The first step that must be performed when using the Universal Analysis
program is to open at least one data file or a session file. If you open a
session file, any files that are currently open will be replaced with those
contained in the session file.

Demanstration data files, located inthe TA\Data folder (default directory), have been
included with the software to allow you to practice using the program.

Follow the instructions below to locate and open a data or session file.

1. Click on the = button or select File/Open from the main menu.
The Open Data File window is displayed, see the figure below.

Dpen Data File EHE

Look jn: I 4 Dsc = ¥ Preview [ Alltest [T Quick open
201 Odsct.in] 2820dsce.in Cpsample.000 Mdsc1327 |Fun63
2910dsch. act 2920dsct sn Disc-cure, 001 Mdsc132, [Module DS Standard Cel
' - Sample PET [Quenched from the Melt]
2510dtab.epl 2520dtab.epl 53 D sc-pet. 001 Mdse-pet |Size 7 66800 ma
291 Ocltat. aul 2920dkat, aul | Dsc-pet. 007 0 Puiity.001 | [Method AT->300°C @ 10°Cmin
2920dsch.2p1 Cpbage. 000 Isokin, 001 B vestmth | [Dperator Applications Lsboratory
) . Comment He Purge=25ml/min

2920dscc.epl Cpealb.000 Mdse132.100 Tskin 001 | yothern Lp

Drate 10-hap-95
dl | ¥ [Time 1444
File narne: |Dsc-pet.DD1 Dpen I
Files of type: I.fl‘-.ll Files [*.%] j Cancel |
File path; C:5Progran FileshTA InstrumentzhTAND ata\DSC Help | 4| | _,,I

Open File Window

2. Click on the arrow next to the “Look in” drop-down list. Scroll

through the available folders until you locate the TA\Data folder (the
default directory), then select the desired instrument type folder.

Click on a data filename or hold down the Ctrl key and click on
multiple files to open more than one data file. (You can also hold
down the Shift key while clicking on files to select a block of files to
open.) NOTE: If you choose to open more than one file at a time,
the files are all opened using the Quick open option—skip step 4.
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Handling Data Files

30

Select from three checkboxes on the top right side of the window to
display information about the selected file in the area below the
checkboxes:

Preview — This option displays a brief list of parameter block
entries from the selected (highlighted) data file.

All Text — This option is used to display a complete list of the
parameter block entries from the selected (highlighted) data file.

The information displayed will include all data file information
plus signal and calibration information, etc. If the data file chosen
was stored in a spread sheet format, the data points from the file
will also be displayed when All Text is selected. If the file chosen
isnot a TA Instruments data file, Universal Analysis will display
any text found in the file up to the first form feed character
encountered.

Quick Open — This option is used to open and plot the data file
immediately after the Open button is clicked, without first viewing
the Data File Information window for that file.

Click Open. The Data File Information window is displayed,
allowing you to confirm the information contained in the data file or
the session file is initiated, which replaces any currently open files
with those contained in the session file.

Tip: You can sort your files in this window by clicking on the

at the top of the window to display the file details and a heading bar (seen
below). Click on any of the heading title buttons and the files will be
sorted by that classification. The sorting will toggle between ascending
order and descending order each time the button is clicked.

| M arne | Sizel Tvpe | kodified | .-'-‘-.ttril:nutesl
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Entering Data File Information

The first window displayed, after you select a data file to open, is the
Data File Information window, shown in the figure below.

Figure 2.2
Data File
Information Window

Data File Information

File:

|

Mame:  CATANData\DSCAD sc-petresults. 001 Signals...

Date:  10-May-95 14:44 s |
Hochie ype: e

DSC Standard Cell Diata Limits. . |

i Parameters:

Sample: |PET [Quenched from the Melt)

Size: IF".BEBD mg

Operator: I.fi‘-.pplications Labaratorny

Method: |F|T--> 300°C @ 10°Cemin

Cormment: IHe Purge=25mL/min

Exotherm:  [Lip - Cell Congtant; I‘I_E2‘|4 ¥ Bestore analysis

<< Previous | Same Ss | Cancel | Help

Successful analysis of the data is dependent upon the information con-
tained in this window. You need to verify and/or correct this information
before beginning the analysis.

Follow the steps below to use this window:

1.

Verify or edit the sample name, sample size, operator, method used,
and comments on this file.

Click on the drop-down list to choose the direction desired for the
exotherm, ifapplicable.

Enter or edit the cell constant, if applicable.

If the data file contains saved analysis results, you can check the
Restore analysis checkbox to return the data file back to the state it
was in when Save Analysis was selected-it cancels any analysis and
rescale conditions selected after the analysis was saved.

Click on any of the buttons at the top of the window to change the:
Signals, Units, Instrument Parameters, or Data Limits.

Click the OK button when completed.

THerMAL ADvANTAGE UNivERSAL ANALYSIS OPERATOR'S MIANUAL 31



Handling Data Files

Table 2.1
Data File
Information Items

32

The following table provides a brief description of each item displayed on
the Data File Information window.

Item Description
File
Information This is a display-only field that shows the data file

Module Type

Sample Name

Sample Size

Operator

Comments

Method

Exotherm
Up/Down

name and date the file was generated.

This is a display-only field that shows the type of
instrument used to gather the data.

Enter the identification of the sample material used
in this experiment. Up to 32 characters may be
entered. This information will appear in the plot
header of the printed graph.

Enter the sample weight in the appropriate units.
This information will appear in the plot header of
the printed graph.

Enter the name used to identify the person con-
ducting the thermal analysis experiment. Up to 25
characters may be entered. This information will
appear in the plot header of the printed graph.

Enter additional text to help describe the experi-
ment, for example, sample treatment or experimen-
tal conditions could be included. Up to 64 charac-
ters may be entered. This information will appear
in the plot header of the printed graph.

Use this field to enter a short description of the
method used to gather this data file. A method file
contains an ordered list of segments that will
instruct the instrument's functions throughout the
course of the experiment. This information will
appear in the plot header of the printed graph.

Select Exotherm Up to plot your heat flow or
temperature difference data in the traditional TA
Instruments format, with the exothermic portion of
the curve in the upward direction. Select Exo-
therm Down to plot your data with the exothermic
portion of the curve in the downward direction.
(See the next section for an example.)

(continued on next page)
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Table 2.1

Data File
Information Items
(continued)

Item

Description

Cell Constant

Restore
analysis

OK Button
Cancel
Button

Help Button

Previous
Button

Units Button

Instr Params
Button

Cell Constant is a calibration factor used to adjust
the calorimetric response of a DSC cell or the
thermal expansion of a TMA. The cell constant is
the ratio of the known value to the measured
experimental variable. Typically, either the heat of
fusion of indium (DSC) or the expansion coeffi-
cients of aluminum or copper (TMA) are used.
The calibration is based on a run made in the
calibration mode using the experimental conditions
to be used in subsequent measurements.

Check this box to return the data file back

to the state it was in when Save Analysis was
selected—it restores any analysis and rescale
conditions selected if the analysis was saved.

Use OK to save the information entered on the
window.

Use the Cancel button to abort the operation.

Use Help to access Help information for the
window shown.

Use the Previous button to return back to the
Open Data File window, which allows you to
select and open a different data file.

Use the Units button to access the Unit Selection
window, which allows you to specify the units to
be used when the data is graphed.

Use the Instrument Parameters button, when
available, to access the Instrument Parameters
window for the data file displayed. This option is
only available when a DMA or Modulated DSC
file is opened.

(continued on next page)
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Handling Data Files

Description

Table 2.1

Data File

Information Items

(continued)
Item
Signals Button
Data Limits
Button
Same As
Button
NOTE:

Choosing an

Exotherm Direction

Use the Signals button to access the Signal
Selection window, which allows you to specify
signals from the data file to be graphed.

Use the Data Limits button to access the Data
Limits window, which allows you to specify a
region of the data to be graphed using either Full
Range, Time Limits, or Temperature Limits.

Use the Same As button to copy the settings used
in another file to the current file. The settings that
are copied include the signals and units selected,
graph options, baseline file (if applicable), smooth-
ing, and X-axis scaling.

The Same As button is only available when
multiple files are open.

The Exotherm list box, located on the Data File Information window
can be used to display the exothermic portion of your heat flow or
temperature difference curve in an upward or downward position. See
the examples below and on the next page.

Exothermn

Erdotherm

Crysallization

Figure 2.3
Example: Exotherm Up

34
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Figure 2.4

Erdotherm
Pz ft

Cryztallizatian

Excthemn

Example: Exotherm Down

Editing File Information

You can modify the parameters on the Data File Information window
by selecting Edit/File Information to display the File Information
window shown here. If only text items are changed, the data in memory
is not reloaded (i.e., current analyses are not lost). If any other items are
changed, the data is reread from the file so the new values (e.g.,size, cell
constant) can be applied. These changes are not saved to the original
data file.

File Information x|
Run date: 14-Sep-01 10:30 Cycles: 1
Paints read: 10752 Buffer size: 4000 points
Paintz used: 3795 Compression: 28t 1
Sample: IF'henau:etin 179.2 a/mal
Size: I'I 1820 mig
Operatar: |ﬁpplicatinns Laboratary
b ethod: IFIamp at 0.5 *Cmit
Cornrnent: IF'ure phenacetin doped with 0.7 mol % p-aminobenzoic acid
Exathern:  |Up - Cell Canztant: I‘I 0473
Cancel | Help
At the top of the File Information window is the data file's run date,
number of data points read from the file, number of data points used to
plot the data (points saved in the data buffer), number of data cycles in
the file, and the data compression ratio (points read divided by points
used).
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NOTE:

Switching

‘I The data buffer size can be changed using the Main Options - Data Page.

Follow these steps to change the file information:

NN R D=

Enter the desired sample name.

Enter the desired sample size.

Enter the desired operator name.

Enter the desired method description.

Enter the desired comments.

Select the exotherm direction for your plotted curve, if applicable.
Enter the desired cell constant, if applicable.

Select OK when finished.

Between Open Files

36

When you have opened more than one data file, you can switch back and
forth between them by using any one of the following methods:

Click on any exposed portion of the desired window to bring it to the
front.

Use the Windows menu to display a list of the open files, then click
on the desired file to bring it to the front.

Rearrange the windows so that they are all in view by using the
Windows/Tile option.

THeRMAL ADvANTAGE UNivERSAL ANALYSIS OPERATOR'S MIANUAL



Selecting Signals

When a data file is plotted, the graph displayed reflects the signal and
signal type for the x and y axes chosen. You can change the signals and
signal type before analyzing the file, if desired.

To select signals follow these steps:
1. Select Graph/Signals from the main menu (or the Signal button from

the Data File Information window). The Signal Selection window
(shown below) is displayed.

Signal Selection |
il
Signal:  [{xEEREERREE] Type: INu:urmaI j
e
Signal: INu:utLlsed j Type: INu:urmaI j
a3
Signal: INu:utLlsed j Type: INu:urmaI j
—rd:
Sighal: INu:utLlsed j Type: INu:urmaI j
H
€ Time [mir)
&+ Temperature [*C)
= Signal: IHeat Flow [ /q] j Type: INu:urmaI j
Ok I Save | Drefault | Cancel | Help |

Figure 2.5
Signal Selection Window

2. Click on the arrow to the right of the Signals field, then click on the
desired signal for the Y1 axis. (You can choose "None," if you do not

want to plota Y1 axis).

3. Click on the arrow to the right of the Type field, then click on the
desired signal type for the Y1 axis.

4. Repeat steps 2 and 3 for each remaining Y-axis.
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5. Click on the radio button next to the desired signal for the X axis.
You can choose from time, temperature, or from a drop-down list of
signals. If you make a selection from the Signals drop-down list, you
need to choose a Type as well.

NOTE: ‘ You can switch between the X-axis signals specified here (time, temperature, or
signal) using the Graph/X Axis function.

6. Click the Save button, if you want to use these as your new default
settings the next time a file of the same type is opened or click the
OK button to use these settings for this session only.

All derivative curves are automatically smoothed when the curve is
drawn. You can change the smoothing interval with Tools/Smooth. See

Chapter 4 for further information.

NOTE: ‘ If afile has already been opened and analyzed, selecting signals rereads the data file
and erases analysis results.
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Selecting Units

When graphing signals, you can change the units displayed. To select
units, follow these steps:

1. Select Graph/Units from the main menu (or the Units button from
the Data File Information window). The Units Selection window
(shown below) is displayed. This window is used to change the units
used for the selected signals.

Units Selection E |

—General
Time: min - Temperature: T - Frequency: Hz -
—DsC
Heat Flow: IW;"g "l Heat Capacity:  |J/g/°C i
~OTA
Difference: I"E.-’mg "I icronalks: Iqug "I
—TGA
Wweight: i -
—Tha
Dimengion: |pm i Offzet: IND offzet "l
Db
b odulus: MFa - Compliance: I prn” 24N i I Wizcosity: I tMPa*sec i |
I M Ate hd l I texdM A l I M etz A |
T
Coordinate: Ium "I
Save Drefauilt Cancel Helm

Figure 2.6
Units Selection Window
2. Click on the arrow to the right of the field to display a drop-down list
of available units for each type of instrument signal. You can click on
the Default button to have all units fields set to their default units
selection.

3. Click the Save button, if you want to use these as your new default
settings for the current instrument type or click the OK button to use
these settings for this session only.

NOTE: Ifthe default units are normalized units, and a zero sample size is specified, the
program willautomatically plot the data using the units that are not normalized.
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Units and
Unit Conversion

The Universal Analysis program can convert most primary signal units to
other units. Available unit conversions are shown on the Units Selection
window.

Unit Conversions

Temp(°F) = Temp(°C) x 9/5 + 32

Temp (K) = Temp(°C)+273.15
Area(mcal/sec) = Area(mW)/4.184

Area(W/g) = Area(mW)/size(mg)
Area(cal/sec/g) = Area(mW)/4.184/size(mg)
Area(°C/mg) = Area(°C)/size(mmg)

Area(%) = Area(mg) x 100%(mg)
Area(mm) = Area(um)/1000(pm/mm)
Area(%) = Area(um)x 100%/10000(pm)/size(mg)
Area(um/m) = Area(pm)x 1 E6(um/m)/size(mm)
Area(ppm) = Area(pm)x 1E6(ppm)/size(mm)

DSC Area Units

Units Area Units
mw mJ
mcal/sec mcal

W/g Jig
Cal/sec/g cal/g

DTA, TGA, TMA, DMA, DEA, pTA Area
and Data Type Units

Area yt
Units y
Derivative y/xX

2nd Derivative y/x?
3rd Derivative y/x*

where: x = current X-axis units
y = current Y-axis units
t = time units
3rd derivative units are the slope units for the 2nd
derivative curves.
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Modifying
Instrument Parameters

When you analyze DMA or MDSC data files you can modify the instru-
ment parameters that are used to calculate the data as follows:

1. Select Graph/Instrument Params. The DMA Instrument

Parameters or MDSC Instrument Parameters window, appropri-
ate for the instrument data file, is displayed.

Instrument Parameters |

Foizzon's ratio; ID.MD

Save | Drefault | Cancel | Help |
Figure 2.7
DMA 2980 Instrument Parameters Window
Instrument Parameters |
~MDSC phaze comection:—— | [ Phaze bazeline limitz:
&+ Mo carection
Start; (000
" Time limits
- Stop:  |CLO0
" Temperature limits
Save Default | Cancel | Help

Figure 2.8
MDSC Instrument Parameters Window

2. Select or edit instrument parameters displayed. See the next page for
information on Poisson’s Ratio and for information on the MDSC
phase correction.

3. Click on the OK button when completed.
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Poisson's Ratio

Poisson’s ratio is a DMA parameter that defines the ratio of transverse
contraction per unit dimension to the elongation per unit length, when the
sample is subjected to a tensile stress. You can select Poisson’s ratio by
selecting Graph/Instrument Params from the Universal Analysis
program’s main menu. The recommended parameters are:

e 0.5 for rubber materials
e 0.33 for metals
*  0.44 for most plastics.

Enter the value needed for the type of material being analyzed by the
program.

Performing MDSC® Phase Correction

What is Phase Correction?

Modulated DSC (MDSC®) analysis has generally been used to measure
the heat capacity (Cp) of a material. However, the MDSC technique can
also be used to calculate phase lag and its contribution to the measured
heat capacity signal. The Thermal Advantage Universal Analysis
program contains algorithms that allow you to calculate the Reversing
Heat Capacity and Nonreversing Heat Capacity signals, as well as the
phase corrected Reversing Heat Flow and Nonreversing Heat Flow
signals. Total heat flow is not affected by deviations in the heat flow
phase.

How Do | Perform MDSC Phase Correction?

42

MDSC phase correction can be done using the automatic calculations as
follows:

1. Gather the data. When you are gathering data to be analyzed for
MDSC phase correction, make sure that certain signals have been
saved to the data file. Use the Thermal Advantage Mode Param-
eters window in the DSC Instrument Control program to save the
following signals: Heat Flow, Reversing Heat Flow, Nonreversing
Heat Flow, Complex Heat Capacity (Cp), and Heat Flow Phase.

If the Complex Heat Capacity and Heat Flow Phase signals are

contained in the data file, the MDSC phase correction options will be
available during the use of the program.
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2. Start Universal Analysis and open the MDSC® data file.

3. Plot these signals using the Signal Selection window: Heat Flow,
Complex Heat Capacity (Cp), and Heat Flow Phase.

NOTE:
Reversing Cpis identical to Complex Cp and Kinetic Cp is equal to zero, untilthe
phase correction is performed.

‘ There are additional heat capacity signals, labeled "Reversing Cp" and "Kinetic Cp."

4. Determine where you wish to place the phase correction limits by
examining the signals. Use the Analyze/Curve Value function, if
necessary, to determine point values.

5. Select Graph/Instrument Params, then select the MDSC phase
correction mode and the start and stop limits on the Instrument
Parameters - MDSC window. The following phase corrections will
be performed on the curve:

*  The Heat Flow Phase signal is shifted and rotated to zero
baseline as specified on the Instrument Parameters - MDSC
window.

»  The Reversing Heat Capacity and Kinetic Heat Capacity signals
are calculated.

»  The original Reversing Heat Flow and Nonreversing Heat Flow
signals are recalculated with phase correction applied.

Choosing the Phase Correction Range

Part of the MDSC phase correction procedure involves choosing the
phase correction range. When selecting the limits to define the phase
correction range, you should consider the following factors:

* Transition of Interest - Phase lag is generally more predominant
during a transition, but negligible in the baseline region. Transitions
containing large kinetic (nonreversing) heat flows tend to contain the
highest degree of phase lag.

* Baseline and Purge Gas - The phase correction algorithm uses the
Heat Flow Phase signal to calculate the Reversing Cp and Kinetic
Cp signals. The accuracy of these signals depends on a flat Heat
Flow Phase baseline.
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If you use helium as the purge gas, the Heat Flow Phase baseline will be
flat with a slight positive slope. If you use nitrogen as the purge gas, the
decreased thermal conductivity of nitrogen can cause some baseline
curvature.

Narrow temperature ranges will also minimize the total degree of curva-
ture across the selected region.

Therefore, for the best phase correction results, select a narrow phase
correction range that contains a flat Heat Flow Phase baseline.
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Setting Up Your
Data for Analysis

The data contained in a data file can be selected for use in analyses in
many different configurations. You can select to use all or just part of
the data by setting limits on the data, choosing a certain amplitude or
frequency (if applicable), excluding particular data, etc. This section
provides information on ways to select the data you want to include in
your graph for analysis.

Choosing Data Limits

You can use the entire contents of the data file for analysis, or you can
place constraints on the amount and type of data used for analysis by
choosing specific data limits.

* Ifyou are starting from the Data File Information window, click
the Data Limits button to display the Data Limits window, shown in
the figure below. Select the radio button desired, then select the
desired values (when applicable) to place limits on the data.

Data Limits |
¥ Full range
" Time limits
" Temperature limits
= Cycle Limits
Cancel Help
Figure 2.9
Data Limits Window
» Ifyou are starting from an open data file, select Full Range
Graph/Data Limits from the main menu to Cursor. .
display the Data Limits menu (shown here). Time. ..
Choose from one of the options shown here Temperature. .
and described in further detail below. Cycle...

After you have selected the desired data limits, the
graph is redrawn using the limits chosen. From that point you can proceed
to customize or analyze the data, etc.
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NOTE:

NOTE:
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\When new data limits are selected, any existing analysis results or data modification
(Shift, Rotate, Linear Transformation, or Excluded Data) will be discarded.

Only data points that fall within the specified data limits are read fromthe data file
and stored inthe program data buffer. All other data points are unavailable for
plotting and analysis.

Full Range (Data Limits)

The Full Range data limits option is used to provide the entire range of
data points that are available in the data file for analysis. This option is
also used to update the data displayed from an active experiment.

Cursor (Data Limits)

The Cursor option is used to display markers that allow you to manually
select the data points that will be used for analysis.

1. Position the first marker at the beginning of the region you wish to
select.

2. Position the next marker at the end of the region you want to select.

3. Right click to display the pop-up menu and select Accept Limits (or
press the Enter key). The selected data range is read from the data
file and displayed.

Time (Data Limits)

The Time Limits option is used to limit the data used for analysis to a
specific time range of the data.

Temperature (Data Limits)

The Temperature Limits option is used to limit the data used for
analysis to a specific temperature range of the data.

Cycle (Data Limits)

The Cycle Limits option is used to limit the data used for analysis to a
specific data cycle range. This option is valid if you have any data breaks
or markers in your file, these can include the following:

*  Cycle marks (due to Mark Cycle End segments in a procedure)

o Data breaks due to gas switch or event mark (selected on the Main
Options — Data Page), or other data breaks.
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Excluding Certain Data

Removing or adjusting a range of data points can be used to correct
explainable anomalies in the data, or to provide a way to create very
small data breaks between thermal cycles, which allows each cycle to be
distinguished using a different symbol. For example, gas composition
changes, heat/cool steps, etc. can be distinguished using symbols. Use the
Edit/Exclude Data option to remove the selected range of data points
from the data used for your analysis. It does not alter the data file.

To remove data points, follow these steps:

1.

Select Edit/Exclude Data from the main menu. Markers will be
displayed on the graph.

Position the first marker at the beginning of the region you wish to
remove.

Position the next marker at the end of the region you want to remove.

Right click to display the pop-up menu and select Accept Limits or
press Enter. The curve is displayed with the selected data excluded.

Click on one of the following options:

*  Marked as invalid data: Use this option to remove the selected

data from the graph. When you click on this option on the
Exclude Data window, it results in the removal of the selected
data range from the graph, creating a discontinuous data region
between the selection limits.

This option provides a way to create very small data breaks
between thermal cycles, which allows each cycle to be distin-
guished using a different symbol.

* Fitted to a straight line: Use this option to remove the selected

data from the graph and have a straight line fitted in its place.
When you click on this option on the Exclude Data window, it
results in the removal of the selected data range from the graph
and the program draws a straight line between the data points
adjacent to the deleted data.

*  Smoothed and blended: Use this option to smooth and blend

the data chosen for exclusion. When you click on this option on
the Exclude Data window, the program smooths and blends the
selected data limits with the data adjacent to it. The range of
blending is approximately equal to the data exclusion range.
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*  Removed and blended: Use this option to remove the data
chosen for exclusion, then blend the adjacent data remaining.
When you click on this option on the Exclude Data window, the
program deletes the selected data limits, then blends that gap in
the graph with the data adjacent to it.

NOTE: Use caution when selecting the data exclusion range for all "blended" options. The
blending region extends over a range that is approximately three times the width of
the exclusion range. Transitions that are in close proximity tothe exclusion range
may be altered. If necessary, perform multiple smaller exclusions or select the
Fitted to a straight line option and then smoath and blend the region around the
straightline end points.

6. Select OK. The results will be displayed.

NOTE: L -
Torestore the graph to the original data, use Graph/Data Limits/Full Range.

After you have excluded the desired data, the graph is redrawn using the
data chosen. From that point you can proceed to customize or analyze the
data, etc.
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Selecting a Frequency,
Amplitude, Location, or Cycle

When a data file contains either breaks in the data, gas switch and event
markers, or multiplexed data (i.e., a family of curves within the data file,
such as multifrequency, multiamplitude, or multilocation curves), you may
want to selectively display one or more curves. This function is particu-
larly useful when performing data analysis.

Follow these steps to select a specific multiplex value:

1. Select Edit/Frequency List or Edit/Amplitude List or Edit/
Location List or Edit/Cycle List from the main menu. The appro-
priate window is displayed. Use this window (example shown below)
to select the frequencies, amplitudes, locations, or cycles that you
want to use for analysis from the list of those contained in the data

file.
Frequency Selcction Cycles are defined by any
Frequency [Hz]: breaks in the data (Data on/
2T T off regions) or gas switch
0.2 and event markers, if
1':'-5 Al enabled on the Main Options
2 — — Data Page.
5 Mane
10 E—
20 Cahicel
Figure 2.10 _ Hek
Frequency Selection Window

2. Select the desired value from the list displayed. At least one multiplex
value must be selected. You can use one of these methods:

e Click on the box next to the values desired.

¢ Click the All button to select all of the values contained in the list.

e Click the None button to clear all values, then check the one(s)
desired.

3. Click on the OK button when finished.
After you have selected the desired data, the graph is redrawn using the
data chosen. From that point you can proceed to customize or analyze the

data, etc. Analyses performed on unselected values are not lost. They are
restored when that value is selected again.
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Adding/Subtracting
Baseline Files

You can use two data files that have been obtained from the same
instrument and combine their data (by addition or subtraction) in a way
that enables you to create a new modified sample signal. File addition or
subtraction requires the use of two data files, a sample and a baseline
reference file, to create a modified sample signal(s).

Follow the steps below to either subtract or add the baseline:

1. Open the baseline reference file and plot the signals that will be used
to perform operations on the new data file.

2. Open the desired sample file and select the desired signals that will
be used to perform operations with the baseline file. (Or use Graph/
Params Same As to copy the parameters.)

3. Make sure that the sample data file window is currently active.

4. Select Tools/Baseline , ygpe

from the main menu. A 1 Dze-pet 001 PET [Quenched from the Mel]
list of the open, compat- 2 Dscpet 001 PET [Auenched from the el
ible files will be dis-

played as shown here.
(None is displayed when no baseline file is used.)

5. Click on the desired reference file to be used as the baseline. The
Baseline File window is displayed as shown in the figure on the
next page.

6. Check the desired signal(s) from those shown.
7. Click on the desired base: time or temperature (see below).

» Time Base enables the operation to be performed using data
values from the same point in time. If data values do not have
times that correspond exactly, the data points are interpolated.
This option is useful for cyclic data.

NOTE: Because this operation matches signal values on the basis of time alone, the sample

and reference baseline files should have the same time /temperature profile; that s,
they should have been created using the same methad.

50 THeRMAL ADvANTAGE UNivERSAL ANALYSIS OPERATOR'S MIANUAL



*  Temperature Base enables the operation to be performed using
data values that have the same temperature. If data values do not
have temperatures that correspond exactly, the data points are
interpolated. This option is useful for the majority of data files.

NOTE: ‘I The best results are obtained when heating rates are the same.
8. Click on the desired operation: add or subtract the baseline file.
9. Click the OK button. A baseline signal will be added to or subtracted

from each data file signal that has the same units. The resulting data
isdisplayed.

Baseline File |

—File:
E:A\TA\Data DS ChD sc-pet. 001

—Signalz:
[ Heat Flow [+'/g)
[ 1 it il
[ Wty
[ it lid

—Baze: COperation:

= Time  Add
& Temperature * Subtract

Cancel Help

Figure 2.11
Baseline File Window

NOTE: ‘I Those signals that are not compatible between the files are not used.
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Saving Analyses
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After completing your analyses, you can select File/Save Analysis/
Analysis Only to save just the current analysis and plotted data or File/
Save Analysis/Analysis and Data to save the analysis along with a
complete copy of the data file for future recall. When you select this
option, the standard Save As window is displayed, allowing you to select
a filename and location.

Saving just the analysis conserves disk space because the original data
file is not saved redundantly with the analysis. However, you will have to
locate/retrieve the original data file should you need to reread the data
after restoring the analysis. In this case, Universal Analysis will first
search for the data file in its last known location. If this search fails, then
the program will ask you to locate the file.

Once an analysis has been saved in a file, the analysis results can be
retrieved by checking the "Restore saved analysis" box on the Data File
Information window.

The difference between "Save Analysis Only" and "Save Analysis and
Data" is whether the original raw data is included to the saved analysis
outputfile.

* The "Analysis and Data" option outputs a complete copy of the
original data file with an extra data block appended to the end of the
file. This extra data block contains the saved analysis information
that is read by UA when an analysis is restored. If you do not check
the "Restore" checkbox on the Data File Information dialog, then the
data file is read as if there were no saved analysis block present; i.e.,
the original raw data is read, not the analyzed data.

*  When you save analysis using the "Analysis Only" option, the data
file is copied without the original raw data points. The saved analysis
block is then appended to this abbreviated file. If you restore the
analysis from this file then everything will look just the same as it
does from a file that includes raw data, except that you will not be
able to reread (New Data Limits, Signals, Units, etc.) the raw data
from this saved analysis file. In this case, Universal Analysis will
have to locate the original data file and read the data from that file.

This is why the file name at the top of a plot of the data shows the name
of the original data file when an "Analysis Only" file is restored, but
shows the name of the saved analysis file when an "Analysis and Data"
file is restored. If the program cannot locate the original data file associ-
ated with an "Analysis Only" file, then Universal Analysis will prompt you
to locate the original file.
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NOTE: Attempting to open a "Save Analysis Only" saved analysis file with the "Restore”
checkbox unchecked will resultinthe "Less than two pointsin file" error message
because thereis noraw data stored inthefile.

NOTE: Saved analyses that have been performed using the DOS version of Universal
Analysis are restorable using this program. However, if you overwrite the DOS
analyses with this program, the original record of analyses can nolonger be used
forthe DOS Universal Analysis program.

NOTE: You can also use the Export Data File window to save a modifiedfile.
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Exporting Data Files

Figure 2.12
Export Data
File Window
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Universal Analysis provides the ability to export the file signals and/or the
plot signals in the form of a binary data file, an ASCII data file, or a
spread sheet text file. This will let you use your data in other software
applications such as spread sheet programs and word-processing pro-
grams for reports, etc.

TIT5 Signals. ..

To export your data files, select File/Export
File Signals Ornly...

Data File from the main menu. The menu :
shown here is displayed. The menu items Elot Signals Only...
found on the Export Data File menu are used File and Plat Signals...
for the following purposes:

* TTS Signals: Use this option to export selected DMA or DEA
Time-Temperature Superposition (TTS) signals from the data file.

» File Signals Only: Use this option to export selected signals from
the data file only.

* Plot Signals Only: Use this option to export selected signals from
the plot only.

* File and Plot Signals: Use this option to export selected signals
from the data file and the plot.

Select one of the options described above, the Export Data File window
is displayed. See the figurebelow.

Export Data File |
—Output zignals: —File parameters:
[-1] Heat Flav (] Module Tepe: DSC

Run Date: 10-bap-95 14:44

Sample: PET [Auenched from the Melt]
Size: 78680 mg

Cell Constant: 1.6214

Erotherm: Up

Operator: Applications Labaoratory
Method: RT--»300°C @ 10°C/min
Comment: He Purge=25mL /min

—Options:
—Output farmat———— 1~ Character et ™ Mo parameter block
" Binamy data file * OEM [PC-8) [~ Mo data breaks or flags
" A5CI data file  Windows [ANS]) [~ Mo invalid data points
% Spreadsheet kext file Total data points: 980

Cancel Help
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Follow these instructions to continue with the export procedure:

1. Click to check or uncheck the output signals displayed. The checked
output signals will be exported. You can limit the output signals by
selecting only those signals that you want to save in the exported file.
(At least one signal must be selected.)

2. Click on the desired type of export file:

*  Binary format (standard file format) saves the files in a special
binary format. This format stores the data in an efficient, com-
pact form and preserves the method log information.

*  ASCII (American Standard Code for Information Interchange)
format saves the data file in a text format that allows the data file
to be imported into other software packages, or transmitted
conveniently through serial communication protocols.

*  Spread Sheet format saves the data file in a "tab-delimited"
spread sheet-compatible ASCII text format, which places the
data in columns. This format is compatible with most commercial
spread sheet programs. When importing or exporting this file
format, select "Tab delimited text" format in the spread sheet
program.

3. Choose the desired character set: OEM or Windows. Universal
Analysis can handle both the OEM (PC-8) and the Windows (ANSI)
character sets in data files. The OEM (PC-8) character set origi-
nated with the Disk Operating System (DOS) and the first personal
computers. The OEM character set contains the original 128 ASCII
characters plus an additional 128 special symbols (including the
degrees symbol, the micro symbol, etc). The Windows character set
was developed by Microsoft® Corporation for use with their Win-
dows operating system. The Windows character set also contains
the original 128 ASCII characters, but a different set of 128 special
symbols is used.

4. Click on the desired export options:

*  No parameter block exports the data file without any param-
eter block information. Note that if you check this option, the
exported file will not be able to be opened in Universal Analysis
as a data file, because there will no longer be any parameter
block information available. Leave this box unchecked (default)
to export your data file with the parameter block information
intact.
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NOTE:

NOTE:
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*  No data breaks or flags exports your data file without any data
breaks or data flags such as cycle markers, gas on/off changes,
or event on/off changes. This allows you to remove data breaks
that may hinder your use of the data in spread sheet applications.
When this item is checked, the minus time flags are removed
from the data and all points appear connected. Leave this box
unchecked (default) to export your data file as it is, with all data
breaks or flags intact.

*  No invalid data points removes any invalid data points that are
present in the data file from the exported data file. These invalid
points will be replaced with a single data break for each group of
invalid points. NOTE: If the option No data breaks or flags is
checked along with this checkbox, no data break will be inserted
in place of the invalid points in the exported data file. Leave this
box unchecked (default condition) to export your data file as it is,
with all invalid data points included.

5. Click on the Finish button when completed to specify an export
filename and location.

The data file information displayed on the window can be selected and copied, but it
cannotbe altered here. To change the data file information shown on the Export
Data File window, you must alter it on the initial Data File Information window
whenthefileisfirst opened.

This function also allows you to save data that has been modified with the options
foundinthe Tools menu and the Edit/Exclude Data menu (except the “Marked
asinvalid data” option).
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Saving a Session

NOTE:

After you have spent time setting up and configuring an overlay plot, you
may find that you would like to save all of that work so that you can
come back later and do more work on that plot. You can save the work
you have already done by saving the program session.

You can also use the Save Session function to save the current state of
the program, including all settings, open file information, and data read
into memory. This function can also be used to save the analysis results
from multiple data files into a single session file. This way you can turn
off or restart your computer, or let someone else use the program,
without losing the work you have already done. You can later restore the
program to the state it was in when you saved the session.

Select File/Save Session from the main menu. Then select the drive and
directory location and enter the filename. It is recommended that you
save session files using a specific extension that allows you to recognize
the session files (use .sav for example).

The data files will not be saved with the session file. The associated data files should
be saved separately. If the data files must be reread for a particular function
(changing data limits; smoathing curves; changing signals, units, orinstrument
parameters), the data file must be present—a session file alone will not suffice.

Recalling a Session

NOTE: ‘ |

To recall a saved session, simply open a session file using the File/Open
function. Any files currently open in the program will be replaced by the
ones contained in the session file.

Saved sessian files from the DOS Universal Analysis program cannot be opened with
this program. An error message will be displayed, if you attempt to open one.
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Editing Parameter Blocks

There may be times when

you would like to change the information that

is contained in the parameter block of a data file. Perhaps someone put
their name in as the operator and you would like to change it to your
company's name and use the file for a demonstration, etc. You can use
the File/Edit Param Block function to make an exact copy of the current
data file and to edit the parameter block information that is stored in the

new file.

Follow these steps to edit parameter block information:

1. Select File/Edit Param Block from the main menu. The Edit
Parameter Block window, shown in the figure below is displayed.

Edit Parameter Block E

CLOSED

WERSION 0.4

Run B3

todule DSC Standard C
Sample PET [Quenched
Size 7.86200 mg
Method RT-->300°C &1
O perator Applications La

Ewotherm Up

kel 1.62140

Cpconst 09654

Calib -46.97

TempCal 2 ptz 158.031

lznTrackTime 0.50
Threzholds 0.000 0.0001

Cell# 315
Mzig 3

4

Figure 2.13
Edit Parameter
Block Window

Comment He Purge=25mL/min
Foomment Pan: Aluminum Fazl: Mitrogen (@ Gaz: Mone (@
Texst PET quench coaled

B azelineCal -0.0035 -17.1000 b

Controlz Gaz 1 Event Off Sampling 0.2 zec/pt

FY

ell
from the Melt)

0°CArniny
boratary

5661, 23373 231.95

Cancel | Help |

2. Place the cursor in the text string that you wish to change and edit
the characters as desired.

NOTE: Itis best to edit onlythose parameters that you are familiar with. Editing sample

name, operator, comments,

etc. will not affect the handling of the data file. Some

parameters are used by the Universal Analysis program to perform certain
functions-those parameters can be altered also, but doing so may cause problems
inthe functioning of the program when the altered file is used.
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3. Click the Finish button to display a window that allows you to save
the new data file.

NOTE: We recommend that you do not overwrite the original data file after editing the
parameter blockinformation. The altered file may not open properly if you edit the
parameter blockinformation incorrectly. Ifthe file is not overwritten, you can go
back to the original file without a problem.

4. Enter the new filename and location. Then click Save.

NOTE: Ifthe current data file contains a method log or saved analysis, it will be copied to
the new datafile.

Setting Up
Windows for Display

While you are using the Universal Analysis program you may have
several data files open at the same time. You can arrange and size these
windows different ways for viewing.

Sizing Windows
To resize a window follow these directions:
Move the pointer over any outer edge or corner of the window until the
cursor becomes a double-headed arrow. Then hold down the left mouse

button and pull the mouse in the direction that you want to make the
window smaller or larger.

Arranging Windows

To rearrange the data file windows follow any of these directions:
*  You can manually drag the window by moving the pointer to the top
of the window's title bar, holding down the left mouse button and

dragging the window to its desired position.

*  You can use the Windows menu, as described in the next section, to
arrange the open data file windows.
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Using the Windows Menu

Tile

The Windows menu is used to arrange the cur-
LCazcade

rently open windows in different configurations. B Jees

Select the Windows menu (shown here) from the Stay On Top
main menu. v 1 Pec-1.001

_ 2 Pwe-2.002
The menu items found on the Windows menu are 2 Prwc-3.003

used for the following purposes:

o Tile: Use this command to arrange multiple opened windows in a
non-overlapped fashion. See the figure below for an example.

&2 Universal Analysis [_ O]

File Edt Rescale Graph Analyze Tools Wiew “Window Help

ZEEHAIEL S2LEUL RRBY VA
AT X E
[ =10l %]

&2 D=c-pet.001 Hil=]

ﬁ

Figure 2.14
Example of
Tiled Windows
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e Cascade: Use this command to arrange multiple opened windows in
an overlapped fashion. See the figure below for an example.

Universal Analysis

File Edt Rescale Graph Analyze Tool: Miew ‘Window Help
=EE 5 %k B lE 4 ZEZEM VWA
A A . i s L

& Dma-pet.001 [_ O]

Figure 2.15
Example of
Cascaded Windows

* Arrange Icons: Use this command to arrange the icons for
minimized windows at the bottom of the main window. If there is an
open document window at the bottom of the main window, then
some or all of the icons may not be visible because they will be
underneath this document window.

e Stay On Top: Check this function to keep the Universal Analysis
program window on top of any other open application windows.

e 1 Filename A, 2 Filename B, etc.: Click on the name of the file
desired to bring the chosen window to the front.
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Introduction

Chapter 3

Setting Program Parameters

The TA Instruments Universal Analysis program lets you set up certain
programming options that can be set and then recalled each time you
open the program. This chapter discusses these program parameters and
provides instructions on what each option is used for and how to set it up
the way you want it to be.

Setting Up Your Own Tool Bar

General Tool Bar Buttons

Universal Analpsis =]

File Edit Bescale Graph Analyze Toolz Yiew Window Help

ZHEHNELIEIBEEUL  EEMVVAAC L HRE %R

Figure 3.1
Main Options -
Tool Bar Page

Tool bars, such as the tool bar above, can be very useful objects, but only
if you can recognize and use the options that are displayed there. If the
options you use frequently are found on the tool bar, it is a very useful
tool. We kept that in mind when we designed the Universal Analysis
program. You can set up the tool bar that is displayed at the top of the
Universal Analysis window to suit your own needs as follows:

1. Select File/Options from the main menu. The Main Options -
Tool Bar Page is displayed.

Main Options [ %]

Toal Bar | Pop-Up Menul Farit I Colar I Data I Expart F’Iotl Directoriesl Initializationl QOther I

~Buttons: ~Options:
Open Data File = &l | ¥ Show tool bar
[] Reapen Data File
[[] Close Data Fils
[ Close All Files ﬂl EE
[ Remave Saved Analpsis
[ Save Analpsis DSC IV Flyover help
[J Save Session
[ Edit Parameter Block. TGA
[[] tain Options
[ Export Plot Thid
[ Export TTS Signals
[[] Export File Signals Only DMA
[] Export Plat Signals Only —
] Expart File and Plat Signals
Brirt ;I General |

Save Default Cancel | Help |
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2. Select the buttons that you want to display on the tool bar by using
one of two methods:

a. Check each desired function button name from the scrollable
button list shown. This list corresponds to the menu items per-
forming the same function.

or

b. Click on the button that selects the default functions that apply to
the button label. For example, you can click on the TGA button to
select the icons for the most common functions that apply to the
TGA instrument.

3. Check each option that you want to use for your tool bar: Show tool
bar, Flat buttons, Flyover help.

4. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session

only.

See the table below for an explanation of each of the items found on the
Main Options - Tool Bar Page.

Table 3.1
Tool Bar Page Options

Option

Description

All Button

None Button

DSC Button

TGA Button

64

Click this button to select all of the options shown.

Click this button to select none of the options
shown.

Click this button to select the buttons applying to
the most common functions available for the DSC
(Differential Scanning Calorimeter) for display on
the tool bar.

Click this button to select the buttons applying to
the most common functions available for the TGA
(Thermogravimetric Analyzer) for display on the
tool bar.

(continued on next page)
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Table 3.1
Tool Bar Page Options
(continued)

Option

Description

TMA Button

DMA Button

General Button

Show Tool Bar

Flat Buttons

Fly-over Help
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Click this button to select the buttons applying to
the most common functions available for the
TMA (Thermomechanical Analyzer) for display
on the tool bar.

Click this button to select the buttons applying to
the most common functions available for the
DMA (Dynamic Mechanical Analyzer) for
display on the tool bar.

Click this button to select the most common
functions that apply to all thermal analysis
instruments.

Check this box to display the tool bar on the main
window of the Universal Analysis program. If
the box is not checked, no tool bar is displayed.

Check this box to display the buttons in a one-
dimensional fashion (flat).

=

If the box is not checked, the buttons will display
with a three-dimensional look.

= el = 2

Check this box to display a small text box, called
fly-over help, containing the name of the button
as you move the pointer over the buttons. (This
type of help is also called tool tip help or screen
tip help.)

If this box is not checked, no fly-over help is
displayed.
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Customizing
the Pop-up Menu

After you have opened and graphed at least =~ PR
. . Save Analyziz...
one data file, you can display the main pop- o

up menu (shown here) by clicking the right
mouse button. You can customize the items ~_ #nnotate...
that appear on the main pop-up menu every Marual Fescale..

time the menu is displayed. You can set up Full Scale
the main pop-up menu to suit your own Sericls,.
needs as follows: Farams Same As "
Full Fange
1. Select File/Options from the main Ve Ut
menu, then click on the Pop-Up Menu _ "mperature Limis..
tab at the top of the window. The Main = Asis ¢
Options - Pop-Up Menu Page is Overlay v
displayed, see the figure on the next BirEsin Digims.,
page. Integrate Peak Linear...
|ntegrate Peak Sig Horizontal...
Peak Max...

2. Select the menu items that you want to

. . . Signal Max...
display by using one of two methods: Glass/Step Transition..
) Onzet Paint...
a. Check each desired menu name Oxidation Temp...
from the scrollable menu item list. Slope...
or Running Intearal...

b. Click on the button that selects the Curvs Value. .
default menu items that apply to the = Analysis Optians...
button label. For example, you can
click on the General button to use only the most common menu
items.

3. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session
only.

NOTE: Pop-up menu items that are selected for display, but are not valid when
the pop-up menu is activated will not appear.
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Main Options

Open Data File

[[] Reopen Data File

[] Cloze D1ata File

[ Cloze All Files

[] Remove Saved Analpsiz
Save dnalysiz

[[] Save Session

[ Edit Parameter Black
[T Main Ophions

[] Expart Plat

[] Export Drata File

[] Export TTS Signals

[] Expart File Signals Orly
[] Export Plat Signals Only
[] Expart File and Plat Signals

Figure 3.2
Main Options - Pop-up Menu Page
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Changing Fonts

Fonts can be changed in specific places in the Universal Analysis pro-
gram. You can change fonts that are used in printing out the graphs and
when viewing or printing reports. The displayed graph fonts cannot be
changed.

Use the Font page of the Main Options window to set up the fonts that
appear on the printed curve. Changing fonts here will not affect the
graphs displayed on your monitor. To check the size and position of the
text on the graph before it is printed, use the File/Print Preview option.

You can set up the fonts to suit your own needs as follows:
1. Select File/Options from the main menu, then click on the Font tab

at the top of the window. The Main Options - Font Page, shown
below, isdisplayed.

T~ |

Tu:u:uIEarI Pop-Up Menu  Fort IEDIu:ur I [rata I Ewpart F'Iutl Directoriesl Initializatiu:unl Other I

Plot Header Aral 12 AaBbYyiz 12.34°C

Overday/Custom | Aral 12 AaBbYyrz 12 34°C

fuisNames | Arial 14 AaBbYyZz 12.34°C

Tick Labels Aral 12 AaBbYy/z 12 34°C

Legend Arial 11 AzBhYyiz 12 34°C

Besults Arial 11 AzBhYyiz 12 34°C

Footer Arial 10 AaBbYyiz 12.34°C

Symbals wWingdings 11 ¥SRGeECE E=BAEF SRS

qddddda

Report Text Courier Wew 10 LaBh¥yZz 12.34°C

Save Drefault Cancel Help

Figure 3.3
Main Options - Font Page
2. Click on the button bearing the name of the part of the graph that will
have font adjustments. See the figure on the next page for the
location of these graph parts and the table for a description of each
item on the Font page.

68 THermAL ApvanTAge UNiversaL ANALYSIS OPERATOR'S MIANUAL



Dsc-pet. 001

Sample: PET (Quenched fromthe Meft) —8—____ =~ Header

Platkigend £it
| o=z St can

0.4

I [=] E3
DSC File: E:TAData'DSC Dsc-pet.001

135.21°C

0.2 - Legend
0.0 -
3
2 02
3 ]
o 130.07°C
g\tﬁ"ﬁ\ 313045 "= Results
= 1 Axis Names
-0.6 -
|
-0.8 —\ Tick Lahels
250.61°C
-1.0 . < . : .
0 50 100 150 200 250 300
Exo Up— Footer Temperature (°C) Universal ¥2.0F
Figure 3.4
Parts of a Graph
Table 3.2
Font Page Items
Item Description
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Plot Header
Button

Overlay
Header
Button

Axis Names
Button

Use this button to edit the font used for the
header appearing at the top of the graph. The
header includes the sample name and filename.
(Additional header information—size, method
name, comment, and date—appears on the
printed graph.)

Use this button to edit the font used for the
header appearing at the top of the printed
overlay graph. The header includes the
customizable text that is entered on the Curve
Overlay Options — Plot Heading Page.

Use this button to edit the font used for the axis
names appearing at the sides of the graph. The
axis names include the X- and Y-axis names.

(continued on next page)
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Table 3.2
Font Page Items

Item

Description

Tick Labels
Button

Legend Button

Results Button

Footer Button

Symbols

Button

Report Text
Button

Use this button to edit the font used for the tick
labels (usually numbers) appearing on the axes
of the graph. The tick labels include both the x-
and y-axis tick labels.

Use this button to edit the font used for the
legend appearing on the graph. See “Creating
Plot Legends” in Chapter 4 for information on
setting up a legend.

Use this button to edit the font used for the
results appearing on the graph after an analysis
has been performed.

Use this button to edit the font used for the
footer information appearing at the bottom of the
graph. The footer includes the exotherm direc-
tion and program name and version.

Use this button to select the font contained in
the Edit Custom symbol list. The symbols can be
used to differentiate curves and axes.

Use this button to edit the font used for the
Report Editor. The font can also be changed
using the Report Editor's Edit/Font menu.

3. Select the desired font, font style, and size using the Font window
displayed, see the figure on the next page.

70

THermAL ApvanTAge UNiversaL ANALYSIS OPERATOR'S MIANUAL



-

Eont: Faont style:

IM IHeguIar s I
Aial Black — [talic Cancel |

B Avial Mamow Bald

T Avial Bounded MT Bol: Boald Italic
B Ashley Script MT

T AvvantlGarde

H Baskervile BE Bold 7]

— Sample

AaBbYyysz

Script;

I'W'estern ;I

Figure 3.5
Font Window

4. Repeat step 3 for the desired parts of the graph.

5. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session
only. The font(s) will be applied to the selected portion(s) of the
graph.

NOTE: It is recommended that only True Type (TT) fonts be used. True Type
fonts are always scalable to all sizes on all output devices.
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Selecting Program Colors

Colors can be used to help add interest to your graphs and analysis
presentations. You can set up the colors that will be used each time the
Universal Analysis program is started. Follow the directions below to set
up the default colors to be used for your plots, axes, results, and base-
lines.

You can set up the colors to suit your own needs as follows:

Selecting Individual Colors

1. Select File/Options from the main menu, then click on the Color tab
at the top of the window. The Main Options - Color Page is
displayed as seen in the figure below.

Main Optionsz x|

TDDIBarI Pop-Up Menul Font  Color |Data I E xpart F'Iu:ntl Directoriesl Initializationl Other I
—Flat: A —Multicolor:
Header/Footer: I- Black 'I Y1 I- Green 'I 1: I- Blue v|
Background: I | wihite vI Y2 I | vI Z I- Red ]"
i awis: I M Elack 'I Y3 I M taroon 'I < I M Green jv
4; I-Fuchsia v|
Grid: I I Silver vI 4 I W Fuchsia vI
a I- Black v|
Graphic curzor: I B Red 'I : Iﬁ
Bassine: B: W M aroon
- b air: I- Fed 'I E IJ Aqua 3
g I- Olive v|
Label text: I M Elack vI Tangent: I M Elack vI
g IJ Lime vl
Fit lire: I M Elack 'I Front peak: I M Ele 'I 10 Im
Highlight: I- Red vI Back peak: I- Blue vI 11 I- Mavy v|
12 I | ellow v|
Scheme: |WwinlA Classic white |7
Save Drefault | Cancel | Help |

Figure 3.6
Main Options - Color Page

2. Click the down arrow to display the drop-down list of colors for the
item that you wish to set up.

3. Click on the desired color for that item.
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4. Repeat steps 2 and 3 for each item that you want to set up.
Multicolor is used to set up the "multicolor" option that is available to
apply colors to curves in normal and overlay plots. (This choice is
available on the Graph Options window, Curve Overlay Options -
Curves Page, and normal Plot Legend window.) You can select a
color to apply to up to 12 corresponding cycles in the data. If more
than 12 cycles exist in the data, the colors in the list will be repeated.

5. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session
only. The color(s) will be applied to the selected portion(s) of the
graph.

Selecting Color Schemes

1. Select File/Options from the main menu, then click on the Color tab
at the top of the window. The Main Options - Color Page is
displayed.

2. Click on the down arrow to display the drop-down list of color
schemes that you can use for the entire program.

3. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session
only. The color(s) will be applied to the selected portion(s) of the
graph.

NOTE: Click the Default button to return all of the colors to their original
factory settings.
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Choosing Data
Handling Options

When you start the Universal Analysis program for the first time, the data
files are opened using the factory default settings. You can change the
way the data files are handled by using the Main Options - Data Page.
You can set the data options as desired and they will be applied each time
you open the program.

Follow these steps to set up the data options:

1. Select File/Options from the main menu, then click on the Data tab
at the top of the window. The Main Options - Data Page is
displayed as seen in the figure below.

Main Options
TnoIBarI Foplp Menul Fant I Color  Data IE:-:port F'Intl Directoriesl Initializatinnl Other I

Rk exatherm:
& Up

= Down

rDSC and DTA derivative:—
f+ MNormal

" Reversed

Data compachion:
= Prampt for option

" Dizcard points

{* Linear smoothing

v Plot data outside of analysiz range

Auto scale new data: | Kads WY anis
[ lgnore breaks in data

v Break data on gas switch or event mark,

[ Auto refresh data every IW zeconds
[¥ Bestore saved analysiz W Create PDF file with saved analysiz
[~ Expand heat flow signal names

Data buffer size: W points

[ Hawz [ ¥ adis

v Preview [ Alltext

Ticks / label on 3 awis: |4_ T awiz |4_

Exact scaling:

Open data file: [~ Quick open v Auto Launch

Save | Default | Cancel Help

Figure 3.7
Main Options - Data Page

2. Click on the direction for your RMX Exotherm plot. See “Choosing
an Exotherm Direction” in Chapter 2 for details.

NOTE:

Files created with the Thermal Advantage software are not affected by

this selection. To edit the exotherm direction for these files, select the
desired direction using the Data Information window (if applicable) or
Instrument Control software.
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3. Choose the type of DSC and DTA derivative plot desired (if you are
analyzing DSC and DTA files):

* Normal: Selects the mathematical derivative for DSC and DTA.

* Reversed: Inverts the DSC and DTA derivative by multiplying
by minus one.

4. Choose the type of data compaction that you want to use when the
data files are opened:

*  Prompt for option: Displays the Data Compaction window
that enables you to choose the data compaction each time the
program opens a large data file that must be compacted. See the
figure on the next page.

* Discard points: The program will remove data points linearly
throughout the data file. The number of points removed is based
on the amount of data reduction needed.

* Linear smoothing: The program will divide the points into
groups and compute an average for each group. The size of the
groups depends on how much data compaction is needed.

5. Check the remaining options that you wish to use for your data files:

*  Plot data outside of analysis range: Check this box to have
the data that falls outside of the analysis range plotted. Data
outside the analysis range is plotted in the plot grid color. Leave
this box unchecked to plot only data within the analysis range.

e Autoscale new data X-axis or Y-axis: Check one or both of
these boxes to have the data file’s x and/or y axis autoscaled.
When checked the current file’s axis data will be autoscaled
when the program reads in new data for Data Limits, Linear
Transform, or a new axis. This is the default setting. (This applies
to single files only—it does not apply to curve overlay.) Leave
the box unchecked and the axis data will not be autoscaled (axis
scaling is preserved).

» Ignore breaks in data: Check this box to have the data file
plotted with a continuous curve, regardless of any breaks in the
data points, each time a data file is opened. The data will be
extrapolated to create an unbroken curve. Leave this box un-
checked to have the data file plotted according to existing data
points and display any breaks in the curve.
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Break data on gas switch: Check this box to have any gas
switch and event marks that are contained in the data file plotted
as if they were breaks in the data. This is the default condition.
This allows gas switch and/or event marks to be used for the
Cycle Limits. Leave this box unchecked to have the data file
plotted without regard to gas switch and event

Auto refresh data every __ seconds: Check this box to
automatically refresh the plotted data from any active file (real
time plot) without losing completed results. Enter the minimum
amount of delay between refresh actions.

Restore saved analysis: Check this option to return the data
file back to the state it was in when Save Analysis was selected.
If this box is checked, then any Quick Open or multiple file
selection will be immediately restored.

Create PDF file with saved analysis: Check this box to
display a PDF File Save As dialog immediately after saving an
analysis (File/Save Analysis function). If you do not want to be
prompted to save your analysis as a PDF file, uncheck this box.

Exact scaling X/Y axis: Check one of these boxes to have the
axis plotted using the exact range of the coordinates found in the
data file or rescale zoom box.

Expand heat flow signal names: Check this box to automati-
cally replace the Heat Flow signal name in a Tzero data file with
the full signal name from the parameter block (e.g., Heat Flow
T4). The data file is not modified.

Enter the desired buffer size to use for your data files. A data
compaction option, if selected, will be applied in the event a data file
exceeds this size. (NOTE: You cannot change the data buffer size
when data files are open. Close all files to enable the Data buffer
size entry field on this page.)

Check any desired Open Data File options that will be used when-
ever a new data file is opened:

Preview: This option displays a brief list of parameter block
entries from the selected (highlighted) data file.

All Text: This option is used to display a complete list of the
parameter block entries from the selected (highlighted) data file.
The information displayed will include all data file information
plus signal and calibration information, etc. If the data file chosen
was stored in a spread sheet format, the data points from the file
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will also be displayed when All Text is selected. If the file chosen
is not a TA Instruments data file, Universal Analysis will display
any text found in the file up to the first form feed character
encountered.

*  Quick Open: This option is used to open and plot the data file
immediately after the Open button is clicked, without first viewing
the Data File Information window for that file.

* Auto Launch: Check this box to have the program automati-
cally run (launch) the Windows® application associated with the
file extension of the current file. For example, if this box is
checked and you open a file with the .pdf extension in Universal
Analysis’s File Open window, the program will run Acrobat
Reader and display the file.

NOTE: Universal Analysis will nat auto launch files with the extensions .tai, .txt, .sav,
or.asc, even ifthey have an associated \Windows® application. In addition, the
extension must have atleast one alphabetic character in order to be automatically
launched fromthe program.

8. Enter the desired number of tick marks per label on the x axis and y
axis. The default is 4 ticks per label.

9. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session
only.

NOTE: ‘l Toresetthe options to their factory settings, click the Default button.

Using the Data Compression Window

The Data Compression window, shown here, allows you to select the
type of data handling that you want to apply when a file that exceeds the
buffer size is opened.

Data Compression |

The amount of data in thiz file exceeds the
maximunn buffer size by 975,

Select Option:
¥ Linear smoothing

 Discard data points

" Select new data limitz

Figure 3.8

. . Cancel Helg
Data Compaction Window
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Click on the desired option, listed below, then click on OK:

* Linear smoothing: The program will divide the points into groups
and compute an average for each group. The size of the groups
depends on how much data compaction is needed.

* Discard points: The program will remove data points linearly
throughout the data file. The number of points removed is based on
the amount of data reduction needed.

e Select new data limits: Click on this radio button to select new data
limits for plotting using the Data Limits window. See “Choosing
Data Limits” in Chapter 2 for details.

Selecting More Options

Additional options for printer orientation, time and date format, and a file
close confirmation message can be selected as default program options
using the Main Options - Other Page. These options will be applied
whenever the program is reopened.

1. Select File/Options from the main menu, then click on the Other tab
at the top of the window. The Main Options - Other Page is
displayed as seen in the figure below.

TDDIBarI Pop-Up Menul Font I Color I Data I E=port F'Iotl Directoriesl Initialization ~ Cither

—Printer orientation at program stat—————————— [ Multiline:

Plots: —Reports———— ik I Solid 'I
|7(‘ Paortrait

& Portrait
: I Short dash vl

2
f* | andscape  Landscape
3 I Daszh dot vl
4 I Broken dbl d. 'I
—Tirme of day format:—  —Year folrn.'uat: 5 m
& 24 hours & 2 digits
E

: [Broken dash =]
R 4 digits foken dash 2

—Method log date-and-time stamp:
% Mo date-and-time stamp

£ Time stamp anly

" Date-and-time stamp

[~ Confirm file close with unsaved results

DK, ﬁave Qefault Cancel ﬂelp

Figure 3.9
Main Options - Other Page
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2. Select the direction (orientation) that you want the printer to use each

time the program is started for both the plots and reports: Portrait or
Landscape. Note that this orientation can be changed during your
use of the program, but this setting will be used each time the pro-
gram is started anew.

NOTE: ‘ The report orientation applies to the Report Editor program, The
Custom Report Editor program, and the Macro Editor.

3.

Choose the Time of Day format you want the program to use for the
time data displayed on the graph.

* 24 Hours: The program will use the time based on a 24-hour

day. This format (sometimes called Military Time) will continue

to increment time past 12:00. For example, 2:00 in the afternoon
is 14:00 in this format.

e 12 Hours: The program will use the time based on the 12-hour,

am/pm format. After 12:00 am the time goes back to 1:00 pm.

Choose the Year format you want the program to use for the year
data displayed on the graph.

* 2 Digits: The program will use the year based on the last two

digits. For example, the year is represented as 98 or 99, rather
than 1998 or 1999.

* 4 Digits: The program will use the year based on all four digits.

For example, the year is represented at 1998 and 1999.2.
Choose the Time of Day format you want the program to use for
the time data placed in your files.

Select the desired Method log date-and-time stamp to be dis-
played at the beginning of each line of the method log.

Select a line type from each drop-down list to apply to the corre-
sponding plot curve. This sets up the Multiline line type option. You
can define up to six line types. If more than six cycles exist in the
data, the line types are repeated.

Check the Confirm file close with unsaved results box to display
a message whenever you attempt to close a dat file without saving
the analysis results that you have already generated. Leave this box
unchecked (default) to close the data files without a prompt to save
any analyses performed.
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7. Click the Save button, if you want to use these as your new settings
or click the OK button to use these settings for this session only.

Setting Up Export Options

If you want to use your plots in different software packages or for
another application, you can export the plot using the File/Export Plot
function on the main menu. You can exclude certain parts of the plot, if
desired, so that they do not appear in the exported plot.

You can set up the export plot options to suit your own needs as follows:

1. Select File/Options from the main menu, then click on the Export
Plot tab at the top of the window. The Main Options - Export Plot
Page is displayed, as shown in the figure below.

Main Options E2

TDD|BEIII Fop-Up Menul Font I Caolor | Data  E=port Plat | Directoriesl Initializationl Other I

—Show standard header: —Header type:
¥ Sample [ Module W Filename [ Directories f* Standard header
v Size W Operatar Al £ Customn best
¥ Method ™ Bundate = Blank header
¥ Comment W Instrument M = Mo header
Show axiz —HPGL plotter:
- Hame: —Output port:— )
W71 Y2 Y3 VY4 R Al  PT1 # mir: I-D.D25
Tick labels: Maone | P2 * ma I'I.EIDE
Ml MYz WYIMve VX " LPT3 e |s
) & COM1
[ Tick marks: ~ [V Initialize plotter
Ml Wy2 W3 W4 VR |V Frame COkz
< COM3
Shiow footer:  COM4
W Exathermn directan W Program wersion
Figure 3.10
Main Options - Save | Defah | Concel | Hep |
Export Plot Page

2. Check the options that you want to appear in the heading on the
exported plot: Sample, Size, Method, Comment, Module, File, Opera-
tor, Run Date, Instrument, and/or Directories. You can also click on
the buttons to select All or None of these header options.

3. Check the options that you want to appear on the axes of the ex-

ported plot: Axes names, tick labels, or tick marks. You can also click
on the buttons to select All or None of these header options.
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4. Check the frame option if you want the plot to be printed with a
boxed frame around it.

5. Check the options that you want to appear in the footer on the
exported plot: Exotherm direction and/or Program version.

6. If you are exporting your plot to an HPGL plotter, perform the
following steps:

a. Select the appropriate radio button for the output port needed for
your HPGL plotter.

b. Enter the X min and X max values based on your plotter type
listed in the table below:

X min X max Pens  Plotter Type

-0.0250 1.0050
-0.0250 1.0115
-0.0250 1.0050
-0.0080 1.0090

HP-7470

HP-7475

HP-7440 Color Pro
HP-7550 Auto Sheet Feed

R 0 N

c. Enter the number of pens used on your plotter.

d. Check the Initialize plotter box if you want the program to reset
the plotter prior to drawing a plot.

7. If you are exporting your plot to a printer, choose the default orienta-
tion that you want to use for the printing of the plot: Portrait or
Landscape. You can override this default orientation using the File/
Print Setup window.

8. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session

only.

NOTE: ‘l Click the Default button to return all of the options to their original
factory settings.
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Choosing
Program Directories

When you use the Universal Analysis program there are certain file
folders, or directories, that are repeatedly used to locate or to save data
and settings. You can set up these directories so that the program will
default to a particular location on your hard drive by using the Main
Options - Directories Page.

Follow these steps to set up the file directories:

1. Select File/Options from the main menu, then click on the Directo-
ries tab at the top of the window. The Main Options - Directories
Page is displayed as seen in the figure below.

Main Options E3

Tu:u:uIBarI Pop-Up Menul Fant | Color I Data | Expart Plat  Dirsctories Ilnitializatiu:unl [ther I

rData files:

|E:RTMData Browse. .. |
Export files:

IE:‘\TMData Browse. . |
—Report files:

|E:RTMData Browse. .. |
Macro files:

IE:‘\TMMachS Browse. . |

Save Drefault Cancel Help

Figure 3.11
Main Options - Directories Page

2. Enter the location (file path including the disk drive letter and all

directories and subdirectories) of your data files or use the Browse
button to locate the directory.
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3. Enter the location (file path including the disk drive letter and all
directories and subdirectories) to be used for any files that you want
to export or use the Browse button to locate the directory.

4. Enter the location (file path including the disk drive letter and all
directories and subdirectories) to be used when saving report files or
use the Browse button to locate the directory.

5. Enter the location (file path including the disk drive letter and all
directories and subdirectories) for your macro (.mac) files or use the
Browse button to locate the directory.

6. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session

only.

NOTE: ‘l To reset the options to their factory settings, click the Default button.
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Setting Program
Initialization Options

An initialization file is a file containing all of the settings that are automati-
cally used when the program runs. When you click the Save button on a
window, the program settings are saved in the .ini file selected on the
Main Options - Initialization Page.

Follow the instructions below to set up the file directories (folders) that
you want to use as your default settings for the initialization (.ini) file(s),
which will be used as program preferences by the Universal Analysis
program.

1. Select File/Options from the main menu, then click on the Initializa-
tion tab at the top of the window. The Main Options - Initialization
Page is displayed as seen in the figure below.

Main Options il
TnnIEarI Fop-Up Menul Fant I Calar I Data I Expart F'Iotl Directaries  Initialization | Other I

Program preferences initiahization [in] file:

N ame: I‘\\H obbeshPublich TANWIRLA. ini

Load... | Save fsg |

Load Default Program Preferences |

[ Allow multiple seszions of Universal Analyzis

[ Create Integrity tem access files

Save LCiefault Cancel Help

Figure 3.12
Main Options - Initialization Page

2. Enter the drive, directories, and filename of the .ini file or locate and
load a new .ini file using the Load button. Click the Load button to
display the Open Initialization File window, which is used to locate
and load an initialization file.
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NOTE:

NOTE:

You can use the Save As button to save the current program prefer-
ences under a new .ini filename or save it in a different directory.

To use the program preferences that were set at TA Instruments
(factory settings), click the Load Default Program Preferences
button. This will load the factory default settings for the entire
program.

Check the Allow multiple sessions of Universal Analysis box to
open a new session of the program each time the icon is selected
(more than one copy of the program will be in operation). If the box
is not checked, the current session of the Universal Analysis will be
activated each time the icon is selected.

Check the Create Integrity item access files box to generate item
access script files for use with the Integrity database system. The
files are stored in the directory containing the Universal Analysis
program executable file (WinUA.exe). Refer to the TA System
Manager program for more information on using these files.

Youmust save this setting to the current initialization file by clicking the Save button

oritwillnot take effect.

7. Click the Save button, if you want to use this .ini file as your new
default setting or click the OK button to use this setting for this
sessiononly.

‘I The default directoryand filename are TA\WInUA. ini.
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Setting Up
Print Options

The printing options are set up through the standard Windows NT®
printer setup window. The window that is displayed when you select
File/Print Setup from the Universal Analysis main menu can vary
depending upon the printer(s) that you have connected to your computer.
The window that appears, such as the example shown below, will display
the available options for the printer that you have set up as your default
printer. To change the default printer that Universal Analysis will use, just
select a different printer on the setup window.

Print Setup [ 7] |

— Printer
Properties |

Accelawiter 359

M ame:

Statuz Ready

Type: Accelawriter 359
Where:  LPT1:

Cormmetit:

— Paper Orientatiamn

Size: I Letter j b & Portrait

Source: I.-“-‘-.utumaticall_l,l Select j " Landscape

| k. I Cancel

Figure 3.13
Example of a Print Setup Window
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Saving Program
Parameters

When you open a window that contains Universal Analysis program
parameters, such as the Main Options window, you will see a Save
button at the bottom of the window. Click on the Save button to save the
options that you have set up for the current window or options page in an
initialization (.ini)file.
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Chapter 4

Customizing the Graphs

Introduction

You may not always want to use the graph as it appears when the data
file is first opened. You might decide that you want to analyze a certain
portion of the graph or that you want to add some design elements to it,
such as symbols or legends. This chapter describes the different ways
that you can customize your graphs.

Using the Zoom
Box to Rescale

Rescaling is a technique that can be used to enlarge an area of the curve
that you want to concentrate on for your data analysis. The "Zoom Box"
feature in the Universal Analysis provides the fastest way to rescale.
You can easily expand a portion of the curve for analysis using the
mouse. To zoom in on a particular portion of the curve for analysis,
follow these steps:

1. Position the pointer in the general area you wish to enlarge and hold
down the left mouse button. As you move the mouse, a zoom box
will be drawn from the original point position. Move the mouse to
draw a box encompassing the area of the curve to be enlarged. See
the figure below for an example of the zoom box.

E¥ D sc-pet 001 _|O0]

Sample: PET [Guenched from the Melt] OEC File: OATAD=t=A\DSC\D=c-pat 001

sl

Heat Flow il g)
&
k3

051

1 -0 T T T T T
Figure 4.1 T - s - - 2,
Example of Zoom Box B Up Temprae () VNl Al OF
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2. Release the mouse. If the area selected is acceptable, move the
pointer inside the box and click the left mouse button to zoom the X
and selected Y axis or click the right mouse button to display the
pop-up menu. For an example of how the area is enlarged, see the
figure below.

&% Dsc-pet.001 (=]
Sample: PET [Auenched from the Melt] O5C File: DATAData 05 ChOsc-pet 001
04
02
=
% (ly
=
[=]
o
i
LI iy
I
e
Figure 4.2 s
La) T T T T T T
Graph Rescaled 11 120 130 143 120 160 170 ]
with the Zoom Box BJ:IUFI T?I'I'I|:l?r-c'|1'.l|'¢ [ ke rzal V2 OF

This process can be used repeatedly to expand a smaller portion of the
curve. To return back to the most recent scale changes, press Ctrl-U
(Rescale/Previous Limits option).

Rescaling in the X/Y Direction

You can change the position of the curve in the Y direction (up or down
on the monitor) using either of two methods:

Drag-and-drop method: Click on the curve. A crosshair is
displayed when you have correctly positioned the pointer on the
curve. Continue to hold down the left mouse button while you move
the crosshair to the desired point in either y direction. Release the
mouse button. The plot is rescaled.

Dragging tick labels: Position the cursor over the axis tick label.
Hold down the left mouse button and drag the label

In a normal plot this action rescales the X/Y axis.
In curve overlay this action changes the X/Y offset.
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Using the Rescale Menu

The Universal Analysis Rescale menu
(shown here) has options that allow you to

change the limit points and analysis range. Eull Scale Axis

You can change the axis scaling and zoom Full Scale Al

in on the portion of the graph that will be Lot sesl 2

analyzed using these options. ST e
Stack Axes

The menu items found on the Rescale menu Exact Scaling X

are used for the purposes described in the Ewxact Scaling ¥

table below.

Table 4.1
Rescale Menu Items

Manual...
oo Dut Chrl+Z
Previous Limitz — Chrl+L

Menu Item

Description

Manual

Zoom Out

Previous

Limits

Full Scale
Axis

The Manual rescale option displays the Manual
Rescale window that is used to select exact start
and stop limits for the X- and Y-axes to reduce or
expand the graph, and to change the label and tick
intervals.

When you select the Zoom Out option, you will
expand the current X and Y axis in all directions
by approximately ten percent. Click once to move
out one level. Shortcut Key: Ctrl-Z.

The Previous Limits option redraws the graph as it
appeared before the most recent scale changes.
Only the scaling options selected from the Rescale
menu are affected by this menu option, any
changes made in color or annotation are not
affected. Selecting Previous Limits a second time
will return the graph back to the most recent
changes. Shortcut Key: Ctrl-U.

The Full Scale Axis option redraws the current
axis as it first appeared when you generated it
from the data file. The graph is autoscaled to the
minimum and maximum data values for the
selected axis only.

(continued on the next page)
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Table 4.1

Rescale Menu Items
Menu Item

Purpose

Full Scale
All

Common

Scale

Same Scale

Stack Axes

Exact
Scaling X/Y

NOTE: ‘

g2

The Full Scale All option redraws the graph as it
first appeared when you generated it from the data
file. The graph is autoscaled to the minimum and
maximum data values for all of the axes contained
in the file.

When the Common Scale option is selected, all of
the axes that have the same Y-axis signal units are
autoscaled to match the widest axis. All of the
curves on the axes with the same units are then
adjusted to have the same data range, and are
displayed in full view on the graph.

When the Same Scale option is selected, all of the
axes that have the same units are rescaled to the
same axis scales. The largest scale maximum and
the smallest scale minimum are used for the scale
limits.

When you select Stack Axes, the Y axes are
adjusted so that the curves on the axes are stacked,
one above the other, with no curves from one axis
overlapping the curves of another axis. See the
figure on the next page for an example

When you check this option, the axis will be
plotted using the exact range of coordinates found
in the data file or rescale zoom box. This option
applies only to the current data file. To apply exact
scaling every time a file is opened, check the Exact
Scaling box found on the Main Options—Data
Page.

The Stack Axes option cannot be used when one or more of the axes are
displayed in log form.

THermAL ApvanTAge UNiversaL ANALYSIS OPERATOR'S MIANUAL



2920dsct.snl =] E3
Sample: TIN METAL OSE File: DATAVDRt=\0S C2920dsct 50
.3 e
0o 4.0
15 _ Fzs
N
oy 14 —
& [
= [
—_ 30 = F10 =2
= = =
ot [~}
z = =
= 45 = ET05 =
i} T L
-] . =y
T 2 2
B0 5 F-z0 £
= a
E 2
&~
75 24
Figure 4.3 a0 ' ' ' , , \ 50
200 210 220 230 240 250 260 270
Example of Exa Up Temperature [°C) Universal W2.0F

Stacked Axes

Manual Rescaling

The Rescale/Manual option is used to change the limit points and
analysis range by entering numerical values with the keyboard. You can
enlarge the portion of the graph that you want to analyze as follows:

1. Select Rescale/Manual from the main menu. The Manual Scaling
window shown in the figure below is displayed.

2. Enter the start and stop limits for each Y-axis curve, along with the
desired label interval, tick interval, and label offset for each curve.

3. Click the OK button when completed.

Manual Scaling |
Start Stop Label Interval Tick Interval Label Offzet

1 |10 0.4 0.2 |0 oo

v2 | | | | |

v3 | | | | |

va | | | | |

P |ﬁ |300.0 50,0 |25.0 .0
Figure 4.4 k. Cancel | Helm
Manual Scaling
Window
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Adding a Scale Bar

After you have plotted a data file, you can add a labeled I-bar, which
denotes a unit of distance, to the plot.

Follow these steps to add a scale to your plot:

1.

2.

Open the desired data file.

Select the
desired y axis
for the scale
bar.

Select Edit/
Add Scale
Bar. The
Scale Bar
window
(shown here) is
displayed.

s Scale Bar Hi=]

it Color:

[E  wi HEEN
—Direction: - - - I_
" Harizontal ...I_
* ertical . . I_ I_

k. Cancel | Help |

Enter the width of the scale. The units displayed will reflect the units
found on the current y axis, if horizontal direction is selected (see
step 4), or the x axis, if vertical direction is selected (see step 4).

Click on the desired color for the scale bar and label. The FG (fore-
ground) mark will be displayed in the selected color block.

Select the desired direction for the scale bar by clicking on either the

Horizontal or Vertical radio button.

i D sc-pet.001 B[=] 7. Click OK. A marker will be displayed

Z=ample : PET @uenched tom e Rl

DI Pl CATADEEDDE Dy e 10D

on the graph.

HeatFlow g
=]
-

5

8. Position the marker at the desired place
for the scale bar, then right click and
select Accept Limits from the pop-up
menu. The scale bar will be displayed as
seen in the figure to the left.

You can drag-and-drop the label for the
scale bar anywhere on the graph.

The scale bar is handled as a result by the

T T T
o =0 [xx] 1=0
Exo Up Temperabre & CH

00 program. There to edit or remove this label,

94

right click on the label text to display the
pop-up menu and select the desired action.
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Using the Graph Menu Spreadshet iew
Signals. ..
Lritz. ..

The Graph menu (shown here) is used to IstumentEarams::

select options that allow you to set up your (Raras SEme s y

graphs, either before or after analysis by Data Limits »

changing signals, units, parameters, data Hefresh 4

llmltS, etc. o Auiz F

T 3

The menu items found on the Graph menu Curve b

are briefly described in the table below. All of

these functions are described in more detail in Lieiky '

this manual, see the Index or Table of Con- Plat Header...

tents to locate the references. Plot Legend...

Imzet Miew. .
Options...
v Flot Full Bange
Tuble 4.2 " rrs ekt Dot
Graph Menu liems &uto Refresh D ata

Menu Item Description

Spreadsheet Use this function to toggle between the spread

View sheet view and the graph view. When you display
the data in spreadsheet view some menus will
change and some menu items will be unavailable.

Signals Use the Signals option to access the Signal
Selection window, which allows you to choose the
X- and Y-axis signals that you want to use for
your graph.

Units Use the Units option to access the Units Selection
window, which allows you to choose the units that
you want to use when graphing and analyzing your
data files.

Instrument Use the Instrument Parameters option to access

Parameters the DMA Instrument Parameters window or the
MDSC Instrument Parameters window, which
enables you to edit instrument parameters which
affect the data.

(continued on next page)
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Table 4.2
Graph Menu Items

Menu Item

Description

Parameters
Same As

Data Limits

Refresh

X Axis

NOTE:

Y Axis

Curve

96

This option is only available when multiple files
are open. Use the Params Same As option to copy
the parameters used in another file to the current
file. The parameters that are copied include the
signals and units selected, graph options, baseline
file (if applicable), and smoothing.

Use the Data Limits option to select from four
options: Full Range, Cursor, Time, or Tempera-
ture. These allow you to use the entire data file for
analysis, or to place constraints on the amount and
type of data. NOTE: This option deletes any
existing analyses from the plot.

Use the Refresh/Data option to redraw the plot
using the current data points. Use Refresh/Plot to
redraw the plot using the current data points.

Use the X Axis option to select the signal to graph
on the X axis. Click on the name of the signal and
the graph will be replotted immediately. This
option preserves the applicable analyses when
switching between these signals.

The signal specified on the Signal Selection window
for the X signal is used here in addition to time and
temperature.

This option is only available when multiple Y-axis
signals are displayed. Use the Y Axis option to
select a Y-axis signal for functions such as rescal-
ing, analysis, etc. Emphasis will be switched to
that signal (as seen by the small box enclosing the
Y-axis number).

This option is only available for a curve overlay
graph. Use the Curve option to switch between
different curves on the selected axis of an overlay
graph, so that you can perform functions on that
curve (such as rescaling, analysis, etc.).

(continued on next page)
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Table 4.2
Graph Menu Items

Menu Item

Description

Overlay

Plot Header

Plot Legend

Inset
View

Options
(Graph)

Plot Full
Range

Performing a curve overlay operation lets you
combine curves from several different experiments
or experimental techniques to provide a visual
comparison of the data. This will allow you to
“overlay” the curves on one window and position
the graphs to display the data in a manner that
enables you to emphasize important aspects of the
data. Up to four individual y-axes may be used,
containing up to ten curves, each of common units.

Use the Plot Header option to add a text-only
header to an exported or printed plot. The plot
header will not be displayed on the monitor. When
you select this option the Plot Header window is
displayed to allow you to set up the header.

Use the Plot Legend option to display the Plot
Legend window, which is used to customize the
legend that will be placed on the current graph.

Use this function to add a picture-in-picture
window to the plot. When you select this option,
the Inset View dialog is displayed to allow you to
customize the insert view.

Use the Options menu item to display the Graph
Options window. This window will enable you to
customize the axis labels, grid type, line type,
color, and symbol for each curve on the graph.

Check this option to have the data that falls
outside of the analysis range plotted, but grayed
out. Data outside the analysis range is plotted in
the "Plot Grid" color. NOTE: This option applies
only to the current data file. To apply this
option each time a new file is opened, check
the "Plot data outside of analysis range" box
found on the Main Options—Data Page.

(continued on next page)
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Table 4.2
Graph Menu Items

Menu Item

Description

Auto Scale
New Data
XY

Ignore Breaks
in Data

Auto Refresh
Data

Check this option to have the data file autoscaled
when the program reads in new data for Graph/
Data Limits, Tools/Linear Transform, or a new
Graph/X axis or Y axis. NOTE: This option
applies only to the current data file. To apply
this option each time a new file is opened,
check the "Autoscale new data: x axis ory
axis" box(es) found on the Main Options—
Data Page.

Check this option to have the data file plotted with
a continuous curve, regardless of any breaks in the
data points. The data will be extrapolated to create
an unbroken curve. NOTE: This option applies
only to the current data file. To apply this
option each time a new file is opened, check
the "Ignore breaks in data" box found on the
Main Options—Data Page.

Check this option to automatically refresh the
plotted data from an active data file (real time plot)
without losing completed results. Auto refesh can
be turned on as a default condition on the Main
Options—Data Page.

Most of the items contained in the table are discussed in further detail in
this manual. To locate a particular topic, refer to the Table of Contents

or the Index.
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Using the Spreadsheet View

Use the Graph/Spreadsheet View function to toggle between the
spreadsheet view and the graph view. When you display the data in
spreadsheet view some menus will change and some menu items will be
unavailable.

Characteristics of the Spreadsheet View:

A maximum of five columns can be shown in the spreadsheet view-
one x-axis and up to four y-axes.

You can double click

on any data point in the [T R =1
table to modify that
point or use the Edit/
Modify function to -0.0342347 Wwiig
modify the data.
(NOTE: The data file
will not be changed.)
The Modify Data
window is displayed as
seen here. Just enter the desired value and click OK to alter the
selected cell.

Heat Flows:

] Cancel Help

You can select (highlight) rows, columns, and regions of table cells
by holding down the left mouse button and dragging across the
desired cells.

A right-click popup menu Copy Cirl+C
(shown to the right) is Paste Ctrl+f
available for the following Select &l Chrl+4,
functions in spreadsheet Modify.

view: Select all cells, and

Copy, Paste, and Modify v Lime [min]

v Frequency [Hz]
# Signal Sample Stiffness [W/m)
v Sample Stiffhess [MN/m]

data. A list of signals

(chosen on the Signal

Selection window) is also
displayed in the pop-up v Spreadsheet Yiew
menu to allow you to
display (checked) or
remove (unchecked) the signal data from the spreadsheet view.

You can copy any range of data to the clipboard from the
spreadsheet view and retrieve it in another application.
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NOTE:

You can perform data modification functions such as smoothing,
linear transform, and excluding data using the applicable menu
functions.

You can restrict the data displayed in spreadsheet view to a specific
range using the Data Limits and Analysis Range options.

When you are using a Curve Overlay plot, only the data for the
currently selected curve is displayed in spreadsheet view. (This is
because the x-axis values of each data point are different in each
data file.)

If you want mare columns of data for a Curve Overlay plot, use the View/
Data Table function instead of the spreadsheet view.

If you want to paste several columns of data into an area below a
particular cell, first copy the set of data points, then select the
desired cell and select paste from the popup menu. The data will be
pasted into the cells below the chosen cell in the same column,
overwriting the previous data.

If you want to smooth a group of data points in the spreadsheet,
select (highlight) the desired group of cells. Then select Edit/
Exclude Data, check "Smooth and blend with adjacent data," then
click OK.

Selecting a Y Axis

100

If more than one Y-axis has been graphed, you need to specify which
axis should be used for operations. You can select a Y axis for use by
performing one of five actions:

Select Graph/Y Axis from the main menu.

Click on the Y number text above the axis.

Click on the Y-axis label on the graph

Click on the curve for the desired Y axis.

Right click on a result label on the desired Y axis.
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Annotating Graphs

Figure 4.5
Annotation Window

Annotations are alphanumeric characters that can be placed on the graph
to add notations or comments regarding the information displayed. You
can place comments of up to 20 lines of 80 characters (600 characters
maximum) on the graph.

Follow these steps to place an annotation on the graph:

Select Edit/Annotate from the main menu. The Annotation win-
dow, shown in the figure below, is displayed.

Annotation

=]|

) |
HEN
HEN
|

[ Ao ba point

k. Params= | Cancel | Help |

Enter the desired text in the Text box. (You can use tabs for align-
ment.)

Click on the desired text color. The FG (foreground) mark will be
displayed in the selected color block.

Check the Arrow to Point box, if you want to have an arrow pointing
from the text to the reference point selected on the plot.

Click the Params (Parameters) button, if you want to choose common
parameters to insert in your annotation. The Insert Data File Pa-
rameters window (see the figure on the next page) is displayed.
Make your selections and click OK. The selected text is inserted at
the current position of the cursor in the text box of the Annotation
window.
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Inzert Data File Parameters [ x|

Select parameters o ingert at cursor:

Fun: 41

Module Type: TGA

Fun Date: 10-Map-35 0755

Sample: Calcium Oxalate Maonohydrate
Size: 17.6070 mg

Operator. Applications: Laboratan
Method: RT--»1000°C & 20°Cmin
Comment: M2 Purge=100mL/min

Figure 4.6
Insert Data File

Parameters ok | o Nore Cancel |  Heb |

6. Click on OK. The graph is displayed again with crossed marker lines
displayed.

7. Position the markers so that they intersect at the desired reference
point on the plot.

8. Right click to display the pop-up menu and select Accept Limits. The
text will be displayed on the graph at the chosen point.

After the annotation has been created and displayed, you can edit it.
Position the pointer over the annotation text and click the right mouse
button. The Annotation Pop-up menu is displayed as seen on the next

page.

NOTE: ‘I Annotations may be repositioned after they are displayed by dragging and
dropping the text at the desired location using the mouse.
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Using the Annotation

Pop-Up Menus

Use one of the pop-up menus below, after an annotation or analysis result
label has been created, to edit or delete the annotation. Position the
pointer over the annotation or result label and click the right mouse
button to display these menu options.

Bold

Italic Bold

Colar. .. Ttalic

Size... Color...

Resolution. ., Size...

arrowheads Resolution. ..
] v Arrowheads

Adjust Result, .,

Delete Result Delete Result

Delete Label Delete Label

Edit Annotakion. ., Copy Texk

Copy Texk

Annotation Popup Results Label Popup

The menu items found on the pop-up menu are used for the following
purposes:

Bold: Use this menu item to make the selected annotation text bold.

Italic: Use this menu item to make the selected annotation text
italicized.

Color: Use this menu item to change the color of the selected
annotation text. When you select Color, the Label Color window is
displayed to allow you to select a color.

Size: When you select Size, the Label Size window is displayed.
Use this window to enter or select from a list of relative sizes that
will be applied to the PRINTED annotation text. The size of the
annotation on the display will not be affected. Use Print Preview to
observe the affect of the label size change on the exported plot.

Resolution: Use the Resolution menu item to set the numeric
resolution of an individual result value that is displayed on the plot
and in the reports generated by the Universal Analysis program.
When you select Resolution, the Label Resolution window is
displayed to allow you to round the value to the defined resolution.
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* Arrowheads: Arrowheads is a check item like Bold that toggles on
or off with each click. When Arrowheads is checked, any result
lines that can have arrowheads are drawn with the arrowheads
visible. When Arrowheads is not checked, the arrowheads are
suppressed.

e Adjust Result: After you have completed performing certain types
of analyses on your data file, you can adjust the results of the
analysis.

¢ Delete Result: Use this menu item to remove the associated result
or annotation from the graph.

e Edit Annotation: Use this menu item to make changes to the
selected annotation. When you select this option, the Annotation
window is displayed. See “Adjusting Analysis Results” in
Chapter 5.

* Delete Label: Use this menu item to remove the selected analysis
label from the graph. The remainder of the associated analysis result

1s not affected.

e Copy Text: Use this menu item to copy the text in a result label,
legend, or annotation to the clipboard for retrieval later.
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Changing Colors,
Line Types, Symbols, etc.

You can set up the appearance of the graph by choosing graph settings
that will apply to the file currently displayed. You can set up the curves
with different colors, line types, and symbols, as well as placing a grid on
the graph, if desired.

Follow these steps to select your graph's appearance:

1. Select Graph/Options from the main menu (or position the pointer
over a Y-axis label title or over a curve and click the right mouse
button). The Graph Options window, shown in the figure below, is
displayed.

Graph Options |

i

il £l ClvE v

M ames:
Y |Heat Flaw (]

= ITemperature ['C)

Gnid bype: I Mo grid

L«

Colar: [ Riiulticolor g

L]

Line type: I Salid

—Symbols:

Spacing: I Coarze A I

L]

Tupe: I Mo symbolz

L«

Differentiate; I.&Hes

| EditList.. |

Figure 4.7 Ok, Save | Drfault | Canzel | Help
Graph Options Window

2. Select the radio button for the Y-axis label and curve that you wish to
set up.

3. Edit the names for the Y-axis and X-axis labels, if desired.
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4. Select the color for the graph and label by clicking on the desired
color. Multicolor uses the colors selected on the Main Options—
Color Page. Each color in the multicolor list is applied to the corre-
sponding text line or plot curve.

5. Select the grid type from the drop-down list. Grid options apply to
the currently-selected axis and can only be specified for one Y axis.
e Nogrid
*  Grid at labeled ticks
*  Grid at all ticks.

6. Select the line type from the drop-down list. If you select
"multiline," you can define up to six line types, which are selected on
the Main Options—Other Page. If more than six cycles exist in the
data, the line types are repeated.

7. Select the symbol type from the drop-down list. (For more informa-
tion on symbols turn to page 111.) Choose from one of the follow-
ing:

e No symbols

»  Digits (Uses ascending Arabic numbers from 1 through 9.)

» Letters (Uses the alphabet from A to Z in upper case followed
by letters a to z in lower case.)

e Custom symbol list (The symbols will be used in the order
displayed. You can use the default symbols already displayed or
enter your own symbols.)

If you select a symbol, it will be displayed at the bottom of the
window, then go on to step 8. If you select “No symbols,” go on to
step 10.

8. Select the type of differentiation from the drop-down list. Choose
from one of the following:

e Curves is used to have the symbol that is used for a curve
change to the next symbol in the list at a break in the data. (E.g.,
data breaks, change in multiplexed signal value.)

* Axis/Axes is used to have the symbol that is used for an axis
change when the next axis is drawn.

*  Subcurves (available only in curve overlay plot) is used to have
the symbol that is used for a curve change to the next symbol in
the list when a subcurve is displayed.

9. Select the spacing between data points from the drop-down list.

Choose from one of the following:

*  Coarse is used to space the symbols farthest apart on the curve.

*  Medium is used to space the symbols closer together on the
curve.

*  Fine is used to space the symbols even closer together on the
curve.

*  Every point is used to place a symbol at every data point on the
curve. (This can sometimes lead to a solid line effect.)
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10. If you want to edit the list of symbols, click on the Edit List button,
then edit the list as desired.

11. Repeat steps 1 through 10 for each axis. Grid type and symbol
differentiation apply singularly to the entire plot. They can not be set
up uniquely for each axis, except in a curve overlay plot.

12. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session
only. (X and Y names cannot be saved.)

NOTE: || Select the Default button to use the default settings for this window.

Adding a Plot Header

A plot header is a text-only heading that can be added to exported or
printed plots. You can set up the plot header as desired using the steps
below:

1. Open a data file, then select Graph/Plot Header from the main
menu. The Plot Header window is displayed.

Plot Header E

—Header type:

(= Standard % Custarn € Blank = Mo header

Cuztorn header justific ation:
’7 i Left {+ Center £~ Right

Custom header test:

Enter a customized header in thiz areal

ok I Font.... Cancel Help

Figure 4.8
Plot Header Window

2. Select the radio button for the desired header type: Standard, Cus-
tom, Blank, or No Header.

3. Type in the desired text in the "Custom header text" area, if you have
selected the Custom radio button in step 2. A maximum of four lines
of text can be entered. You can set the font for this text by clicking
the Font button.

4. Click on the desired button to choose the alignment of the text from
the following justifications: Left, Center, or Right.

5. Click the OK button when finished.

To view the header, select File/Print Preview after you have created
one.

THeRMmAL ADVANTAGE UNiveRsAL ANALYSIS OPERATOR'S MIANUAL 107



Customizing the Graphs

Creating Plot Legends

A plot legend is a customized box that shows the symbols, line type, etc.
used for each curve, along with your own text. You can configure the
legend to your specifications before you place it on your graph or edit it
after one has been created.

Follow the steps below to configure or edit the legend.
1. Select Graph/Plot Legend from the main menu (or right click on a

legend that has already been created). The Plot Legend window,
shown in the figure below, is displayed.

Plot Legend |
—Show:

Heading: I

[0 Multiplesed signal bable; Im [0} M ulbizalan ekl

[~ Border [ Module 1D [T Multicolor ket

Text:

—Legend handle pozitiaon:

Yertical handle: Harizantal handle:——

Y IEI.EIEIEI &+ Top &= Left

i~ Center i~ Center

T |1'|:":”:I i~ Eattom ™ Right

Figure 4.9 Save | Liefault Cancel Help

Plot Legend Window

1. Enter the desired Heading for the plot legend.

2. Check one or more options that will be applied to the legend:
*  Multiplexed Signal Table: Displays the values of the multiplex
signal (e.g., DMA and DEA frequency, DMA amplitude, and
WTA location). If a symbol is used to distinguish these curves
then it will be displayed next to each value. If you check Multi-
plexed Signal Table, you must also select either Vertical or
Horizontal from the drop-down list.
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*  Border: Places a box around the legend. NOTE: When the
Border box is checked the legend is opaque (nothing behind
it will show). When the box is not checked, there is no
border and the legend is transparent (anything behind it will
show through).

*  Module ID: Places the name of the instrument in the legend.

*  Multicolor table: Assigns multiple colors to the lines of a
vertical multiplexed signal table. NOTE: Multicolor table will
only work when the Multiplexed Signal Table is set to "Verti-
cal."

*  Multicolor text: Assigns multiple colors to the lines of text
created in the Text field.

NOTE: The colors used for multicolor options are defined on the Main Options—
Color Page.

3. Enter the desired Text that will be added to the bottom of the legend.

4. Enter an X-axis position coordinate. The coordinates are unitless, and
range from 0.0 to 1.0 on the axis.

5. Enter a Y-axis position coordinate. The coordinates are unitless, and
range from 0.0 to 1.0 on the axis.

6. Click on the desired vertical position for the legend handle: Top,
Center, or Bottom.

7. Click on the desired horizontal position for the legend handle: Left,
Center, or Right.

8. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session

only.

See the figure below for an example showing a plot legend.

&% 2940tmat.inl =] B3
Sample: IMDILM THA File: D:NTANData%Z2940tmat. in1
I v -2
100 100
0 o

|Ccntcr Wertical & Horizontal Fosition at .50|K £ Yl

Gimensian Change {pm}
Dimensian Change {pm}

-1900 4 L -100
200 4 L —z200
Figure 4.10 i .
-390 r . . T . -300
Plot Legend Example 110 120 130 140 150 180 170
Temperature [ 7C) Universal Y2, 0B
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NOTES: The legend may be repositioned after it is displayed by dragging and dropping
the legend at the desired location using the mouse. You can also right click
over legend text to display a pop-up menu that allows you to edit or delete
the legend or copy it to the clipboard.

To use these settings each time you display this window, select the Save
button.

Select the Default button to use the default settings for this window.
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Using Symbols in Curves

Symbols are a fun way to creatively represent your information on the
graphs. You can use symbols to differentiate between axes or curves.

Symbols are particularly useful for multifrequency (DMA and DEA) or
multiamplitude (DMA) experiments and can be displayed in the plot
legend. They can be used to differentiate axes.

You can also use the Edit/Exclude Data function to create data breaks,
and then use symbols to show changes within a signal. For example, gas
changes (oxidative stability) or heat/cool segments can be marked by
making breaks in the data, then using symbols to differentiate between
the changes.

NOTE: The symboal type applies to all of the uninterrupted data on an axis or to
different axes. The list symbals apply in the left to right order displayed.
When symbals are used as axis differentiators, the first symbol applies to
axis Y1, the second to axis Y2, etc.
For an example of using symbols in curves, see the figure below.

& Dma-pet 001 I [=]
Sample: PET Tape Demonstration Sample ObdA File: DATAMD=t=\DRALVD ma-pet 009
B
000 £ )

4000
- 300
E’ F000 - ;
= y
E - zo0 E
% 2000 E
2
Ll
oo —
0 T T T T T T o
m 40 en a0 100 120 140 160
Tem peraturs (%) Universal W2.0F
Figure 4.11

Example of Symbols in Curves
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Creating an Inset View

An inset view is a picture-in-picture window that can be added to the
plot. The best way to use the inset view is to first zoom in on the area of
the curve to be analyzed. Then perform the analyses desired. Adjust the
position of the labels to your satisfaction, then

set up the inset view using either Graph/Inset Accept Limits

View or by right clicking to display the pop- Aeeept mits sl Ares
up menu (shown here) and selecting either Inset View. .

Inset View or Auto Inset. See the following Auta Inzet Yiew
sections for more details. Cancel

Inset View Characteristics

When you set up an inset view, keep in mind the following characteris-
tics and refer to the figures shown for examples:

* Inset view is generally used to view events of two different sizes at
the same time. You can show an enlarged view of a small event
inside the inset view and display the full size plot at the same time.

e Only one inset view may be added to a plot.

* The inset view has separate axis scaling so that you can expand any
area of the main plot and put that into an inset view.

Sarnple: PET (Quenchad Trar B Kel DEC Filz; CATADAEDECD se-pel. 002
0.4
120210
0.2
0.0
= Pt ]
£ -0z | +4300E
£ -13800 % rured
b e 13L0TE ., |
= I A4y 5,
T -3044. % cured
-0.5 T2.88%C
1 =, TELO'CA)
-0.5
] 0 G
-1.|:| T f?-‘%3 C T T T T T T T
. i 50 100 150 200 150 00
Flgure 4.12 Etn Up Ternparatre () Unharsal W74
Inset View Example 1

* The inset view can be placed anywhere in the plot area using drag-
and-drop.
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* Aninset view can be customized with optional borders, arrows,
axes, etc. using the Inset View dialog. See the next section, “Setting
Up an Inset View” for more details.

*  You can make the inset view transparent (items behind the inset
view will be displayed) by turning off (unchecking) the Border
option on the Inset View dialog. If Border is checked, the inset view
will cover anything underneath it. See the next section, “Setting Up
an Inset View” for more details.

*  You can view the entire plot or manually choose the viewing area by
selecting Graph/Inset View from the menu. The Inset View dialog
is displayed to allow you to customize the view. See the next
section, “Setting Up an Inset View” for more details.

*  You can choose the area of the plot to be viewed by creating a zoom
box with the mouse and then right clicking to display the pop-up
menu. At this point you can customize the view by selecting Inset
View from the pop-up menu or let the view be created automatically
from the zoom box area by selecting Auto Inset View from the pop-
up menu.

*  You can suppress results that fall within the inset view from
appearing on the main plot, if desired by unchecking the "Results on
plot" box on the Inset View dialog. If this is checked, the results will
only be displayed in the inset view. See the next section, “Setting
Up an Inset View” for more details.

*  When you create an overlay plot (see Curve Overlay), you can
include all of the plots in your inset view or include only the current
plot by checking or unchecking "All curves" on the Inset View
dialog. See the next section, “Setting Up an Inset View” for more
details.

*  You can mark the area of the inset view on the full size plot by using
either a dashed box and/or arrow.
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Setting Up an Inset View

Select Graph/Inset View to open the window shown below. This
window is used to customize the appearance of the inset view.

Inzet Yiew |
—Showr
¥ Wiew ¥ Besults on plat [T = awis scale
¥ “iew border v Zﬂrn:uwt-:u|:ur'-.fEs [ ¥ aviz scale
[+ Region border [ &l cunves [T Partial results
W size— Reqgion limitz:
b |4E|.|:||:||:| 4 = mir: ID.D = mas: |3|:||:|.|:|
A |4E|.|:||:||:| 4 ' mir: I-'I.D Y mas: ID.4

—iew handle position:

—Wertical handle: Harizontal handle:

IEI.EIEIEI " Top o Left

" Center " Center

e
T ID'DDD + Bottom " Bight

Figure 4.13 ok Save | Default Cancel Help

Inset View Dialog

1. Check the items that you want to appear on the inset view window:

*  View: Check this box to show the graph in the inset view. If this
box is not checked, the inset view will not be displayed.

*  View Border: Check this box to put a border around the inset
view and make it opaque. If Border is checked, the inset view
will cover anything underneath it. See Figure 4.11 for an ex-
ample of an inset view with a border.

You can make the inset view transparent (items behind the inset
view will be displayed) by turning off (unchecking) the Border
option on the Inset View dialog.

* Region Border: Check this box to leave a dotted line around the
region chosen for the inset view. See Figure 4.11 for an example
of an inset view with the region shown as a dotted line. If this
box is not checked, the region chosen for the inset view will not
be shown.
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NOTE:

Results on Plot: Check this box to show any analysis results
contained in the inset region on the main plot and the inset view.

If this box is not checked, the results contained in the inset region
will only be displayed on the inset view and not on the main plot.
See Figure 4.11 for an example of an inset view with results only
on the inset view.

‘ You can also toggle is option on or off using the inset view pop-up menu after

the inset view is placed on the plot.

e Arrow to Curve: Check this box to show an arrow pointing

from the inset view to its source on the curve. See the figure
below for an example showing an arrow to the curve. If this box
is not checked, no arrow is displayed.
Sample: Calcium O=alate Monohydrate TGEA File: CATA D=t TGS TEA-Caoc 001
150
100 — | 12.35%
\*. [ (2.1 T4muy)
h, A .
N 1095
-~ £ ‘L‘ [2.200rre)
_'En hs
]
< ED s 0.21580%
4 (10385 )
E‘b ) -\-1_.."“'\-\.___-
40 o
e
375 B0 BWE 300 305 400
pi : . . : . .
200 400 GO0 200 1000
Termperature (7] Lniversal Wi.7&
Figure 4.14

Inset View Example 2
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All Curves: Check this box to display all available data curves
in the inset view. If this item is not checked, only the current
curve is displayed in the inset view.

X Axis Scale: Check this box to display the x axis in the inset
view. See Figure 4.13 for an example of an inset view showing
the x-axis scale. If this box is not checked, the x axis will not be
displayed in the inset view.
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* Y Axis Scale: Check this box to display the y axis in the inset

view. If this box is not checked, the y axis will not be displayed
in the inset view.

* Partial Results: Check this box to display any results whose

limits may be partially in and partially outside the area selected
for the inset view. If this box is not checked, any results that do
not fall completely within the limits chosen will not be displayed
in the inset view.

Enter the size of the window in the X and Y directions in terms of a
percentage of the main window. For example, entering X and Y both
as 40 percent will create a small window that is 40 percent of the
main window's size.

NOTE: ‘l If you resize the main window, the inset view window is resized propartionally.

3.

NOTE: |

116

Enter the data region limits to be used in the inset view window to be
created.

Enter a View handle position X coordinate on the graph for the
position of the handle for the inset view. The coordinates are unitless,
and range from 0.0 to 1.0 on the axis.

Enter a View handle position Y coordinate on the graph for the
position of the handle for the inset view. The coordinates are unitless,
and range from 0.0 to 1.0 on the axis.

Click on the desired vertical handle position: Top, Center, or Bot-
tom.

Click on the desired horizontal handle position: Left, Center, or
Right.

Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session
only.

To use these settings each time you display this window, select the Save
button. Select the Default button to use the default settings for this window.
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Using the Tools Menu

The Tools menu (shown here) is used to select Smooth. ..

from a list of different types of functions that can Shift...

performed on the current graph. You can smooth, Rotate, .

shift, and/or rotate the curve and perform a linear Desmear. ..

transformation on either axis. If you change your Sensitivity. ..

mind you can remove the curve shifts. The Linear Transfarm
Remowe Shifks

resultant curve can be saved using the File/

Export Data File option. Baseline File

The menu items found on the Tools menu are
described in the table below.

Table 4.3
Tools Menu Items

Menu Item

Description

Smooth

Shift

Rotate

Desmear

Sensitivity
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Use this option to smooth curves using a least-
squares averaging technique.

Use the Shift option to move the curve up or down
to the position of the horizontal bar of the marker.

Use the Rotate option to take the curve and rotate
it around the points chosen.

Select this menu item to open the Desmear Curve
window, which allows you to improve the resolu-
tion of DSC sharp melting peaks. When properly
applied, this approach can generate data that
matches the resolution obtained in DSC Q Se-
ries™ T4P heat flow. The desmearing routine is an
offline approach and requires you to adjust a value
until the desired curve shape is obtained.

Select this menu option to analyze curve sensitiv-
ity using a least-squares averaging technique. The
curve data is reread from the data file, smoothed
using the analysis region window, and subtracted
from the original raw data. The resultant plot is a
measure of the signal sensitivity during any
portion of the experiment.

(continued on next page)
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Table 4.3
Tools Menu Items
(continued)

NOTE:

118

Baseline File

Menu Item Description

Sensitivity Before you analyze a curve, you must choose the

(continued) desired Y-axis to smooth by clicking on the
desired Y number displayed on the graph. When
you choose the Sensitivity function from the Tools
menu, the Analyze Sensitivity Window is dis-
played to allow you to enter the analysis region
width.

Linear Use the Linear Transform/Y Axis function to

Transform adjust the slope and/or intercept of the selected Y-

Y Axis axis signal.

Linear Use the Linear Transform/X Axis function to

Transform adjust the slope and/or intercept of the X-axis

X Axis signal.

Remove Use the Remove Shifts function to undo any

Shifts shifting or rotating of the curve. Please note that

when a linear transformation is applied to the
shifted data, this function is no longer available.

Use Baseline File to perform baseline subtraction
or addition. File addition or subtraction requires
the use of two data files, a sample and a baseline
reference file, both obtained from the sample
instrument, to create a modified sample signal(s).
When you select this function, you will get a
choice of the available files to be used as the
baseline file.

‘I The Shift and Rotate options are not available for log axis data.

This section contains further information on the items listed in the Tools
menu on the following pages.
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Smoothing Curves

The Smooth option found in the Universal Analysis program allows you
to smooth curves using a least-squares average. Normal curves are
smoothed versus the X-axis signal, and derivative curves are smoothed
versus the X-axis signal with respect to which the derivative was taken.
Integral curves cannot be smoothed. We recommend that you perform
smoothing before any analysis functions.

NOTE: ‘l The larger the smoothing interval you specify, the smoother the curve.
Follow these steps to perform this function:

1. Choose the desired Y-axis to smooth by clicking on the desired Y
number displayed on the graph.

2. Select Tools/Smooth from the main menu. The Smooth Curve
window shown below is displayed.

Smooth Curve |

Smoothing region width; Im T

[~ Smooth curve for nest file or new data limits

(] 4 Default | Cancel | Help

Figure 4.15
Smooth Curves Window

3. Enter the width of the desired smoothing region. For example, if you
enter 5 for an X-axis showing temperature, data from every 5 degrees
is grouped together and averaged by the method of least squares. The
resulting averages are then plotted on the screen.

4. Check the box to smooth the curve for the next file or new data
limits, if you would like to save and apply this smoothing region
again each time the selected signal is read from the data file.

5. Click on the OK button when completed. (If a reduced analysis
range has been selected, then the smoothing is applied to the selected
analysis range only. A limited data range can also be smoothed

using the Exclude Data function.)

NOTE: ‘I To use the default settings, click on the Default button.
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Shifting Curves

You may find it useful in some cases to manipulate your graph by
moving the curve up or down to a desired position on the graph. The
Shift option found on the Tools menu allows you to shift the curve as
desired.

Follow these steps to use this function:

1. If more than one Y-axis is displayed, choose the desired Y-axis to
shift by clicking on the Y number shown on the graph.

2. Select Tools/Shift from the main menu. A marker is displayed on the
graph.

3. Double click at the point where you want to shift the curve to posi-
tion the marker as seen in the figure below. The position of the
horizontal bar of the marker indicates whether the curve is to shift up
or down and by how many units. The vertical bar of the marker
intersects the curve at the point that will be brought to the level of the
horizontal bar.

&5 Dsc-pet.001 I [=]
Sample: PET [Quenched from the Melt]  DSC File: DATAADat=A\DSCADsc-pet 001
0.4
0.2
0.0 1
5
E 0.2
:
e '
E 0.4
=
-0.E
0.5
1.0 T T T T T T T T T T T
Figure 4.16 0 50 100 150 200 250 300
Markers for Shift Curve Bwa Lp Tempersture [°C) Uniwersal "2 .0F

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The program redraws the graph according to
your specifications as seen in the example on the next page.
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Figure 4.17
Example of a Shifted Curve

=% [} sc-pet. 001 =]

Sample: PET [Quenched from the Melt]  DO5C File: DATAVData\D5CADSc-pet 001

o4

0.z

Heat Flow (Wig)
o o o
= P [}

o
i
1

0.2 A

T T T T T T T T T T
a a0 100 150 200 250 200
Exa Lp Temperature [°C) Universal ‘2 .0F

NOTES: The curve can be shifted and/or rotated multiple times. To remove shifting/
rotating, select Remove Shifts from the Tool menu.

The Shift option is not available for log axis data.

Rotating Curves

If your curve can use adjustment, you can use the Rotate option to take
the curve and rotate it around the points chosen.

Follow these steps to use this function:

1.

If more than one Y-axis is displayed, choose the desired Y-axis to
shift by clicking on the Y number shown on the graph.

Select Tools/Rotate from the main menu. Markers are displayed on
the graph.

Double click at the first point where you want to shift the curve to
position the marker. The position of the horizontal bar of the marker
indicates whether the curve is to shift up or down and by how many
units. The vertical bar of the marker intersects the curve at the point
that will be brought to the level of the horizontal bar.

Double click at the second point to which you want to shift the curve
to position the next marker. See the figure on the next page.

THeRMmAL ADVANTAGE UNiveRsAL ANALYSIS OPERATOR'S MIANUAL 121



Customizing the Graphs

& Dsc-pet 001 I [=]
Sample: PET [Quenched fram the Melt]  DSC File: DATAVDat=2AD5SCADSc-peat 001
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)
Z 007
z
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r
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- |
0.4 1
Figure 4.18
7 -0.E T T T T T T T
Markersfqr the Shift 100 120 140 150 150
Curve Optlon Exo Up Temperature [°C) Uniwersal %2 .0F
5. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The program rotates the curve and redraws
the graph according to your specifications. See the figure below for
an example.
& Dsc-pet.001 =]
Sample: PET [Quenched from the Melt] DSC File: DATAVData\DSCA\Dsc-peat 001
0.4
0.2 1
=
= 0.0
z
=]
ra
%02
=
0.4
Figure 4.19
Example of a 0E : - : - : - ;
Rotated Curve 100 120 140 160 150
B Up Temparzture [°C) Universal “2 .0OF
NOTES: The curve can be shifted and/or rotated multiple times. To remove shifting/

rotating, select Remove Shifts from the Tool menu.

The Rotate option is not available for log axis data.
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Linear Transformation

You can perform a linear transformation on the selected Y-axis or X-axis
signals displayed on the graph using the appropriate option found in the

Tools menu.

The Y-axis or X-axis transformation functions are used to enter the
desired values into the general equation that the program will use to

perform the linear transformation, which adjusts the slope and/or inter-
cept of the selected Y-axis signal or the X-axis signal.

Follow these steps to perform this function:

1. If more than one Y-axis is displayed, choose the desired Y-axis to
smooth by clicking on the desired Y number displayed on the graph.

2. Select Linear Transform/Y Axis or Linear Transform/X Axis

from the Tools menu. The X or Y Transform window, shown in the

figure below, will be displayed.

Y Transform

[ Od¥slue — [WE )« [1.000

Mewalue =

|1.DEIEI

Ok

Cancel |

= IEI.EIEIEI

Help

]|

Figure 4.20
Y Transform Window

3. Enter the desired value for the equation in each field. The default
values are displayed when the window is first opened.

4. Click on the OK button when completed. The linear transformation

will be performed, the graph will be autoscaled, and the results

displayed on the screen.

NOTE: When a linear transformation is applied to the shifted data, the Remove
Shifts option is no longer available.

THeRMmAL ADVANTAGE UNiveRsAL ANALYSIS OPERATOR'S MIANUAL

123



Customizing the Graphs

Overlaying Curves

What is Curve Overlay?

NOTE:

NOTE:
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Performing a curve overlay operation lets you combine curves from
several different experiments or experimental techniques to provide a
visual comparison of the data. This will allow you to "overlay" the curves
on one window and position the graphs to display the data in a manner
that enables you to emphasize important aspects of the data. Up to four
individual Y-axes may be used, containing up to ten curves, each of
common units. Up to 20 separate overlay plots may be configured.

A signal from a file may only be used once. Signals containing the same units
(e.g., nonreversing and reversing heat flow, flexural and storage modulus)
may be overlaid on the same Y-axis, however, the axis label will reflect the
signal of the first curve added to the axis. Customize the axis label using the
Axes Page.

The curve is displayed on the overlay graph using the same conditions that
were used in the single file made. For example, the same data limits,
analyses, etc. will be used.

Follow these basic steps to overlay curves:
1. First you need to open and plot your files

using the desired signals.
Auto Configure. .

2. Then you can overlay curves using one of Manual Setup...
the following methods from the Graph/ Edit *
Overlay menu seen here: Copy *

. . Show Overlay Plat *
*  Auto Configure: Use this option to = o Mormial Elat

automatically configure the open data
files for curve overlay. When you select
this options, the Overlay Auto Configure window (see the next
page) is displayed to allow you to select the settings that you
want the program to automatically configure for you. See the
next section for details.

*  Manual Setup: Use the manual setup option to manually
configure a new curve overlay.

» Edit: Use the Edit option to edit the chosen curve overlay plot.

e Copy: Use the Copy option to copy the chosen curve overlay
plot.
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e Show Overlay Plot: Use this option to switch the window focus
to display the curve overlay results.

*  Show Normal Plot: Use this option to switch the window focus
to the normal plot window of the currently selected overlay curve
(the curve that is numbered).

Auto Overlay Functions

You can set up Universal Analysis so that the program will automatically
configure options that will be used to create a curve overlay graph. To do
this, you can use the Graph/Overlay/Auto Configure function to set up
a curve overlay graph initially (using the program-optimized settings),
then use the Graph/Overlay/Manual SetUp function to refine your
overlay graph.

Follow these steps to automatically set up your curves for overlay:
Step 1:
First you need to open and plot your files using the desired signals.
Step 2:

Then, select Auto Configure from the Graph/Overlay menu. The Auto
Configure window, as seen in the figure below, is displayed.

Dwverlay Auto Configure E3

Files: —Signals—  [Auto:
Pwc-1.001: PY-2450
Pyo 02 PY-1290 v 1 | ¥ Line  Ames @ Curves |
Puwc-3.003 PYC Green
v V2 | [~ Swmbol € Axes & Curves |
‘ [+ Color = Axes  Curves ‘
I3
[~ Curve offset v Asis
4 ¥ File selection [V Legend
Plat heading:
Sawe Diefault Cancel Help

Figure 4.21
Auto Configure Window
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Follow the instructions beginning on the next page to set up this window.

1. Check the desired Y-axis signal boxes (Y1, Y2, etc) to automatically
use the selected Y signal(s) for a curve overlay graph, when available
in the selected data files. For detailed examples, see the information
below.

Examples Y Signals (Curve Overlay)

— Ifseveral data files are chosen for Curve Overlay that have
signals plotted on axes Y1, Y2, and Y3, checking just the Y2
check box on the Auto Configure window will configure
only the Y2 signals from each selected data file.

— Ifthe Y2 signals in each file have the same units, then they
will all be configured on a single overlay axis.

— Ifthe Y2 signals in each file have different units, then each
signal will be placed on a different overlay axis.

NOTE: Signals from different Y axes are always
configured on different overlay axes, regardless of
their units.

— To autoconfigure identical signals from several files on
different overlay axes, open each data file with the signals on
the same axis (as desired on the overlay plot) and check all Y
signals check boxes on the Auto Configure window.

— To autoconfigure identical signals from several files on one
overlay axis, open each data file with the signals on the same
axis (as desired on the overlay plot) and check only the Y
signal check box for the axis specified.

2. Check the desired Auto options from the following:

e Line: Check this box to automatically apply the Auto Line
settings, found on the Manual SetUp/Auto Page, to the curve
overlay graph. To change the Auto Line settings after auto
configure is complete, use the Manual SetUp/Curves Page to
adjust the line type for each curve.

Examples Auto Line Checked:

— Checking Auto Line for Curves is equivalent to pressing the
Auto Line button on the Manual SetUp/Curves Page for each
overlay axis.

— Checking Auto Line for Axis assigns the first Auto Line type
to all curves on overlay axis Y1, the second Auto Line type is
assigned to all curves on axis Y2, etc.
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Example Auto Line Unchecked

— Ifthe Auto Line box is not checked, the line type for each
curve in the overlay will be the same as that used in the
individual file graph.

*  Symbol: Check this box to automatically apply the Auto
Symbol settings, found on the Manual SetUp/Auto Page, to the
curve overlay graph. To change the Auto Symbol settings after
auto configure is complete, use the Manual SetUp/Curves Page
to adjust the symbol type for each curve.

Examples Auto Symbol Checked

e Checking Auto Symbol for Curves (see the figure below) is
equivalent to pressing the Auto Symbol button on the Manual
SetUp/Curves Page for each overlay axis.

*  Checking Auto Symbol for Axis (see the figure below) assigns
the first Auto Symbol type to all curves on overlay axis Y1, the
second Auto Symbol type is assigned to all curves on axis Y2,
etc.

Example Auto Symbol Unchecked
* Ifthe Auto Symbol box is not checked, the symbol type for

each curve in the overlay will be the same as that used in the
individual file graph.

e Color: Check this box to automatically apply the Auto Color
settings, found on the Manual SetUp/Auto Page, to the curve
overlay graph. To change the Auto Color settings after auto
configure is complete, use the Manual SetUp/Curves Page to
adjust the color for each curve.

Examples Auto Color Checked

— Checking Auto Color for Curves is equivalent to pressing the
Auto Color button on the Manual SetUp/Curves Page for
each overlay axis.

— Checking Auto Color for Axis assigns the first Auto Color to
all curves on overlay axis Y1, the second Auto Color is
assigned to all curves on axis Y2, etc.

Example Auto Color Unchecked

— Ifthe Auto Color box is not checked, the color for each curve in
the overlay will be the same as that used in the individual file plot.
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3. Click on the Axes or Curves radio button to automatically apply the
associated setting to the curve overlay axes.

—  Example I: 1f you check Line and Axes, the Auto Line type
settings will be automatically applied to the curve overlay
axes. All curves on a single overlay axis will be assigned the
same line type.

—  Example 2: 1f you check Line and Curves, the Auto Line type
settings will be automatically applied to each curve on an axis.
The first curve on each overlay axis will be assigned the first
line type. The second curve on each axis will be assigned the
second line type, and so on.

4. Check any of the remaining four Auto options that you want the
program to optimize and apply to your overlay graph:

e Curve offset: Check this box to automatically apply the Auto
Offset settings from the Manual SetUp/Auto Page to each axis
in the curve overlay plot. To change the offset settings, use the
Overlay/Manual Setup function to manually adjust the offset
for each curve in the overlay plot.

—  Auto Curve Offset Checked: Checking the Auto Curve Offset
box is equivalent to pressing the Auto Offset button on the
Manual SetUp/Curves Page for each overlay axis.

—  Auto Curve Offset Unchecked: 1f you do not check the Auto
Curve Offset box, then no offset is applied to any curve in the
overlay plot.

*  Axis: Check this box to automatically configure the Show Color,
Symbol, and Line Type options for each overlay axis. If Auto
Axis is not checked, the Manual Set Up/Axes Page settings are
used.

*  File selection: Check this box to automatically include all of the
opened files for curve overlay. You can then uncheck any files
that you do not want to include.

* Legend: Check thisbox to automatically apply the legend
settings, that the program will optimize for you, to the curve
overlay graph. To change the Legend settings, use the Manual
Set Up/Legend Page. When the Auto Legend box is checked,
the program will include the minimum amount of information in
the legend that uniquely identifies the files included in the
overlay plot.
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NOTE:

NOTE:

5. Enter the plot heading that you want to have printed on your curve
overlay graph each time one is created using the Auto Configure
option. The plot heading will not be displayed on the screen, it will
only be PRINTED or EXPORTED.

6. Click the Save button, if you want to use these as your new default
settings for Auto Configure or click the OK button to use these
settings for this plot only. The curve overlay results will be dis-
played.

Step 3:

Use the Graph/Overlay/Manual Set Up function to refine the options to
be used. When you select Manual Setup from the Graph/Overlay
menu, the Curve Overlay Options window is displayed. Click on the tab
at the top of the window that will open the page pertaining to the item
that you wish to configure for curve overlay.

Step 4:

Save the curve overlay options when you have finished the manual setup
above.

Once the curves are displayed on the overlay plot, you can still perform
all of the same operations on the selected curve (e.g., analysis, rescaling,
etc.).

A signal from a file may only be used once. Signals containing the same units
(e.g., nonreversing and reversing heat flow, flexural and storage modulus)
may be overlaid on the same Y-axis, however, the axis label will reflect the
signal of the first curve added to the axis. Customize the axis label using the
Manual SetUp/Axes Page.

The curve is displayed on the overlay graph using the same conditions that
were used in the single file mode. For example, the same data limits,
analyses, etc. will be used.
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Setting Up the
Curve Overlay Options

To combine (overlay) curves from several different experiments, you
need to open and plot your files using the desired signals. Then create a
new curve overlay plot manually following the directions provided here.

1. Select Graph/Overlay/Manual Setup from the main menu. The
Curve Overlay Options window, shown in the figure below is
displayed.

2. Click on the tab at the top of the window that will open the page
pertaining to the item that you wish to configure for curve overlay.
Information on each of these pages can be found in this section on
the following pages.

Configuring
the Curves Page

The Curves Page (shown below) is used to set up the curves that will be
overlaid from the different data files.

Curve Overlay Options |
Curves |A:-:es I F'Iu:utHeau:Iingl Legendl Grid | Auto I
B
’7 oy Y2 3 (! Storage Modulus [MPa)
Curve Line Tppe  Sumbal Color ¥ Offzet File: M ame Show Legend Text
1 |Soid =l M Green x|[00 Puc-1.001 [V Py-2450
2 |Shotdash x| M Bue v |[2500  [Puc-2.002 ¥ Fv/-1280
3 |Dash dat jl B Maroon j 500.0 Prwe-3.003 [w P4C Green
4 |Sold =]l M Black |00 r
5 |Sold =]l M Black  ~ |00 r
E |Sold =]l M Black  ~ |00 r
7 |5old =]l M Black |00 r
8 |Sold =]l M Black  ~ |00 r
3 |Sold =]l M Black  ~ |00 r
10 |Sold =]l M Black |00 r
At Line | Auta S_I,Iml:uoll Auta Calar | : Add Curves | Delete Egr\-'esl Delete Al |
Ok | Save | Default | Cancel | Help |

Figure 4.22
Curve Overlay
Options—Curves Page
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1.

Follow these steps to configure the Curves Page:

Click on the desired Y-axis number at the top of the window to select
the Y axis that will be configured.

Click the Add Curves button. The Add Overlay Curves window is
displayed, as seen in the figure below. Select the files and signal to
be used.

Add Overlay Curves |

Overlay awiz 'l

Select files:

Select zignal:

Puyc-1.007: P-2450
Puwc-2.002: PY-1280

Select Al Files |

Deselect All Files |

Pyc-3.003 PYC Green

Show
' Compatible signals anly

Al zsignals

Y'1: Storage Modulus [MPa)

Cancel Help

Figure 4.23

Add Overlay Curves Window

3.

Select the line type to be used for each curve. Use either the drop-
down list or click the Auto Line button. (The automatic line type
selection can be set up using the Auto Page.)

Click on the Symbol block to display the Curve Symbol window
(shown on the next page), which allows you to select the symbols to
be used for the curves, or click on the Auto Symbol button. (The
automatic symbol selection can be set up using the Auto Page.) For
more information on symbols see “Changing Colors, Line Types,
Symbols, etc.”in this chapter.

Select the color to be used for each curve. Use either the drop-down
list or click the Auto Color button. (The automatic color selection can
be set up using the Auto Page.)

Enter the Y offset to be used or click the Auto Offset button. This
allows the curves to be offset in the Y direction. (The automatic
offset selection can be set up using the Auto Page.)
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Curve Symbol |
Symbal type: IN::: syribilz j Symbal: m
Symbaols:
Differentiate; I Curves j Spacing: I Coarze il I

Edit List...

Help

Figure 4.24 Ok, |

Curve Symbol Window

7. Edit the filename, if desired.

8. Check the Show Legend Text box, if you want to show any informa-
tion for this curve in the legend. You can also edit the legend text
here. The individual items displayed for each legend entry are
selected on the Legend Page.

9. Save the curve overlay options when you have finished the manual
setup. Click the Save button, if you want to use these as your new
default settings or click the OK button to use these settings for this
session only. The curve overlay results will be displayed.
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Configuring the Axes Page

The Axes Page (shown below) displays the axes that have been set up for
curve overlay using the Curves Page. Use this page to customize the axis
labels that will be displayed on the curve overlay window.

Curve Overlay Options E3

Curves Awes IPIntHeadingl Legendl Grid |f—\utu:u |

Dlirenzion Change [pm) " units; pm

Shaw: T Line Type [~ Colar [~ Symbal # offset: ID-D T
T2

M amne: I ' unitg:

Show: [ Line Type [ Calaor [~ Swmbal # offzet: ID.D “
3

Hane: I Y units:

Show: [ Line Type [~ Calar [~ Swumbal 7 offzet; IU.U T
—rd:

Marne: I " units;

Show: [ Line Type [~ Colar [~ Symbal # offzet: IU.U T
R

M arie: |Temperature [*C]  units: T

(1] 4 I Save Default Cancel Help

Figure 4.25
Curve Overlay
Options—Axes Page
Follow these steps to customize the axis labels using this window:

1. Edit the name(s) of the axis label(s) displayed, if desired. The units
associated with the axis signal are displayed next to the name.

2. Check the box next to the desired items that you want to be displayed
in the Y-axis label: Line type, Color, or Symbol.

3. Enter the desired X-axis offset. This allows curves to be offset by a
fixed amount from each other in the X direction. (This does not apply
to the first curve.) The X-axis offset can be used with Y-axis offsets
to produce a simple 3-D (Z axis) effect on the plot.

4. Click the Save button, if you want to use these as your new default

settings or click the OK button to use these settings for this session
only. (The names entered here cannot be saved as a default setting.)
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Configuring the Plot Heading Page

The Plot Heading Page (shown below) is used to customize the plot
heading that will be placed on the curve overlay graph.

Curve Overlay Options E3

Eurvesl Lxez  Plot Heading | Legendl Grid I Auto I

M anme: IEuwe Dverlay 1

dJustification:
" Left {« Center " Right

Tenut:

Save Default Cancel Help

Figure 4.26
Curve Overlay Options—
Plot Heading Page

Follow these steps to customize the plot heading using this window:

1. Enter the desired name (maximum of 80 characters) for the overlay
window that will be created. This name will appear in the window
title and Windows menu only. It is used to help identify one curve
overlay plot from another.

2. Click on the desired button to choose the alignment of the text from
the following justifications: Left, Center, or Right.

3. Enter up to four lines of 76 characters that are used for the plot
header information.

4. Click the Save button, if you want to use these as your new default

settings or click the OK button to use these settings for this session
only.
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Configuring the Legend Page

The Legend Page (shown below) is used to customize the legend that
appears on the curve overlay window. An entry in the legend appears for
each curve that is displayed in the overlay graph.

Curve Overlay Options E |

Eurvesl Aues I Plat Heading  Legend IGriu:I I Auto I

¥ Line type [+ Caolar [~ Symbol ¥ File narme [ Text
—Manual position:
Vertical————— Horizomtal:
e |1.uuu % Top ) Left
" Center " Center
i I-I'EIDD & Bottom & Right

0k I Save Default Cancel Help

Figure 4.27
Curve Overlay Options—
Legend Page

Follow these steps to choose what will appear in the legend:

1. Check the box next to the desired options that will be displayed in
the legend: Border, Line type, Color, Symbol, File name, Text. See
“Changing Colors, Line Types, Symbols, etc.” in this chapter for
more information.

2. Select the x and y coordinates on the graph for the manual position-
ing of the legend. The coordinates are unitless and range from 0.0 to

1.0 on the X and Y axis.

NOTE: When the curve overlay window is displayed, you can drag and drop the
legend anywhere on the graph.
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3. Click on the radio buttons desired to select the position for the point
of reference that is used to move the legend to the selected coordi-
nates. For example, if you choose both center radio buttons, the
center of legend box is positioned at the coordinates selected.

4. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session
only.

Configuring the Grid Page

Use the Grid Page (shown below) to select the grid that can be used for
each axis.

Curve Overlay Options E3

EurvesIAHes IPIDtHeadingI Legend Grid |Autn I

Az
’7 (Gl Y2 %3 (i !

Grid type: Mo grid -

k. I Save Default Cancel Help

Figure 4.28
Curve Overlay Options—
Grid Page

Follow these steps to select the grid type:

1. Click on the radio button to choose the desired Y axis that will
display the grid.

2. Select the grid type from the drop-down list.
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3. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session
only.

Configuring the Auto Page

Use the Auto Page (shown below) to set up the Auto Line, Auto Symbol,
Auto Color, and Auto Offset buttons shown on the Curve Page and the
similar settings on the Auto Configure window. The settings shown on
this page will be used when you click on those buttons.

Curve Overlay Options E2 |

Eurvesl Bues I F'Iu:utHeadingI Legendl Gnd Ao |
line————————— —Sumbal Color——————— —Offzet:
1 Solid - 1 L 1 G -
2 L S M Green = = Major axis tick
2 |Short dash =] 2 0 2 | EBEle hd
3 |Dashdot = 3 + 3 | Mtaroon hd = Minar axis tick
4 | Broken dbl d. = | 4 L+ ] 4 | Ml Fuchsia |
6 [Longdash ] 5 = 5 [ Ted -] f* Half minor axis tick
B |Broken da&h; & A E | M MNaw | = Percent of axis range:
7 |Dash hd 7 . 7 | M Puple |
g |5oid - g | * 5 (M Red ¥ o =
9 |Short dash = 3 o 9 Ol -
bl e M Oive = [ Megative offsets
10 [Dashdot =) 0 | & 10 | M Black =
—Scale:
1 v 72 v va v rd v =
Save Default Cancel Help

Figure 4.29
Curve Overlay Options—
Auto Page

Follow these steps to configure the Auto buttons:

1. Select the desired line type for the first curve from the drop-down
list.

2. Position the pointer over the first symbol field and click the mouse
button to display the Curve Symbol window (see Figure 4.20).
Choose the desired symbol type, then click OK. For more informa-
tion on symbols see “Changing Colors, Line Types, Symbols, etc.”
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Select the desired color for the first curve from the drop-down list.
Repeat steps 1, 2 and 3 for all ten curves.

Click on the desired radio button for the desired offset. See the next
section “Results of Offset Selections” for details on the effect of
these selections.

*  Major axis tick: Positions (offsets) each curve on the axis
positively by an amount equal to a major axis tick when the Auto
Offset button is selected.

e Minor axis tick: Positions (offsets) each curve on the axis
positively by an amount equal to a minor axis tick when the Auto
Offset button is selected.

e Half minor axis tick: Positions (offsets) each curve on the axis
positively by an amount equal to a half minor axis tick when the
Auto Offset button is selected.

*  Percent of axis range: Positions (offsets) each curve on the axis
by an amount equal to the percentage of the axis range entered
when the Auto Offset button is selected. Enter the desired
percentage.

Check the box for negative offsets, if you want to use the offset
chosen above as negatives.

Check the desired boxes for the axes that you want to autoscale. Any
unchecked axes will not be autoscaled when using the curve overlay
function. (The default setting is all axes checked.)

Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this curve
overlay only.

Results of Offset Selections

138

The Auto Offset selections result in the offset of the curves from each
other as follows:

No offset is applied to the first curve on an axis.

The second curve is offset by the amount equal to one offset interval
when the Auto Offset button is selected.

The third curve is offset by an amount equal to twice the offset
interval when the Auto Offset button is selected.
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*  The fourth curve is offset by the amount equal to three times the
offset interval when the Auto Offset button is selected.

e Andsoon...

ah Curve Overlay [ _ O =]

Curve 1 PY-2450 Db, File: O ATA InstrumentsiT A Data Dk AP c-1 001

1.4

—  Pwc-3.003

Puwc-1.001 ;
1-——— Pwc-2ooz ﬂ

Tan Delta
o
o0

=
fus]
1

0.4

0.2

0.0 T T T T T T T T
=150 =100 =50 u] 50 100 150
Temperature (°C) Universal %2.10C

Figure 4.30
Example of Finished
Curve Overlay

Once a curve overlay graph has been created and displayed, you can
position the pointer over a curve Y-axis label or legend and right click to
display the Curve Overlay Options window. This allows you to edit the
curve overlay graph.

You can also reposition a curve on the overlay graph already created.

Select the desired curve, then drag-and-drop it at the position you want
using the left mouse button.
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Exporting Plots

You may find that you would like to use the graph image that you have
plotted using Universal Analysis in another application for a presenta-
tion or report, etc. It is possible to export the plot to a file for just such a
purpose. It is suggested that you become familiar with the type of file
that is compatible with your application before you use this function, or
you can just export the plot to the clipboard and retrieve it into your
application.

To export a plot, follow these steps:

L.

Export Plot

Select File/Export Plot from the main menu. The Export Plot
window, shown below, is displayed.

—Desztination:
" Clipboard

* Fils

Erypet

" Plokter

£ Printer

Browsze. .. C:ATaMD atahPurity, emf

Setup...

—Format;

* Metafile Im i+ Full Size Height: IW percent
= Bitmap Im {~ Beduction fidth: IW percent
(ol I YT | " Pigels Penwidth: [3

¢ BOF  [lewer 7]

—Size:

Drark, colors anly

[

E =port Save Drefault Cancel Help

Figure 4.31
Export Plot Window

2. Select the plot's destination from one of the following options:

140

e Clipboard exports the plot to the computer clipboard so that it
may be pasted into other applications after export. Note that you
must also select the desired format—Metafile or Bitmap—before
exporting the plot.
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»  File exports the plot to a file. If you choose the file export
option, you must enter a filename or use the Browse button to
locate a filename. You must also select the format for export.

»  Plotter exports the plot to a plotter. The plotter must already be
configured online with your computer and connected to the port
specified on the Main Options - Export Plot Page (select File/
Options).

*  Printer exports the plot to a printer. The printer must already be
configured online with your computer.

NOTE: The default printer will be used unless you specify a different printer. Use the
Setup button, if needed.

3. Select the format for export from the following options:

*  Maetafile exports your plot to a file using the Metafile format. If
you select this option, you must also choose a Metafile type from
the Metafile list.

e Bitmap exports your plot to a file using the Bitmap format. If
you select this option, you must also choose a Bitmap pixel
format to use from the drop-down list.

*  HPGL exports your plot to a file using the HPGL format. If you
select this option, you must also choose a HPGL symbol type
from the HPGL list.

*  PDF exports your plot to a file using the PDF format. If you
select this option, you must also choose a paper size from the
drop-down list to the right.

4. Select the desired colors for export from the drop-down list.

* All Colors: All of the colors shown on the monitor will be
exported.

*  Dark Colors Only: The light colors (white, yellow, aqua, and
lime green) will be translated into darker colors.

*  Black and White Only: All colors will be translated to black
and white.

5. Select the size desired for the exported plot, if applicable:

e Full Size is 100% of the allowable size.
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*  Reduction reduces the plot to the percentage entered for height
and width reduction.

*  Pixels sizes the plot to the entered size in pixels.
6. Enter the desired pen width, if applicable.

7. Click on the Save button, if you want to save the settings for the plot
destination chosen.

NOTE: You can set up each plot destination with its own settings, then click the
Save button each time to save them as the default settings for that specific
destination.

8. Click the Export button when completed.
NOTE: ‘l HPGL is the only format available when you export to a plotter.

NOTE: ‘ Changes made when exporting to the clipboard or printer affect the pasted
plot (Edit/Copy Plot) and File/Print functions respectively.
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Printing Plots

There are three different printing options you can select in Universal
Analysis:

Print

To print your plots, select File/Print from the main menu. A standard
Windows® Print dialog box is displayed, which lets you specify the
range of pages to be printed, the number of copies, the destination
printer, and other printer setup options.

Or you click on the Print button && to print directly to the default system
printer without displaying the Print dialog box.

Print Preview

You can also preview the plots before it is printed using File/Print
Preview on the main menu. An example of a plot shown in the Print
Preview window can be seen in the figure on the next page.

Print Setup

To set up your particular printing options, select File/Print Setup from
the main menu. The print setup dialog box specific to your printer will be
displayed. Choose the options you want to use when printing plots in
Universal Analysis.

NOTE: Changes that you have made on the Export Plot window (such as reductions)
will be applied when you use the printing options described above.
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Introduction

Chapter 5

Analyzing the Data

After you have used the other features contained in the Universal
Analysis program to set up your graph the way you want it to appear, you
can analyze the data using the functions found in this chapter.

Although each type of analysis is different, there are basic steps that
generally apply to most of the analyses.

Basic Analysis Steps

Most of the analyses that you can perform in the Universal Analysis will
follow the same basic steps. There may be additional information that you
need to enter through special dialogs, but most of the analyses involve
choosing and accepting limit points. You can apply the following basic
steps to most types of analyses in the Universal Analysis program.

1.

Click on the appropriate Y-number label displayed above the desired
axis on the graph to select that axis, if more than one Y-axis is
displayed.

If you are analyzing a curve from a family of curves, (e.g., multi-
plexed data) select the desired curve for the analysis by choosing
Edit/Frequency List, Edit/Amplitude List, or Edit/Location List
then selecting the desired curve (or by using the Analyze/Analyze
Range options).

Select the desired operation from the Analyze menu, from the pop-up
menu, or click the appropriate tool bar button. One or more markers
are displayed. (See “Tips on Using Markers.”)

Double click at the point on the curve where you want the baseline to
begin (before the transition) to position the first marker. The next
marker (if applicable) becomes active.

Double click at the point on the curve where you want the baseline to
end (after the transition) to position the second marker. Repeat steps
3 and 4 if additional points are required for your analysis.

Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The analysis results are displayed.

Change the position of the fitted lines, if desired, by selecting Adjust
Results from the Edit or pop-up menu.
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NOTE: You can change the parameters of certain analyses befare they are performed by
using Analyze/Options to set the desired analysis options.
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Using the Analyze Menu

The Analyze menu is used to choose the type of analysis that you want
to perform on the current data file. This menu reflects the type of analy-
ses available for the particular type of signal that is currently selected.
For example, if an SDT data file is currently active, and a TGA signal has

been selected, the analyze menu contains only
those types of analyses that relate to TGA

analysis.

The Analyze menu shown here is displayed
when a DSC data file is opened.

A set of generic analyses are always available
for any signal selected. Signal-specific analyses
are only available when that signal is selected
and displayed as “normal” type (with no

derivative applied).

NOTE: ‘

This chapter will discuss each one of the
different types of analysis in further detail on
the pages that follow.
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Analyzing the Data

Using the Analysis Pop-Up Menu

Table 5.1
Analysis Pop-Up
Menu Items

148

After you have selected an analysis option from the
Analyze menu, a pop-up menu becomes available.

Accept Limits
tanual Lirmitz...

This Analysis pop-up menu allows you to change i::il;:m“s"'
to a manual method for entering data limits, accept -

the limits chosen, cancel the operation, or choose a Faint 1
point to enter. Foint 2

The menu items found on the Analysis pop-up menu are described in
the following pages:

Menu Item

Description

Accept Limits

Manual Limits

Auto Limits

Use the Accept Limits function to accept the
chosen data limits for analysis. The results of the
analysis will be displayed on the graph.

Use the Manual Limits function to select limit
points by entering numeric values from the key-
board. When you select this option the Manual
Limits window is displayed, allowing you to enter
the numerical values desired.

Use the Auto Limits function, which is available
for certain types of analyses, to store and then
automatically reuse stored analysis limits. This
option is good for repeating a particular analysis on
similar data files and take the uncertainty factor
out of trying to choose the correct analysis limits.
The desired position of the cursors relative to the
peak can be predetermined using the Auto Limits
feature. Then when you analyze similar data files,
you can recall the appropriate cursor position and
perform accurate analyses quickly. When you
select this option a window is displayed that allows
you to either use the cursor (marker) position that
the operator selects or to use an offset (or differ-
ential fraction).

(table continued)
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Table 5.1
Analysis Pop-Up

Menu Items (cont'd)
Menu Item

Description

Cancel

Point
1,2,3,4,5,6

Use the Cancel option to abort the operation
chosen.

Use the Point menu items to activate the applicable
marker on the graph. This allows you to more
accurately position the markers for analysis. The
number of points available depend upon the type of
analysis and the chosen analysis options.
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Setting the
Analysis Range

The Analysis Range option is used to set the analysis range from
portions of the original X-axis range, thus confining your data for analysis
purposes to the chosen range. Data outside this range becomes invisible
to the analysis functions, but analyses already performed on these curves
are retained.

When you select Analyze/Analysis Range Full Range
from the main menu, the menu (example shown Erter Lirnits. .
here) is displayed. Select Cycle...

Select Frequency...

The items shown in the menu are explained in
this section on the following pages.

Using the Full Range

The Analyze Range/Full Range menu option is used to restore all of
the data points available in the file for analysis after the range has been
limited by one of the other analysis range options.

Entering Limits

The Analyze Range/Enter Limits menu option is used to select points
for the new analysis range.

1. Select Enter Limits from the Analyze/Analysis Range menu.
Markers will be displayed on the graph.

2. Double click on the desired place on the curve to position the marker
at the beginning of the region of the curve you want to analyze.

3. Double click on the desired place on the curve to position the next
marker at the end of the region you want to analyze.

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The graph is redrawn using the analysis

limits chosen.

NOTE: ‘ Data outside the analysis range is drawn in the grid color instead of the normal
curve color.
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NOTE: \When the program redraws the plot, part or all of the region you rejected for
analysis may be excluded. Toview the entire graph again, select Rescale/
Previous Limits. The previous limit points will be shown, but your analysis range
will still be restricted, as indicated by the grid color of the data outside the analysis
range.

Selecting a Cycle

The Analyze Range/Select Cycle option is used to segregate data using
the cycle markers contained in the data file. (See the online manual
accompanying Thermal Advantage Instrument Control for information
on creating methods that will add cycle markers to your data.)

1. Choose Select Cycle from the Analyze/Analysis Range menu.
The Data Cycle window, shown in the figure below, is displayed.

Data Cycle |
Analyze data cycle IE af 11.

Enter 0 far all data in file.

] 4 Cancel | Help |

Figure 5.1
Data Cycle Window

2. Enter the desired cycle number to be used for analysis.
3. Click the OK button.

NOTE: This aptionis anly available for data files containing either cycle markers, multiplexed
data, ordata storage off/on method segments.
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Selecting a Multiplex Value

The Analyze Range/Select Frequency (Amplitude or Location)
option is used to separate the data according to a chosen multiplex value.
This option is very useful when performing a function (such as analysis)
onan individual value.

1. Choose Select Frequency or Select Amplitude or Select Loca-

tion from the Analyze/Analysis Range menu. A window, such as
the Data Frequency window shown below, is displayed.

Data Frequency |

Analysiz Frequency: ~

] 4 Cancel | Help |

Figure 5.2
Data Frequency Window

2. Click on the button to display the drop-down list of multiplex values
available.

3. Click on the desired value, then click the OK button. The data in that
range will be available for analysis. The data outside the analysis
range will be grayed out.
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Tips on Using Markers

Markers are lines that are used to select points on a graph during rescal-
ing and analysis operations. Depending on the action and/or the file,
markers will be displayed as a single vertical line or as a set of vertical
and horizontal lines.

When using markers, keep in mind the following tips:

Active vs. Inactive Markers

*  Only one marker is active at any time.
* The active marker can be indicated two ways depending on the
action or file: As a full-length vertical and horizontal line or as a

single vertical or horizontal line.

» Inactive markers are generally seen as a cross.

Sample: PET (Quenched from the Melt) DEC File: DA TA\Data \DECGA\Dse-pet 001
0.4
0.2 .
Active Marker
0.0+
=
= -2
=
jr |
T4
= T Inactive |Marker
-0 6o
-0 .8+
-1.0 T T T T T T T T T T .
" 8] S0 10 150 200 =61 ann
exa Temperature (703 Universal ve.OC

Figure 5.3
Example of Active
and Inactive Markers
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Moving Active Markers

e To move active markers with the mouse follow these steps:

1. Grab the marker with the left mouse button as follows: Position
the point at the intersection of the cross or anywhere on the
single line. Press and hold down the left mouse button.

2. Drag the marker to the desired position and release the mouse
button.

*  To move the active marker with the keyboard, use the right and left
arrow to move the marker or hold down the Ctrl key or Shift key
while using the arrows to move the marker 10 pixels at a time.

e To move an active marker quickly you can also position the pointer
at the desired location and double click the left mouse button to move
the marker to this point. This action causes the next marker to
become active.

Activating a Marker

NOTE:

154

To activate (select) the next marker you can use any one of these
methods:

* Position the pointer over the inactive marker and click the left mouse
button.

or

* Right click to display the pop-up Analyze menu and select the next
point from the menu.

\When using markers to perform peakintegration, you can drag-and-drop the first
set of markers to encompass the first peak. Then, if you want to analyze a neighbor-
ing peak onthe curve, you can leave the right-hand markerin its existing position
(thereby keeping the exact same data point, which will become the start point of the
second peak] and drag-and-drop the left-had marker at the stop point desired for the
second peak.
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Step/Glass Transition Analysis

NOTE:

The Step Transition or Glass Transition analyses (both are very
similar) are used to calculate the onset, end, inflection, and signal change
of a step/glass transition in the curve. For example, this analysis enables
you to determine DSC glass transtion.

Tangents

\ Onset

Inflection

Onset is the intersection of the first and second tangents.

Inflection is the portion of the curve between the first and third
tangents with the steepest slope.

End is the intersection of the second and third tangents.

‘l The Step/Glass Transition option is nat available if the Y-axis scale is log.

The step/glass transition can be done in either of two ways: automatic
mode (which is the default condition) or manual mode (selected on the
Analysis Options - Step Transition Page).

In automatic mode the program draws three tangent lines between
the two data limits that you select.

In the manual mode, you specify the start and stop limits for each
of the three tangent lines. The intersection of the first two lines is the
onset, and the intersection of the second two is the end.

Follow these steps to perform the step/glass transition analysis:

1.

Select Step Transition or Glass Transition from the Analyze
menu. Markers will be displayed on the graph.

Position the active marker by double clicking on the curve at the point
where the data for the tangent line will begin.
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Analyzing the Data

3. Position the second marker by double clicking on the curve at the
point where the data for the tangent line will end.

4. If you are using manual mode, repeat steps 2 and 3 for Points 3
through 6 until all six markers have been placed.

5. TGA data only: The Transition Label window (see the figure on
the next page) is displayed. Enter the desired text (up to 30 charac-
ters) and click the OK button.

6. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter).

The program draws the tangent lines, calculates and displays the onset,

midpoint,and end.
¥ D sc-pet.001 M=l B3
Sample: PET (Quenched from the Melf) DEC File: DATAData\DSC\Dsc-pet.001
0.4
0.2
0.0+
=
E 4
=
& -0.24 73B0°C
- TE.49°C(N
[y - T T
E TT.BE"C
-0.4
_DE -
-0.8 T T T T T T T T T T T T T T T T T
20 40 1] a0 100 120 140 160 180 200
Exo Lp Temperature {"C) Universal W2.18
Figure 5.4
Example of
Step Transition Analysis

NOTE: You can change the parameters of this analysis by using Analyze /Options to set
the desired analysis options.
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\Weight Change

Figure 5.5
Transition Label Window

The Weight Change option is used to determine the amount of change
in the weight between two points on a TGA curve. A horizontal line is
drawn from your selected start point to a vertical line drawn from your
selected stop point. The difference between these points is reported in the
units of the Y-axis.

Follow these steps to determine the TGA weight change:

1. Select Weight Change from the Analyze menu. Markers will be
displayed on the graph.

2. Double click on the desired place on the curve to position the marker
at the beginning of the region of the curve you want to analyze.

3. Double click on the desired place on the curve to position the next
marker at the end of the region you want to analyze.

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The Transition Label window is displayed.

Tranzition Label

Enter text far tranzition label:

] Cancel | Help |

5. Enter any text that you want to display on the graph (up to 30 charac-
ters), then click on the OK button.

The program calculates the weight change and displays the results in
percent and in the units of the Y-axis as shown in the figure on the next

page.
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Analyzing the Data
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Figure 5.6

Example of Weight Change Analysis
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Temp/Time at Weight %

The Temp/Time at Weight % option is used to locate the X-axis value
on a TGA curve (either time or temperature) that corresponds to a
selected Y-axis value, and label the graph with the weight percent.

NOTE: || This analysis is only available when the selected Y-axis units are in % weight.
Follow these steps to perform this analysis:

1. Select Temp/Time at Weight % from the Analyze menu. A
marker will be displayed on the graph.

2. Position the horizontal marker at the weight on the curve for which
you want the corresponding X-axis value (either temperature or
time).

3. Rightclick to display the Analyze pop-up menu, then select Accept
Limits (or press Enter).

The program calculates the results and marks the graph with a cross at
the selected point and labels it with the corresponding X- and Y-axis
values as seen in the figure below.

&% TGA-Caox.001 M[=] E3
Sample: Calcium Oxalate Monohydrate TGEA File: EATADAta\T GAVT GA-Caox.001
120
100 4
= 204
il
= 610.66°C 62.78%
=
o
=

G0 -

20

. T v T v T . T v
u] 200 400 GO0 200 1000
Temperature ("C) Uniwversal W2.0%

Figure 5.7
Example
Temp at Weight % Analysis.
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Analyzing the Data

Weight At Temp/Time

VWeight Loss

NOTE:

160

Use the Weight At Temp/Time option to locate the X-axis value on a
TGA curve (either time or temperature) that corresponds to a selected
Y-axis value, and label the graph with the weight remaining in the sample.

Follow these steps to perform this analysis:

1. Select Weight At Temp/Time from the Analyze menu. A marker
will be displayed on the graph.

2. Position the horizontal marker at the weight on the curve for which
you want the corresponding X-axis value (either temperature or
time).

3. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter).

The program calculates the results and marks the graph with a cross at
the selected point and labels it with the corresponding X- and Y-axis
values.

Temp/Time

Use the Weight Loss Temp/Time option to locate the X-axis value on
a TGA curve (either temperature or time respectively) that corresponds
to a selected Y-axis value, and label the graph with the weight lost (ng,
mg, or %) from the sample (from the original or 100 % weight).

Follow these steps to perform this analysis:

1. Select Weight Loss Temp or Weight Loss Time from the
Analyze menu. A marker will be displayed on the graph.

2. Position the horizontal marker at the weight on the curve for which
you want the corresponding X-axis value (either temperature or
time).

3. Rightclick to display the Analyze pop-up menu, then select Accept
Limits (or press Enter).

The program calculates the results and marks the graph with a cross at
the select point and labels it with the time or temperature and the corre-
sponding weight lost from the sample (from the original weight).

‘I This analysis is only available when the selected Y-axis units are weight.
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Residue

The Residue option is used to report the difference between any se-
lected point on the TGA curve and the final weight. The final weight is
assumed to be zero, but can be modified to any value using the Modify
Size option.

Follow these steps to perform this analysis:

1.

Select Residue from the Analyze menu. A marker will be displayed
on the graph.

Position the marker at the point on the curve that you want to ana-
lyze.

Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The Transition Label window is displayed.

Enter any text that you want to display on the graph (up to 30 charac-
ters), then click on the OK button.

The program calculates the residue and displays the results on the graph,
along with the transition label as shown in the example below.

& TGA-Caox.001 M=l E3
Sample: Calcium Oxalate Monohydrate TGA File: EATAVD ata T & AMT GA-Cao 001
120
100
~— 80 4
=
=
=
i)
£ 5o
Residue:
28.82%
40 4 I(B.BSBrngj
20 T T T T T T T T
u] 200 400 [a{u]u] 200 1000
. Temperature (°C) Universal W2.00G
Figure 5.8

Example of Residue
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Analyzing the Data

Modify Size

The Modify Size options (menu shown here) for

TGA files are used to modify the sample weight used | Manual Limits...

in the percent weight calculations. This allows you to Graphic Limits...
provide volatile-free and ash-free results. These Graphic Start...

options can also be used to isolate a reaction from Graphic Finish...
other side reactions (e.g., oxidation).

The Modify Size options are available anly when the weight signalis plottedin

NOTE:
percent.

The default sample weight is the weight measured at the start of the run.
You can change the start and/or the stop weight, and the program will
adjust the percent axis based on the new weight. The shape of the curve
itself does not change.

After you have used one of the Modify Size analysis options (which are
explained on the following pages) to change the size, any subsequent
analyses are based on the new modified size-previous analysis results are
unaffected.

If you want to restore the original size after modifying it, select Graph/

Data Limits/Full Range from the main menu. All analyses performed
on the modified size will be lost.
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Using Manual
Limits to Modify Size

The Modify Size/Manual Limits option is used to enter start (100%)
and final (0%) sample weights directly from the keyboard as follows:

1. Select Modify Size/Manual Limits from the Analyze menu. The
Modified Size Limits window is displayed to allow you to change

the size.

NOTE: | I The current sample size is displayed for reference.

Modified Size Limits

Current Size: 10,1500 mg

Start WWeight: mg
Final Weight: [0.0000 mg
Ok Caticel | Help |
Figure 5.9
Modified Size

Limits Window
2. Enter the desired start weight.
3. Enter the desired final weight.
4. Click the OK button. The entries are shown again for confirmation.
The modified sample weight is the difference between these two
points.

5. Click OK again to accept the weights displayed.

The program adjusts the percent axis (y-axis) to the modified weight and
alters the axis label to reflect the changes.

After you have used one of the Modify Size analysis options to change
the size, any subsequent analyses are based on the new modified size-
previous analysis results are unaffected.

If you want to restore the original size after modifying it, select Graph/

Data Limits/Full Range from the main menu. All analyses performed
on the modified size will be lost.
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Analyzing the Data

Using Graphic
Limits to Modify Size

The Modify Size/Graphic Limits option is used to enter start (100%)
and final (0%) sample weights by choosing corresponding X-axis points
(temperature or time) using the markers.

Follow these steps to perform this analysis:

1. Select Modify Size/Graphic Limits from the Analyze menu.
Markers will be displayed on the graph.

2. Double click on the desired place on the curve to position the marker
at the beginning of the region of the curve you want to analyze.

3. Double click on the desired place on the curve to position the next
marker at the end of the region you want to analyze.

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The modified size values are displayed for
verification.

5. Click the OK button to accept the modified weight or Cancel to exit
the analysis. If you accept the results, the program adjusts the
percent axis (y-axis) to the modified weight.

After you have used one of the Modify Size analysis options to change
the size, any subsequent analyses are based on the new modified size—
previous analysis results are unaffected.

If you want to restore the original size after modifying it, select Graph/

Data Limits/Full Range from the main menu. All analyses performed
on the modified size will be lost.
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Using Graphic
Start to Modify Size

The Modify Size/Graphic Start option is used to select a volatile-free
start weight using a marker to choose a corresponding X-axis point
(temperature or time). The modified sample weight is considered the
difference between the chosen point and the stop point.

Follow these steps to perform this analysis:

1. Select Modify Size/Graphic Start from the Analyze menu. A
marker is displayed on the graph.

2. Position the marker at the desired start weight.

3. Rightclick to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The modified size values are displayed for
verification.

4. Click the OK button to accept the modified weight or Cancel to exit
the analysis. If you accept the results, the program adjusts the
percent axis (y-axis) to the modified weight.

After you have used one of the Modify Size analysis options to change
the size, any subsequent analyses are based on the new modified size-
previous analysis results are unaffected.

If you want to restore the original size after modifying it, select Graph/

Data Limits/Full Range from the main menu. All analyses performed
on the modified size will be lost.
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Analyzing the Data

Using Graphic
Finish to Modify Size

The Modify Size/Graphic Finish option is used to select an ash-free
final weight using a marker to choose a corresponding X-axis point
(temperature or time). The modified sample weight is considered the
difference between the chosen point and the stop point.

Follow these steps to perform this analysis:

1. Select Modify Size/Graphic Finish from the Analyze menu. A
marker is displayed on the graph.

2. Position the marker at the desired final weight.

3. Rightclick to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The modified size values are displayed for
verification.

4. Click the OK button to accept the modified weight or Cancel to exit
the analysis. If you accept the results, the program adjusts the
percent axis (y-axis) to the modified weight.

After you have used one of the Modify Size analysis options to change
the size, any subsequent analyses are based on the new modified size-
previous analysis results are unaffected.

If you want to restore the original size after modifying it, select Graph/

Data Limits/Full Range from the main menu. All analyses performed
on the modified size will be lost.

166 THerMAL ApvanTAGE UNivERSAL ANALYSIS OPERATOR'S MIANUAL



Alpha At X

The Alpha at X option is used to calculate the expansion coefficient
(alpha) using a single point on a TMA curve. Alpha is calculated from the
smoothed digital derivative at the point.

Follow these steps to perform this analysis:

1. Select Alpha At X from the Analyze menu. A marker is displayed
on the graph.

2. Double click at the region of the curve that you want to analyze to
position the marker.

3. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter).

The program will calculate the expansion coefficient (alpha) at the single
point X. The result plus the temperature at the chosen point will be added
to the graph.

NOTE: || This optionis only available when a dimension change signal is selected.
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Analyzing the Data

Alpha X1 to X2

The Alpha X1 to X2 option is used to calculate the expansion coefficient
changes in dimension, divided by the change in temperature between two
selected points on a TMA curve.

Follow these steps to perform this analysis:

1. Select Alpha X1 to X2 from the Analyze menu. Markers will be
displayed on the graph.

2. Double click at the beginning of the region of the curve that you want
to analyze to position the marker.

3. Double click at the end of the region of the curve that you want to
analyze to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter).

The program will calculate the expansion coefficient (alpha) between the
two points. The result plus the temperature values of the two analysis
limits will be added to the graph. See the figure below for an example of
Alpha X1 to X2 analysis.

NOTE: || This option is anly available when a dimension change signal is selected.

&® Tma-al-e.001 [_ (O]

Sample: Aluminum Expansion Thid File: EATAM ata\ThATma-al-=.001

13

-
=
1

FO.02°C
Alpha=22 Bpmim°C

Dirmension Change (um
h

T
20 40 [aln} 20 100
Temperature (°C) Uniwversal W2 006

Figure 5.10
Example Alpha X1 to X2
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Alpha Fit X1 to X2

The Alpha Fit X1 to X2 option is used to calculate an expansion coeffi-
cient that is measured as the slope of a line fit through a region of data
between two points on a TMA curve.

Follow these steps to perform this analysis:

1. Select Alpha Fit X1 to X2 from the Analyze menu. Markers will be
displayed on the graph.

2. Double click at the beginning of the region of the curve that you want
to analyze to position the marker.

3. Double click at the end of the region of the curve that you want to
analyze to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter).

The program will calculate the expansion coefficient as a linear fit
through the data between the two points. The result plus the temperature

values of the two analysis limits will be added to the graph.

NOTES: Endpoints may nat lie exactly onthe curve because a line has been fitted through the
data.

This option is anly available when a dimension change signal is selected.
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Analyzing the Data

Dimension Change

During your TMA experiment, the sample will react to the changes in the
physical environment placed upon it. This may be a change in tempera-
ture, force, or atmosphere. The resulting dimension change of the TMA
sample is detected by the instrument’s probe and can be measured
between any two points on the data curve using the Dimension Change
option.

Follow these steps to perform this analysis:

1. Select Dimension Change from the Analyze menu. Markers will
be displayed on the graph.

2. Double click at the beginning of the region of the curve that you want
to analyze to position the marker.

3. Double click at the end of the region of the curve that you want to
analyze to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter).

The program will calculate the dimension change of the sample within the
specified limits, drawing a horizontal line from point 1 and a vertical line
from point 2. The results are displayed on the graph. See the figure below
for an example of Dimension Change analysis.

NOTE: || This optionis only available when a dimension change signalis selected.
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Figure 5.11
Example of - . . .
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Integrate Peak

The Integrate Peak menu contains analysis options that are used to
calculate and report start and stop temperatures, onset temperature, peak

maximum temperature, and peak area.

When you first select the Integrate Peak
menu, it appears as shown here, with certain
options grayed out.

First Peak Integration

Perform the first peak integration analysis by
selecting the type of baseline to be used from
the following Integrate Peak menu items:

e Linear

* Sigmoidal Horizontal
e Sigmoidal Tangent

* Extrapolated

Linear...

Sig Honzontal..
Sig Tangent...
Extrapolated...

Eerperdiculan Brom..
llanaents..

elete Feak.
Bt atearal..

These types of baselines are further described in this section.

The peak is integrated with respect to time between the start and stop

baseline limits.

Additional Peak Integration Analyses

Once a peak integration has been conducted
for the first time on a curve, a number of
additional peak integration analyses (see the
menu here) are available when you reselect
Integrate Peak from the Analyze menu.

*  Perpendicular Drop
e Tangent

*  Delete Peak

*  Running Integral

Linear...

Sig Harizontal...
Sig Tangent...
Extrapolated...

Perpendicular Drop...
Tangent...

Delete Peak...
Burnning Integral...

These additional analyses are further described in this section.
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Analyzing the Data

Result of the Integration Analyses

NOTE:

172

The peak onset is at the intersection of the onset tangent line with the
baseline. The onset tangent line is fit to the current X-axis type, and can
be selected in automatic mode (the default condition) or manual mode
(selected using the Analysis Options - Onset/Peak Integration
Page.)

* In automatic mode you select the baseline limits, and the program
defines the onset line as the line tangent to the curve at the inflection
point (the inflection is the steepest 1/10 portion of the curve from
peak start to peak max).

*  In manual mode you also select the data limits for the onset tangent
line. (If you use the Manual Limits Window to enter the limit
points, be sure to specifically enter or tab through all four entries
for the limit points to ensure that the program picks up the exact limit
values.)

|| The onsetline and onset point are not displayed if the axis scaling is log.

If the data shows superheating or supercooling (temperature decreases or
increases by more than 0.25°C), the onset point is at the superheating or
supercooling point. Superheating and supercooling are detected only if the
X-axis is temperature.

e DSC Peak Integration: The program uses the sample size to
normalize the area under the peak and obtain the experimental heat
in joules per gram. If the sample size is zero, the heat is expressed in
joules. If the Y-axis heat units are calories instead of watts, the area
is reported in calories per gram (or millicalories if the sample size is
zero). If you want the results reported in mJ, uncheck the
Normalized Area option on the Analysis Options - Onset/Peak
Integration Page.

o DTA Peak Integration: 1f the DTA sample size is not zero, the
peak area is normalized to °C times minutes per milligram. If the
sample is zero, the area is expressed in °C times minutes.

o Peak Integration Using Other Instruments: The peak area is
normalized for other instrument types only when the signal being
integrated is normalized. For these instruments the Normalized Area
option has no effect.
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Linear Baseline

The Integrate Peak/Linear option is used to
perform a peak integration using a linear baseline.
A linear baseline (shown here) is defined as a
straight line drawn between the selected start and
stop limits. It is used when the baseline varies
directly (linearly) with time.

Follow these steps to perform this analysis:

1. Select Linear from the Analyze/Integrate Peak menu. Markers
will be displayed on the graph.

2. Double click at the place on the curve where you want the baseline
to begin to position the marker.

3. Double click at the place on the curve where you want the baseline
to end to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The peak integration analysis results are

displayed.

NOTE: ‘ You can change the parameters of this analysis by setting the options found anthe
Analysis Options - Onset/Peak Integration Page.
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Analyzing the Data

Description of

Sigmoidal Baselines

Sigmoidal

A sigmoidal baseline is an s-shaped line that changes in level and/or slope
before or after a peak. It is used to compensate for the change in base-
line that occurs during a transition; the baseline is adjusted for the fraction
reacted (alpha) versus time.

A sigmoidal baseline initially is calculated as a straight line from peak
start to peak end. It is then recalculated for each data point between the
peak limits as the weighted average between the projected horizontal or
tangent baselines at peak start and end. The weighting factors for a given
point are: (1) one minus alpha times the initial baseline and (2) alpha
times the final baseline. The area is then recalculated with the new
baseline. If the new area differs from the previous area by more than one
percent, the area is recalculated and the sigmoidal curve shifted repeat-
edly until two consecutive calculations of the area differ by no more than
one percent. If the baseline fails to converge within ten iterations, the
calculation is aborted. The convergence of the baseline can be observed
by checking the “Draw sigmoidal baseline iterations” box on the Analysis
Options — Other Page.

Horizontal Baselines

NOTE:

174

To calculate a sigmoidal horizontal baseline,
two lines are drawn between the selected
limits, then a sigmoidal curve is drawn with
its midpoint halfway between the horizon-
tals. This baseline type is used when the
glass transition and cure overlap.

Follow these steps to perform this analysis:

1. Select Sig Horizontal from the Analyze/Integrate Peak menu.
Markers will be displayed on the graph.

2. Double click at the place on the curve where you want the baseline
to begin to position the marker.

3. Double click at the place on the curve where you want the baseline
to end to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The peak integration analysis results are

displayed.

You can change the parameters of this analysis by setting the options found anthe
Analysis Options - Onset/Peak Integration Page.
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Sigmoidal
Tangent Baselines

To calculate a sigmoidal tangent baseline,
two tangent lines are fit within the selected
limits on each side of the transition. A
sigmoidal curve then joins the tangent lines.

Follow these steps to perform this analysis:

1. Select Sig Tangent from the Analyze/
Integrate Peak menu. Markers will be
displayed on the graph.

2. Right click to display the Analyze pop-up menu, then select Point 1 to
activate the first marker.

3. Position the first marker so that it intersects the curve where you
want the first tangent line to begin.

4. Right click to display the Analyze pop-up menu again, then select
Point 2.

5. Position the second marker where you want the first tangent line to
end.

6. Rightclick to display the Analyze pop-up menu again, then select
Point 3.

7. Position the third marker so that it intersects the curve where you
want the second tangent line to begin.

8. Right click to display the Analyze pop-up menu again, then select
Point 4.

9. Position the fourth marker where you want the second tangent line to
end.

10. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The peak integration analysis results are
displayed.

NOTE: ‘ You can change the parameters of this analysis by setting the options found on the
Analysis Options - Onset/Peak Integration Page.
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Analyzing the Data

Extrapolated Baseline

176

The Integrate Peak/Extrapolated option is used to perform a peak
integration using an extrapolated baseline.

To calculate an extrapolated baseline, four points are selected (in any
order). The program automatically sorts the points. Tangent lines will be
drawn between two of the points so that the extrapolated baseline
intersects the range of data bracketed by the other two points (intersec-
tion range). The program automatically determines whether the first two
points (as seen in Figure A) or the last two points (as seen in Figure B)
specify the tangent line. This is accomplished by the program as it tries
both potential tangent lines and then uses the tangent line that will inter-
sect the data between the other points.

Intersection FPoint 2
Ranga

Point 3
Foint 4

Intersaction
ith Data
Fa e Lina
Point 1

Figure A

Point 4

Tangent
Lina Intersaction

with Diata

Ll
1 I
Point 1 Paoint 2 Intersection
Range

r
Point 3

Figure B

For example, in Figure A, a tangent line drawn between Point 1 and Point
2 will not intersect the data found between Points 3 and 4. This arrange-
ment is discarded as incorrect. The program will then draw a tangent line
between Points 3 and 4. This tangent line does intersect the data found
between Points 1 and 2, so this becomes the final extrapolated baseline.

If two of the four points are placed on top of each other, the baseline is
extrapolated to be a horizontal baseline from these two points to intersect
the data between the other two points, as seen in Figure C on the next

page.

THerMAL ApvanTAGE UNivERSAL ANALYSIS OPERATOR'S MIANUAL



Intersaction PE_Ln1 4

with Data
Haorizontal .
Basaling Intersection
Range

]
1
Points 1 &2

-
Foint 3

Figure C

Perpendicular Drop Analysis

After you have performed at least one peak inte-
gration on a curve, the Perpendicular Drop option
becomes available when you reselect Integrate
Peak from the Analyze menu.

When you perform the perpendicular drop function,
it subdivides a peak with a perpendicular line drawn
from a selected point on the curve to the baseline.
This is helpful if you have transitions that overlap each other and must be
analyzed separately.

[ S LA

NOTE: || The Perpendicular Drop option is not available if the Y-axis scale s log.
Follow these steps to perform this analysis:
1. Perform at least one peak integration.

2. Select Perpendicular Drop from the Analyze/Integrate Peak
menu. A marker is displayed on the graph.

3. Position the vertical bar of the marker at the point where you want to
bisect the curve.

4. Right click to display the Analyze pop-up menu, then select Accept

Limits (or press Enter). The program calculates the area of the
subpeak marked off by your perpendicular line.
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Analyzing the Data

Tangent Analysis

After you have performed at least one peak integration on a curve, the
Tangent option becomes available when you reselect Integrate Peak
from the Analyze menu.

When you use the Tangent integrate peak option,
the program uses a line tangent to the curve (deter- III
mined by a least-squares fit) to find the area of a |
subpeak between two points (shown here). Results !
displayed are the area of the subpeak, the area of the

.-'I
main peak, the total area, and the onset. "'-.__ __’_,f"‘.
ol Y

NOTE: ‘l The Tangent optionis not available if the Y-axis scale is log.
Follow these steps to perform this analysis:
1. Perform at least one peak integration.

2. Select Tangent from the Analyze/Integrate Peak menu. Markers
will be displayed on the graph.

3. Double click at the place on the curve where you want the tangent
line to begin to position the marker.

4. Double click at the place on the curve where you want the tangent
line to end to position the second marker.

5. Right click to display the Analyze pop-up menu, then select Accept

Limits (or press Enter). The program calculates the area of the
subpeak marked off by your tangent line.
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Deleting Peak Integrations

The Integrate Peak/Delete Peak option is used to delete the results of
a selected peak integration so that you can reanalyze the peak without
deleting all of the results. If the deleted peak is a tangent or perpendicular
drop subpeak, its area is returned to the peak that was subdivided. If the
deleted peak contains any subpeaks, they too are deleted.

Follow these steps to delete peaks:

1. Select Delete Peak from the Analyze/Integrate Peak menu. A
marker is displayed on the graph.

2. Position the vertical bar of the marker within the limits of the peak
integration results you wish to delete.

3. Rightclick to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The selected results are deleted.

Running Integral Analysis

NOTE:

The Integrate Peak/Running Integral option is used to graph the
integral of the data based on peak integration. This analysis is useful
when you want to determine the area under a peak or the ratio of differ-
ent materials within a sample. For example, in TGA, this function is
valuable for determining the relative amounts of evolved gases in a
material. In DSC, it can be used to calculate the percent composition of
polymer blends.

The Running Integral option is not available if the Y4 axis is being used to graph a
datasignal.

Follow these steps to perform this analysis:
1. Perform at least one peak integration.

2. Select Running Integral from the Analyze/Integrate Peak menu.
A marker is displayed on the graph.

3. Position the marker within the limits of the peak integration results on
which you wish to perform a running integral analysis.

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The Integral Type window, shown on the
next page, is displayed.
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Figure 5.12
Integral Type Window

NOTE:
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Integral Type |

—Select running area bpe:

* [ntegral v Momalized

' Area percent [~ Inverted

—Select running area bazeline:
+ Linear bazeline

" Zero baseline [abzalute integral)

Cancel Help

Select the running area type from the types displayed:

Integral: The program plots the raw integrated data.

Area Percent: The program takes the end result of the raw
integration and shows the percent contribution of each peak in
the selected region of the curve (assuming the selected region to
be 100%). If you want to determine the percent composition of
various components in a material, select the area percent option.
Then, when the program finishes plotting the integral curve, use
the Curve Value analysis to mark each step of the curve with its
percent contribution.

Normalized: For DSC files only. The program plots the integral
curve in normalized units (Joules/g).

Inverted: The program multiplies the normal integral by minus
one, and computes the area percent integral from 100 percent
down to zero percent.

6. Choose from the following running area baseline choices:

Linear baseline: When you select this option the baseline will
be anchored to the curve at the integral limit points. The area will
be integrated with respect to the linear baseline between the
analysis limits.

Zero baseline (absolute integral): When you select this
option, the area will be integrated with respect to a baseline set to
zero on the y axis, which calculates the absolute integral.

Inboth cases above the baseline islinear, unless the peak runningintegral is
selected with Sigmoidal baseline peakintegration.

7. Click on OK. The program calculates the integral of the peak based
on the peak integration results and displays the result on the Y4 axis.

THerMAL ApvanTAGE UNivERSAL ANALYSIS OPERATOR'S MIANUAL



NOTE:

Peak Max

NOTE:

Signal Max

Youmust use the Analyze/Integrate Peak /Bunning Integral analysis to obtain the
correct peak area whenintegrating over a sigmoidal baseline. The more general
Analyze /Running Integral analysis always uses a linear baseline forintegration, which
will give a different running area than that reported by the Peak Integration analysis
with a sigmoidal baseline.

The Peak Max analysis option is used to calculate a peak’s point of
maximum deviation from a linear baseline drawn between two points on
the curve. After you select the start and stop limits for the baseline, the
program calculates and reports the height of the peak.

Follow these steps to perform this analysis:

1. Select Peak Max from the Analyze menu. Markers will be dis-
played on the graph.

2. Double click at the intersection of the baseline start to position the
marker.

3. Double click at the intersection of the baseline stop to end to position
the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The program calculates and displays the

peak's maximum deviation from the baseline.

Peak Maxand Signal Max analyses report the same maximum value if the baseline
is horizontal (the curve Y-axis values of the start and stop limits are the same).

The Signal Max analysis option is used to calculate the maximum signal
value between two selected points.

Follow these step to perform this analysis:

1. Select Signal Max from the Analyze menu. Markers will be dis-
played on the graph.

2. Double click at the intersection of the desired start point to position
the marker.
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Signal Change

182

Double click at the intersection of the desired stop point to position
the second marker.

Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The program calculates and displays the
maximum signal.

Use the Signal Change option to determine the amount of change in the
signal between two points on a curve. A horizontal line is drawn from
your selected start point to a vertical line drawn from your selected stop
point. The difference between these points is reported.

Follow these steps to determine the signal change:

1.

Select Signal Change from the Analyze menu. Markers will be
displayed on the graph.

Double click on the desired place on the curve to position the marker
at the beginning of the region of the curve you want to analyze. (You
can also use the Auto Limits function from the pop-up menu to
choose the data limits, see the section "Using the Analysis Pop-Up
Menu" in this chapter for more information.)

Double click on the desired place on the curve to position the next
marker at the end of the region you want to analyze.

Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter).

The program calculates the signal change and displays the results in the
signal units.
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Onset Point

Use the Onset Point analysis option to determine the temperature at
which a change in the slope of the curve occurs (i.e., the onset point of a
transition). The onset point is defined as the intersection of an initial
tangent line with a final tangent line.

Onset determination can be done in either of two ways: automatic mode
(which is the default condition) or manual mode (selected on the Analy-
sis Options - Onset/Peak Integration Page).

In manual mode, you select the start and stop limits for each
tangent line and the program fits two tangent lines to the curve.

In automatic mode, you enter the start and stop limits to be used in
the analysis, and the program takes care of the rest.

Follow these steps to perform this analysis:

1.

Select Onset Point from the Analyze menu. Markers will be
displayed on the graph.

Double click at the point where you want the data for the tangent line
to begin to position the first marker.

Double click at the point where you want the tangent line to end to
position the second marker. If you are using manual mode, repeat
steps 2 and 3 for Points 3 and 4 until all four markers have been
placed.

Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The program calculates and displays the
onset point.
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Oxidation Time/Temp

The Oxidation Time/Temp option is used to analyze DSC data from
oxidation induction time (OIT) and oxidation temperature (OT) experi-
ments.

* Oxidation induction time (OIT) is a DSC test method that
measures the time to oxidation onset of a sample held at an
isothermal temperature and in an oxidizing atmosphere.

* Oxidation temperature (OT) is a DSC test method that measures
the oxidation onset temperature of a temperature-programmed
sample in an oxidizing atmosphere.

Follow theses steps to perform either analysis:

1. Select Oxidation Time/Temp from the Analyze menu.

If you choose OIT as your analysis type, the Oxidation Time
window, shown in the figure below, is displayed.

Oxidation Time

Sighal Threshold: |m Wi
Dxidation Gas Stark: ID.DUU min

k. Cancel | Helm |

Figure 5.13
Oxidation Time Window

If you choose OT as your analysis type, the Oxidation Tempera-
ture window, shown in the figure below, is displayed.

Oxidation Temperature
Signal Threshold: |m Wig
k. Cancel | Helq |

Figure 5.14
Oxidation Temperature Window

2. Enter the signal threshold to mark the desired point where the curve
deviates the threshold value from the baseline.
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Purity

NOTE:

3. For OIT analyses: Enter the oxidation gas start, which is the time
when you started the use of oxygen in your experiment.

4. Click the OK button. Markers will be displayed on the graph.

5. Double click at the beginning of the region of oxidation onset to
position the marker.

6. Double click at the end of the region of oxidation to position the
second marker.

7. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The program calculates and displays the
oxidationresults.

The TA Instruments DSC Purity Analysis can be used to calculate the
absolute purity of a sample based on data obtained from the DSC (Differ-
ential Scanning Calorimeter) according to ASTM procedure E0928.*

The DSC Purity Analysis is nat recommended for analysis of SOT (DSC-TGA) data.
The results will not be as expected.

The analysis method used in DSC Purity Analysis is based on the van’t
Hoff equation shown below:

RTZX 71
T= Ty (F)
f

Where

TS = sample temperature

T, = melting point of pure sample (K)

R = gas constant (8.314 J/mol"' K')

X = molefractionimpurity

AH, = heat of fusion of pure sample (J/mol™)
F = faction of total sample melted at T

* For more information go to http://www.astm.org or write to ASTM, 100
Barr Harbor Drive, West Conshohocken, PA 19428-2959, (610) 832-
9500.
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If you use this data analysis program to plot T versus 1/F, it should result
in a straight line with a slope of RT ? X/AH_(melting point depression)
and an intercept of T (melting point of a pure sample). In actual practice,
the plot of T versus 1/F results in a curve. This curve is thought to be the
result of “undetected melting.” A correction value is added to the value of
F so that a straight line results. The impurity level of your sample is
calculated from the slope of the T versus 1/F line. The heat of fusion is
calculated using the total peak area.

You can select specific parameters to be used in the analysis and obtain a
better fit to the equation used by the program. The results of all analyses
are displayed on the screen. You can also print your results on the
printer and create tabular reports on the screen, printer, or in a disk file.

Before performing Purity analysis, you will need to gather the data. For
the guidelines used to obtain the best results from the Purity analysis, see
the following section.

For additional information on purity analysis, see R.L. Blaine and C.K.
Schoff, eds., Determinations by Thermal Methods, ASTM Special
Technical Publication 838, Publication code 04-838000-40.

Collecting DSC Purity Data

Guidelines for Data

186

You can analyze DSC data from many types of samples using DSC
Purity analysis.

Be sure to calibrate your DSC using indium at the heating rate to be used
for subsequent sample analysis. Correct calibration of your DSC for cell
constant and onset slope is extremely important. These calibration
constants will affect the accuracy of your DSC Purity results.

Collection

To obtain the best results from the DSC Purity analysis, use the following
optimum experimental conditions for purity determinations:

e Sample size = 1.7 mg

*  Heating rate = 0.5 °C/min

e Impurity level <2 mol%

e Data sampling interval = 1 sec/point

*  Encapsulate the sample as tightly as possible to minimize gradients
and/or sample movement.
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Slight variations from the previous values are acceptable; however, for
the most accurate results, you need to maintain as many of these param-
eters, at the most optimum value possible, during data collection.

The Analyze/Purity menu (shown here) provides two items—one to
analyze the data and one to set up options for analysis. The following

sections describe these options.

Analyzing for Purity

Select Analyze/Purity/Analyze to
perform the analysis on the current
datafile. The following guidelines
should be considered when
analyzing:

* Before analyzing the data, set
up the analysis options by
selecting Analyze/Purity/
Options.

*  When you select Analyze/
Purity/Analyze, the markers
are displayed on the graph to
allow you to select the
analysis limits.

Integrate Peak
Pealk bax...
Signal Ma...
Glazs Tranzition. ..
Onzet Paint...
Qxidation Temp...

Analyze...
Optionz. ..

Slope...
RBunning Integral...

3

Curve Yalue AL ...
Curve Yalues ALY,
Label Ak &=

Analuziz Range
Macra

]

Optionz. ..

* Select the desired analysis limits and select Accept Limits from the

pop-up menu.

*  Enter the molecular weight of the sample in g/mol when prompted.

*  The program uses the van’t Hoff equation to calculate your sample’s
purity, performing a series of operations using the data file. See the

online help for more information.

»  First, there is an initial scan of the peak to find the baseline, peak
area, and peak height, which are needed to calculate area segments.

* A second scan divides the peak into the number of partial area
segments specified on the Purity Options—Partial Area Page (25
is the default) to find the T versus 1/F curve. The segments are
equally spaced along the 1/F axis. The first segment starts when the
peak height is the specified percent of the maximum height or the
input value (10 percent is the default). The last segment ends at the
specified maximum percent of the total peak area or the input value

(50 percent is the default).
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NOTE: Ifthe curve does not contain enough points to allow the specified number of
segments, the allocation continues untilthe maximum partial area percent of the
total peakis reached.

* A correction is made at the end of each segment for the temperature
difference between the sample and sample thermocouple (using the
onset slope value entered in the analysis options).

*  Then a nonlinear least squares technique is used to approximate the
area correction for the T versus 1/F curve. (This is done to linearize
the usual curvature of the line, commonly attributed to undetected
melting of the sample before peak start.)

* A least-squares fit to a straight line is used to calculate the slope and
intercept of the T, versus the corrected 1/F curve.

e The corrected peak area is used to calculate the heat of fusion
unless you have opted to used the uncorrected area, or have entered

a known heat of fusion for the sample.

» Lastly, the van’t Hoff equation is used to calculate the impurity level
and convert it to the purity.
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Selecting Purity Analysis Options

Select the Analyze/Purity/Options function to set up the options
available for DSC purity analysis.

Purity Analysis Options - Partial Area Page

Click on the Partial Area Page (shown here) to set up the default
parameters for the program to use when you perform the DSC Purity
analysis.

Purity Analysis Options |
Fartial Area | Prurity Ealn::ulati-:nnl Results F'In:ntl Beswilks Lal:nell
First partial area height cutaff [fraction of peak masimum); (010

M awirurn partial area [fraction of peak area): [0.50

Murnber af partial areas: IEE
Conztraints on area correction factar: IU.EIEIEI ¢ Factor < IEI.EEIEI

Figure 5.15
Purity Analysis Options
Partial Area Page

Save Drefault Cancel Help

Follow the steps below to set up these options:

1. Enter the First partial area height cutoff (fraction of peak maxi-
mum) as a decimal [the default is 0.1 (10 percent)]. The first partial
area begins at the left edge of the peak range, and extends to the
point where the signal is a specified fraction of the peak height below
the baseline.

2. Enter the Maximum partial area (fraction of peak area) as a
decimal [the default is 0.5 (50 percent of the total area)]. The last
partial area ends when it exceeds or equals this fraction of the total
peak area.

3. Enter the desired Number of partial areas (the default value is 25).
The number of partial areas is computed by the program and used in
the purity calculations. The reciprocals of these partial areas are
spaced approximately equal.
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4. Enter the upper and lower limits of the area correction factor as the
Constraints on area correction factor. The “missing area”
correction factor must fall within the specified range (0.0 < Factor <
0.2 is the default). You can force the correction to a specific value
by setting the lower and upper limits of the range to the same value;
however, it is more often used to force the correction to remain
below a selected value (the upper limit value).

If the correction factor selected by the program is equal to the upper
limit, the amount may be inadequate to obtain a good fit to the straight
line, and DSC Purity obtained may be incorrect. Check the fit (using
the RMS deviation value in the Results Report). If necessary, you
can reanalyze the data with a larger maximum area correction factor.
A small RMS deviation indicates a good fit to the straight line.

5. Click Save to save these options to the initialization file or click OK
to use these parameters for this session only.

NOTE: |] Tousethefactorydefauttoptions, clickthe Default button.
NOTE: ‘ If you make a change to these parameters after analyzing the data, you will need to
repeatthe analysis again.

Purity Analysis Options - Purity Calculation Page

Click on the Purity Calculation Page (shown below) to set up the
default parameters for the program to use when you perform the DSC
Purity analysis.

Follow the steps below to set up these options:

Purity Analyziz Options |
Partial rea  Purity Calculation | Fesults Plat I Fesults Labell

Penalty factar [larger value forces smaller area comrection];  [1.00

v diust delta H of fusion accaording to area comection Factor

[~ Use known pure heat of fusion: I']-':":":I kAol
[ Use known pure melting temperature; IU-DUU C

[~ Use known molecular weight, |00 gl

Figure 5.16
Purity Analysis Options
Purity Calculation Page

Save | Drefault | Cancel | Help
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1. Enter the desired Penalty factor (larger value forces smaller area
correction). The penalty factor is used to bias the results towards a
smaller area correction. A penalty factor of one means that the fit is
determined entirely by the squared deviation between the data and
the modified van’t Hoff equation. A penalty factor greater than one
results in a deviation multiplied by a function that tends to make
smaller area corrections fit better. The default value is 1.0.

This functionis:

P =400 (Pf-1.0)(g-0.052+10 if g>005
P=10 if g<005

Where:

P = penalty

Pf = penalty factor

g = area correction factor (gamma) as a fraction (0.0 < gamma
< 1.0). Gamma is reported as “correction %”/100.0 on the
report.

This equation is a quadratic function centered on a 5 percent correc-
tion, with a penalty equal to the penalty factor at a 10 percent correc-
tion.

2. Check the Adjust delta H of fusion according to area correction
factor box, if this option is desired.

3. Check the Use the known pure heat of fusion box, if desired. If
this option is checked, enter the value in kJ/mol.

4. Check the Use the known pure melting temperature box, if
desired. If this option is checked, enter the value in °C.

5. Check the box for Use known molecular weight to perform the
purity calculations on your data using the known molecular weight of
the sample material. If you check this box, you will need to enter the
value in g/mol. If you do not check this box, the Molecular Weight
window is displayed when you perform the Purity analysis.

6. Click Save to save these options to the initialization file or click OK to
use these parameters for this session only.
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Purity Analysis Options — Results Plot Page

Figure 5.17
Purity Analysis Options
Results Plot Page

192

Click on the Results Plot Page (shown below) to set up the default
parameters for the program to use when you perform the DSC Purity
analysis and display the results plots. Five checkbox options are dis-
played. These deal with the plot options that can be displayed along with
the heat flow curve.

Purity Analysis Options |

Partial .-’-‘-.real Purity Calculation  Fesultz Plat | Results Lal:nell

¥ Indicate partial area slices on Heat Flow curve Swmbol: 4
¥ Plaot temperature vz, comected partial area points Swmbol: [
[ Flat fitted line to corected partial area points

[¥ Flat temperature vz uncomected partial area points— Symbol (&)

[ Plit fitted maodified van't Hatf equation to uncorected partial area points

iz IYE "I Colar; I- Blue j Edit Sumbiols |

Save | Drefault | Cancel | Help

Follow the steps below to set up the “Temperature vs. partial area plot
options:”

l.

Check the Indicate partial area slices on Heat Flow curve box to
have partial areas shown on the heat flow curve.

Check the Plot temperature vs. corrected partial area points
box to display a graph of the temperature versus the corrected partial
area points.

Check the Plot fitted line to corrected partial area points box, if
desired. If you check the third box, a line will be drawn through the
temperature versus corrected partial area points, only if displayed.

Check the Plot temperature vs. uncorrected partial area points
box to display a graph of the temperature versus the uncorrected
partial area points.

Check the Plot fitted modified van’t Hoff equation to uncor-
rected partial area points box, if desired. If you check the fifth
box, a plot will be fitted to the temperature versus uncorrected partial
area points, only if displayed.
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6. Select the Axis from the drop-down list that will be used to plot the
analysis results.

7. Select the Color for the results plot from the drop-down list.

8. Click the Edit Symbols button if you want to change the symbols
used for the analysis. The first three symbols in the symbol list are
used in the purity result plot. The first symbol corresponds to the
partial area points on the heat flow curve, the second symbol corre-
sponds to the corrected partial area versus temperature points, and
the third symbol corresponds to the uncorrected partial area versus
temperature points.

9. Click Save to save these options to the initialization file or click OK
to use these parameters for this session only.

Purity Analysis Options - Results Label Page

Click on the Results Label Page (shown below) to set up the results
labels that will be displayed when you perform the DSC Purity analysis
and display the results.

Purity Analysis Options |
Partial .-’-\-.real Purity Ealn::ulatin:-nl Fiesultz Plot  Results Label |

W Purity [mal %] v Mualecular weight [g/mal)
[+ Meling point [*C) [v Cell conztant

[+ Depreszion ['C) v Onzet slope [miw/°C)
[+ DeltaH [kd/mol) [+ BMS deviation

[+ Comection [%) v Peak limits

Figure 5.18
Purity Analysis Options
Results Label Page

Save Default Cancel Help

Check the desired results to be displayed on the results plot as listed in
the table on the next page.
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Table 5.2
Purity Analysis Results Labels

Results Description
Label
Purity Check the Purity box to display the purity in the

results annotation, the amount of a specified
compound or element in an impure sample.

Example: Purity 99.64 mol %

Melting Point Check this box to display the melting point in the
results annotation. Melting point is defined as the
point at which the crystals of a pure substance are
in equilibrium with the liquid phase at atmospheric
pressure. This point is commonly referred to as
melting point when a substance is approaching it
from its solid state and is referred to as freezing
point when a substance is approaching it from its
liquid state.

Melting Point Depending on whether this value is determined by
the data or a known value is used (which is set on
the Purity Analysis Options — Purity Calculation
Page), this value will be labeled as (determined) or
(entered) respectively.

Example: Melting Point 134.90°C (determined)

Depression Check this box to display the van’t Hoff melting
point depression value in the purity analysis results.
This is the difference between the melting tem-
perature of this sample and that of a 100 percent
pure sample.

Example: Depression 0.29°C

(table continued)
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Table 5.2 (cont'd)
Purity Analysis Results Labels

Results
Label

Description

Delta H

Correction

Molecular

Weight

Cell Constant

Onset Slope

Check this box to display the Delta H value in kJ/
mol. This is the change in the heat of fusion.

Depending on whether this value is determined by
the data, determined and adjusted according to the
area correction factor, or a known value is used,
this value is labeled with (uncorrected), (cor-
rected), or (entered). Use the Purity Analysis
Options - Purity Calculation Page to enter a
known value.

Example: Delta H: 26.37 kJ/mol (corrected)

Check this box to display the Correction value in
percent. This is the area expressed as a percent of
the total melting enthalpy that is added to the
fractional areas in order to produce the straight line
form of the van’t Hoff equation.

Check this box to display the Molecular Weight
in g/mol. This is the value that you have entered
during the purity analysis, which is defined as the
mass of one molecule of a nonionic substance in
atomic mass units.

Check this box to display the Cell Constant
value. Cell Constant is a calibration factor used to
adjust the calorimetric response of a DSC cell. The
cell constant is the ratio of the known value to the
measured experimental variable. Typically, the
heat of fusion of indium (DSC) is used. The
calibration is based on a run made in the calibration
mode using the experimental conditions to be used
in subsequent measurements.

Check this box to display the Onset Slope in the

purity analysis results. This parameter is the slope

of the onset of the melting curve for a standard.
(table continued)
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Table 5.2 (cont'd)

Purity Analysis Results Labels

Slope

196

Results
Label

Description

Onset Slope

RMS Deviation

Peak with
Limits

The onset slope, or thermal resistance, is a mea-
sure of the temperature drop that occurs in a
melting sample in relation to the thermocouple.
Theoretically, a standard sample should melt at a
constant temperature. As it melts and draws more
heat, a temperature difference develops between
the sample and the sample thermocouple. The
thermal resistance between these two points is
calculated as the onset slope of the heat flow
versus temperature curve on the front side of the
melting peak. This is always a negative term.
Default is 0.00 mW/°C.

Check this box to display the RMS Deviation in
the purity analysis results. Root Mean Square
Deviation is the estimate of the deviation in the
melting temperature of the 100 percent pure
sample.

Check this box to label the peak with the chosen
analysis limits for integration.

The Slope option is used to calculate the average slope of a selected
region of the curve.

Follow these steps for perform this analysis:

1. Select Slope from the Analyze menu. Markers will be displayed on

the graph.

2. Double click at the beginning of the region you want to measure to
position the first marker.

3. Double click at the point where you want to stop measuring the slope
to position the second marker.
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4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The program calculates and displays the
slope.

Running Integral

NOTE:

NOTE:

NOTE:

The Running Integral option is used when you want to determine the
area under a peak or the ratio of different materials within a sample. For
example, in TGA, this function is valuable for determining the relative
amounts of evolved gases in a material. In DSC, it can be used to calcu-
late the percent composition of polymer blends.

The Analyze/Running Integral option is the same as the Analyze/Integrate
Peak/Running Integral option, with ane exception—you do not need to perform a
peakintegration before selecting this option.

You must use the Analyze/Integrate Peak/Running Integral analysis to obtain
the correct peak area whenintegrating over a sigmoidal baseline. The more general
Analyze/Running Integral analysis always uses a linear baseline for integration,
which will give a different running area than that reparted by the Peak Integration
analysis with a sigmoidal baseline.

The Running Integral analysis option is not available if the Y4 axis is being used to
graph adatasignal.

Follow these steps to perform this analysis:

1. Select Running Integral from the Analyze menu. Markers will be
displayed on the graph.

2. Double click at the beginning of the region of the curve that you want
to analyze to position the marker.

3. Double click at the end of the region you want to analyze to position
the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept
Limits (or press Enter). The Integral Type window is displayed.

5. Select the running area type from the types displayed:

e Integral: The program plots the raw integrated data.
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NOTE:

NOTE:

1898

e Area Percent: The program takes the end result of the raw
integration and shows the percent contribution of each peak in
the selected region of the curve (assuming the selected region to
be 100%). If you want to determine the percent composition of
various components in a material, select the area percent option.

Then, when the program finishes plotting the integral curve, use
the Curve Value analysis to mark each step of the curve with its
percent contribution.

*  Normalized: For DSC files only. The program plots the integral
curve in normalized units (Joules/g).

* Inverted: The program multiplies the normal integral by minus
one, and computes the area percent integral from 100 percent
down to zero percent.

6. Choose from the following running area baseline choices:

* Linear/Sigmoidal Baseline: When you select this option the
baseline will be anchored to the curve at the integral limit points.
The area will be integrated with respect to the linear baseline
between the analysis limits.

e Zero baseline (absolute integral): When you select this
option, the area will be integrated with respect to a baseline set to
zero on the y axis, which calculates the absolute integral.

Inboth cases above the baseline islinear, unless the peak runningintegral is
selected with Sigmoaidal baseline peakintegration.

7. Click on OK. The program calculates the integral of the peak based
on the peak integration results and displays the result on the Y4 axis.

You must use the Analyze/Integrate Peak /Bunning Integral analysis to obtain the
correct peak area whenintegrating over a sigmoidal baseline. The more general
Analyze /Running Integral analysis always uses a linear baseline forintegration, which
will give a different running area than that reported by the Peak Integration analysis
with a sigmoidal baseline.
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Curve Value at X/Y

The Curve Value at X/Y analysis options are used to to determine the
X-axis value or Y-axis value at the selected point on the curve. Marking
the curve with this feature allows you to label a curve at any point.

Follow these steps to perform this analysis:

1. Select Curve Value at X or Curve Value at Y from the Analyze
menu. A marker is displayed on the graph.

2. Double click at the point on the curve you want to label to position the
marker.

3. Rightclick to display the Analyze pop-up menu, then select Accept
Limits. The Label Point window is displayed.

Label Point |

Label paint with;:
[ Time ¥ 7 awis value

¥ Temperature
[~ Signal. Heat Flow [/g)

[ Draw amow to paint

[v Draw cross at point

Cancel Help

Figure 5.19
Label Point Window

4. Check the box for the item(s) that you wish to use for the point
labeling. Refer to the table on the next page for a description of each
item.
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Table 5.3
Label Point With...

NOTE:

200

Item Description

Time Labels the selected data point on the graph with
the time.

Temperature | Labels the selected data point on the graph with
the temperature.

Signal Labels the selected data point on the graph with

Y-Axis Value

Frequency*

Amplitude*

Location*

Draw arrow
to point

Draw cross
at point

the X signal. This signal is selected on the Signal
Selection window. You do not have to select the
Signal radio button on the Signal Selection
window. In this manner, any point can be labeled
with any of the X signals saved when the data was
collected.

Labels the selected data point on the graph with
the Y-axis value.

Labels the selected data point on the graph with
the frequency.

Labels the selected data point on the graph with
the amplitude.

Labels the selected data point on the graph with
the location.

Check this box to have an arrow displayed that
will point from the label(s) to the selected data
point on the graph.

Check this box to have an cross displayed at the
selected data point on the graph.

5. Click the OK button. The point you selected is labeled with the
selected items on the curve.

|I * This option is available for multiplexed files only.
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Label at X,Y

The Label at X,Y analysis option is used to determine the x and y
coordinates for any point within the graph limits, even if it is not on the
curve. To obtain a point on a curve, use the Curve Value at X/Y
analysis.

Follow these steps to perform this analysis:

1. Select Label at X,Y from the Analyze menu. A marker is displayed
on the graph.

2. Double click at the point you want to label to position the marker.

3. Right click to display the Analyze pop-up menu, then select Accept
Limits. The Label Point window is displayed.

4. Check the box for the item(s) that you wish to use for the point
labeling. See the table on the previous page for a description of each

item.

5. Click the OK button. The point you selected is labeled with the
selected items.
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Setting the
Analysis Options

The Options menu item found in the Analyze menu is used to set up
parameters that will be applied when analyzing your data files.

When you select Analyze/Options from the main menu, the following
window is displayed.

Analysis Dptions =l
Step / Change IDnset / Peak Integration | Special drea | Resolution | Other |

[T Manual tangent selection

Step midpoint at: IIanectian j
Step change between: IDnset j and IEnd j
—Step label:

[~ Limits [v Onset |+ End [ Change [ DeltaCp
[~ Signed change [~ Signed delta Cp

—Sighal change label:
[ ®elimits [ -mits [ Change [ Signed change

Figure 5.20
Analysis Options -
Step/Change Page

Save Drefault Cancel Help

Click on the desired tab at the top of the window to select the page you
wish to use. Details on each page can be found in this section.

Step,/Change Page

The Step/Change Page (shown in the figure above) is used to set up the
parameters for the program to use when you perform a step transition,
glass transition, or signal change analysis.

Follow the steps below to set up these options:

1. Select Analysis/Options from the main menu, then click on the
Step/Change tab, if needed.

2. Check the Manual tangent selection option, if you wish to manu-
ally select the start and stop limits for the tangent lines. If you choose
the manual mode, the program uses the limits you select to fit the
tangent lines to the curve. The program will use the limits you select
to fit the tangent lines to the curve.
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NOTE: If you do not check the Manual tangent selection box, the analysis will be done in
automatic mode. This means that you will only need to enter the start and stop data
limits to be used in the analysis and the program will take care of the rest.

3. Click on the arrow to display the drop-down list and select the step
transition Midpoint. See “Choosing the Midpoint” for further
information.

4. Click on the arrows to display each drop-down list and select the two
Step change between options to be used in step transition calcula-
tions. See “Choosing the Step Change Options” for further informa-
tion.

5. Check the desired options to be used when labeling the step transition
analysisresults:

Limits: Check this box to label the graph with the x-axis value
atthe limit points.

Onset: Check this box to label the graph with the onset of the
step/glass transition.

End: Check this box to label the graph with the end of the step/
glasstransition.

Change: Check this box to label the graph with the step/glass
transition signal change.

Delta Cp: Check this box to label the graph with the heat
capacity.

Signed Change: Check this box to label the graph with the
appropriately signed change value. If the change is negative, a
minus sign will be shown with the numerical value. If the change
is positive, no sign will be shown with the numerical value,
positive is implied.

Signed Delta Cp: Check this box to label the graph with the
appropriately signed change in heat capacity (Cp) value. If the
heat capacity is negative, a minus sign will be shown with the
numerical value. If the heat capacity is positive, no sign will be
shown with the numerical value, positive is implied.

NOTE: || The Delta Cp step labelis available for DSC heat flow curves only.

6. Check the desired options to be used when labeling the signal change
analysisresults:

X-limits: Check this box to label the graph with the value at the
x-axis limit points.

Y-limits: Check this box to label the graph with the value at the
y-axis limit points.

Change: Check this box to label the graph with the signal
change.
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* Signed Change: Check this box to label the graph with the
appropriately signed change value. If the change is negative, a
minus sign will be shown with the numerical value. If the change
is positive, no sign will be shown with the numerical value,
positive isimplied.
NOTE: Youmust direct the program to label the graph with the change value before the
sign can be indicated on the plot (see above) by checking the Change box onthe
page. If Change is not checked, the result will not be displayed on the plot.

7. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session
only.

NOTE: || You can choose the default options by clicking on the Default button.

Choosing the Midpoint

Select one of the following methods to be used in determining the mid-
point in step transition analyses:

* None results in no step transition midpoint calculation.

* Inflection results in the use of the inflection point (the point on the
curve with the steepest slope) as the midpoint of the step transition.

Sart

ot
Inflection g

*  Half height defines the midpoint as the Y-axis value halfway
between the onset and end of the step/glass transition region.
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*  Half width defines the midpoint as the X-axis value halfway
between the onset and end of the step transition region.

Onzet

T LEW

* Half extrapolated tangents results in a line drawn midway
between the onset and end tangents, and the intersection of this line
with the curve is considered the midpoint.

* Fictive temperature defines the intersection point of two
extrapolated baselines extending from the start point and end point of
the absolute running integral of the glass or step transition being
analyzed with respect to the current x-axis. This option is primarily
used to remove the effects of enthalpic relaxation phenomena in your
experiment.

Choosing the Step Change Options

Use Step Change list to select how you want the step change (height)
to be determined in step transition calculations. The step change is
calculated as the change in the Y-axis between the two choices made
on the Analysis Options - Step Transition Page (see Figure 5.16).
Choose from the following:

*  Start—the step change will be computed using the specified start
limit on the Y-axis.

*  Onset—the step change will be computed using the step transition
onset point on the Y-axis.

e Midpoint—the step change will be computed using the onset

tangent or end tangent Y-axis value evaluated at the midpoint X-axis
value.
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Onset,/Peak

Integration Page

Figure 5.21
Analysis Options -
Onset/Peak
Integration Page

206

End—the step change will be computed using the step transition end
point on the Y-axis.

Stop—the step change will be computed using the specified stop
limit on the Y-axis.

The Onset/Peak Integration Page (shown in the figure below) is used
to set up the parameters for the program to use when you perform a
onset or peak integration analysis.

Analysis Options x|

Step / Change Onzet / Peak Integration | Special .-i'-.real Hesu:ulutiu:unl Other I

Weight: IDriginaI VI [~ Manual onzet kangent selection
Calculate peak onzet versus: IEurrent H-ARiE VI v Onszet at inflection

—Orzet label:
W weaxiz [ axiz [ Time [~ Iemp [~ #-signal

—Peak label:
[~ Limits v furea [~ Height [ fidth at half height

[~ Sigrned heat flow area v Nomalized area

bl Esirniarn: I Current #-axis ™ I

Save | Default | Cancel Help

Follow the steps below to set up these options:

1.

Select Analysis/Options from the main menu, then click on the
Onset/Peak Integration tab.

For DSC-TGA Mode SDT Files Only: Select a Weight option to be
used to calculate peak integration results from the drop-down list. If
you select “Prompt” from the list, you will need to select a weight to
be used from the Integration Weight Selection window. See also:
“List of Integration Weight Selections” on the next page.

Check the Manual Onset tangent selection option, if you wish to
manually select the start and stop limits for the tangent lines. If you
choose the manual mode, the program uses the limits you select to fit
the tangent lines to the curve. The program will use the limits you
select to fit the tangent lines to the curve.
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NOTE:

that you will only need to enter the start and stop data limits to be used inthe
analysis and the program will take care of the rest.

‘ If you do not check this box, the analysis will be done in automatic mode. Thismeans

4. Check the Onset at inflection box, if desired. This box applies to
Onset and Oxidation analysis with automatic (2-point) cursors.

e Check the box to fit the onset line to the curve at the inflection
point on the curve. If no inflection point is encountered between
the two cursors, the onset line is fitted to the data at the point of
highest slope. The onset line is fitted to a data region whose
width is 12.5 % of the vector length of the curve between the
two cursors.

e Uncheck the box to fit the onset line to a data region whose
width is 12.5 % of the vector length of the curve between the
two cursors.

5. Check the desired boxes to label these onset values: X-axis, Y-axis,
Time, Temperature, and X-signal. These options apply to Onset
Point and Peak Integration analyses.

6. Click on the arrow to display the drop-down list and select the signal
used to Calculate peak onset versus. Use this list to choose
whether you want the program to calculate and display the peak
onset during peak integrations and to select the variable desired.

7. Check the desired options to be used when labeling the peak:

*  Limits: Check this box to label the peak with the chosen
analysis limits.

e Area: Check this box to label the peak with the peak area.

e Height: Check this box to label the peak with the height.

*  Width at Half Height: Check this box to label the peak with its
width at the half height point.

*  Normalized Area: (Available for DSC and DTA data only.)
Check this box to label the peak with the normalized area,
otherwise, unnormalized area is reported.

* Signed Heat Flow Area: Check this box to label the peak with
the appropriate exotherm/endotherm designation. If the peak area
is exothermic, the value will be labeled as positive (implied-no
sign displayed). If the peak area is endothermic, the value will be
labeled as negative (minus sign displayed).

8. Click on the arrow to display the drop-down list and select the desired
peak maximum label. This list lets you choose whether you want the
program to calculate and display the peak maximum and to select the
variable desired.
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9. Click the Save button, if you want to use these as your new default
settings or click the OK button to use these settings for this session
only.

NOTE: || Youcan choose the default options by clicking on the Default button.

List of Integration Weight Options

The following options are available

on the Integration Weight [ weight:

Selection window, shown here. ' Driginal 21,5732 mg

They will be used when you  Start 21.3628 mg

perform a peak integration analysis ¢ Midpaink: 20,0352 mg

for DSC-TGA mode SDT files. c Siop: 187077 ma
" Change: 26551 mg

* The Original button uses the S

weightdisplayed. _ _
«  The Start button uses the first £ Giraphic two points
limitselected. € Manuat  [0.0000 mg
*  The Midpoint button used the
weight midway between the ok | cancel | Help |

start and stop limits.

*  The Stop button uses the last
limitselected.

* The Change button uses the difference between the start and stop
limits.

*  The Graphic One Point button permits graphic selection of the
weight from the weight curve using one point.

e The Graph Two Points button permits graphic selection of the
weight change (difference between the two limits chosen) for the
weight curve.

*  The Manual button allows you to enter the desired weight value.

208 THerMAL ApvanTAGE UNivERSAL ANALYSIS OPERATOR'S MIANUAL



Special Area Page

The Special Area Page (shown below) is used to select a special area
calculation, if desired. Special area calculations are additional analyses
performed when you integrate a peak.

Figure 5.22
Analysis Options -
Special Area Page

Analysis Options

Step / Ehangel Omnzet / Peak Integration  Special Area I Hesnlutinnl Other I

Type: IND area j

Save Default Cancel Help

Select Analysis/Options from the main menu, then click on the
Special Area tab.

Click on the desired item in the drop-down list from the following list.

No area: No special calculations using area are performed.

General equation: When you perform a peak equation integra-
tion, a value is automatically calculated using the following
equation, which is displayed when you click on General Equation:

Value =(areax1.0/1.0)+0.0

This is used to compare results with a standard material. You can
change any of the numbers in the equation to tailor it to your
needs. You can also type in a label of up to 20 characters with
the reported value.

Percent crystallinity: 7his is available for DSC data files
only. The percent crystallinity (%Cr) is calculated using the
followingequation:

%Cr = area/standard heat x 100
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When you click on Percent Crystallinity the standard heat entry field is
displayed, allowing you to change the value, if desired.

e Percent cure: This is available for DSC data files only. The
percent cure (%oc) is calculated using the following equation:

%C = (1 - area/standard heat) x 100

When you click on Percent Cure the “Standard Heat” entry field
is displayed, allowing you to change the value, if desired.

* Heat per mole: This is available for DSC data files only.
The heat per mole (H/M) is calculated using the following
equation:

H/M = area x molecular weight

When you click on Heat per Mole the molecular weight entry
field is displayed, allowing you to change the value, if desired.

3. Click the Save button, if you want to use these as your new default
settings or click on the OK button to use these settings for this
sessiononly.

NOTE:

In orderto use the percent crystallinity or percent cure options, you must have a
non-zero sample size.

Resolution Page

The Analysis Options - Resolution Page (shown below) is used to set
the numeric resolution of all result values that are displayed on the plot
and in the reports generated by the Universal Analysis program.

Analysis Options x|
Step / Change I Ongzet / Peak Integration I Special &rea  Resolution I Other I

Time: IAutnmatic j
Temperature: Iﬁl‘-.utnmatic j
Other: I.ﬂ‘-.utumatic j

Figure 5.23
Analysis Options -
Resolution Page

Save Default Cancel Help
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1. Select Analysis/Options from the main menu, then click on the
Resolution tab.

2. Click on the drop-down list to set the resolution for all of the time,
temperature, or other values to one of the following criteria:

* 1to 7 significant figures
*  0to 10 digits after the decimal point
* rounded to an integer
* automatic resolution (this is the default)
NOTE: The "Cther" option refers to anyand all result values that are not time or tempera-
ture.
3. Click the Save button, if you want to use these as your new default

settings or click the OK button to use these settings for this session
only.

The resolution adjustment can be made to any individual result label on

the plot by right clicking on the label and selecting the Resolution menu
item from the pop-up menu.

Other Page

The Analysis Options - Other Page (shown below) is used to select a
special additional analysis parameters.

Analysis Options El
Step / Change I Ohzet £ Peak Integration I Special Area I Flesolution  Other I
Alpha at a point smoathing width; — [20.0 T
[T T2 percent calculated with respect to corected zample length
Camected heat flaw minimum weight: IE.D 4
v Adjust TGA weight derivative for maodify size
[T Label results with curve calor - [ Draw sigmaidal baseline itterations

[T Suppress anmowheads on result lines

TGA step change / weight change # residue label:
[ Limnits [ “eight [+ Bercent v Tranzition label

[T Signed change

Figure 5.24
Analysis Options -
Other Page

Save Default Cancel Help
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10.

Select Analysis/Options from the main menu, then click on the
Other tab.

Enter the desired smoothing width. The number entered here will
result in the logical smoothing of the data to the specified width.
Alpha is calculated as the slope of a least squares linear fit to the
dimension and temperature data region around the given temperature.
The size of this linear fit region is the "alpha at a point smoothing
width" analysis parameter. The region is truncated if it extends
outside the analysis limits or data collection region. If the given
temperature is outside the analysis limits or is in a region where data
was not collected, then the calculation of alpha is suppressed.

Click on the first checkbox to calculate the percent value by dividing
the expansion over the temperature range by the corrected size of the
sample. The corrected length is calculated at the first temperature
entered. Leaving this box blank (which is the default) indicates that
the percent value will be found by dividing the expansion over the
temperature range by the original size of the sample.

For DSC-TGA Mode SDT Files Only: Enter the desired weight that
will be used as the minimum value for the weight-corrected SDT heat
flow data. The default value is five percent.

Click on the next checkbox to adjust the TGA weight derivative
for modify size analyses.

Click on the checkbox to Label results with curve color, if you
want to use the same color for the curve and results label.

Check the Draw sigmoidal baseline iterations box to have
intermediate sigmoidal baseline iterations shown on the graph during
peak integration analyses. Leave this unchecked to see only the final
peak integration results.

Click on the checkbox Suppress arrowheads on result lines, if no
arrowheads are desired on the result lines.This gives you the option
of selecting Arrowheads from the Annotation popup menu, when
desired. Leave this box unchecked (default) to always draw arrow-
heads on the result lines.

Check any of the following checkboxes to label a TGA step change,
weight change, or residue analysis with the label listed: Limits,
Weight, Percent, Transition Label, or Signed Change.

Click the Save button, if you want to use these as your new default

settings or click on the OK button to use these settings for this
sessiononly.
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Adjusting Analysis Results

After you have completed performing operations such as those listed
below on your data file, you can adjust the results of the analysis.

Integrate Peak

Glass Transition

Step Transition

Onset Point

Slope

Oxidation Time/Temperature
Alpha Fit X1 to X2

Annotate

Add Scale Bar

—_—

Select Adjust Last Result from the Edit menu immediately after
one of the analyses listed above (or right click on a label associated
with one of these results and select Adjust Result from the pop-up
menu). Markers for each of the analysis tangent lines will be dis-
played. The Adjust Last Result option is used to fine tune the
position of the analysis tangent lines.

2. Select the desired marker and reposition it to the new location, as
desired. The revised analysis results will be shown when you are
finished. Right click to display the Analysis pop-up menu, then select
Accept Result (or press Enter) when you have completed the
adjustment.

To Cancel this operation, select Cancel from the Analysis pop-up
menu or press the Esc key.

Removing Analysis Results

After your analysis is complete, you can change your mind and remove
the results from the graph. The option that you select will depend on how
many analyses you have already performed, and which one you want to
remove.

To remove one or more analysis results from your graph,
select Edit/Delete Results from the main menu. Four
different options (shown in the Delete Results menu
here) will be available depending on the number of analy-
ses you have performed.

The menu options are described below:

* Last: Use the Last option to delete the last data analysis results that
you obtained from the plot.
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e Select: Use the Select option to select an analysis result for
deletion. A dialog box is displayed for each analysis performed,
allowing you to decide whether or not you want to delete that
particular analysis.

* All: Use the All option to delete all of the current analysis results
from the plot.

* Axis-1,2,3: Use this option to remove all of the analysis results
from the selected (active) Y axis.

NOTE: Toremove anindivudual result, you can also position the pointer overthe result you
wantto delete, then right click to display the pop-up menu and choose Delete
Result.

For information on how to print out the analysis results, turn to
Chapter 6.
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Chapter 6

Getting Reports
Introduction

The Universal Analysis program contains options that enable you to
obtain various types of reports individually, edit them, or combine them
into one report or make up a customized report template for use again
and again. You can also access a spreadsheet program directly from
Universal Analysis to create data spreadsheets. This chapter contains
information on the following subjects:

e Obtaining the different reports

e Using the View menu items

»  Using the Report Editor program

*  Opening the spreadsheet program, Microsoft Excel®
*  Creating a Custom Report Editor template.

Obtaining the
Different Reports

All data files will present information for the data table, parameter block,
and method log reports because that type of data was obtained when the
experiment was originally run. However, in order to obtain a results
report, you must first perform at least one analysis on your data file. For a
current macro report, you must have loaded a macro file and opened a
macro. For an autoqueue report and autoqueue log, you must have an
autoqueue containing records that has not yet been processed and after it
is processed, you can view the resulting autoqueue log.

For information on how to obtain the different types of reports and an
example of each one, refer to the appropriate page in this chapter.

Microsoft Excel® is a registered trademark of the Microsoft Corporation.
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Getting Reports

Using the View Menu

NOTE:

Results 3
. . Data Table 3
The View menu (shown here) is used to
: ) Parameter Block. ..
select from an assortment of information Method Lag
on the analysis to view, and in some cases, o
dit ot Analysis Log...
cdit or print. fudit Trail,..

. Current Macro Repart. ..
If you want to combine any or all of the

reports shown in the View menu into one,
use the Report Editor's Insert menu.

Autogqueue Report...
Aukoquene Log...

Report Editar. ..

Only one Report Editor window and one Custom Spreadsheet...

Report Editor window at atime is available within A Rt ’
the Universal Analysis program. If either of these

windows is minimized or opened, and the View options are accessed again, the
currentinformation displayed in the window is replaced with the newly selected
infarmation.

The following pages describe the types of report and function available
using the View menu. Note that the View/Audit Trail menu item is
unavailable unless you have an Advantage Integrity system. See the
documentation available with that option for further information.

Gettings Results Information

Results Report

216

After you have com- Bepot...
pleted analyzing your Ciata Table b Spread Sheet...
data, you can use the Parameter Block.... Options...
View/Results menu Method Lag...
(shown here) to view the Current Macro Repart,..
results in either report or Autogqueue Bepart...
spreadsheet form and to Autaqueus Log...
choqse results that will Report Edtor...
be displayed. Spread Sheet...

Custom Fepaort r

The View/Results/Report function is used to view the results of your
analysis in a written report form. When you select this item from the
View menu, the Report Editor program is automatically opened, display-
ing the analysis results and allowing you to edit and print the report using
the Report Editor functions. See the figure on the next page for an
example of the results report. See the section on “Using the Report
Editor™ in this chapter for more information on the functions of the
program.
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Results in Spreadsheet Form

The View/Results/Spreadsheet function is used to open the data
analysis results in a spreadsheet application such as Microsoft Excel®
(see the figure below). If you need help using the program, see the
documentation provided with the program.

L Microsoft Excel - Sheetl | [O] x|
”ﬁ File Edit Wiew Insert Formak Tools Data window Help -|5’|5|
DR SRy saad o - e ||k
”.ﬁ.rial 10 - B Ig|§§§|
A1l | =]
A [ B8 [ ¢ [ 0 [E[] F [3
1 |Peak Integration —
2 Start Onset  Maximum | Stop | Area | Special Area
3 °C “C “C “C Jig % cured
4 11526 130.07 13821 187 .44 31 .44 -3044
5 21215 23699 25061 26815 448 -4380
B
7 |Glass Transition
0 Onset Midpoint (Il End Height
9 °C “C "C Wy
10 7289 70.49 7793 0.0558
11 |
12
Figure 6.2 1?
Results Spreadsheet |4 | 4w b Sheet? ; Sheetl | 4]
Microsoft Excel® Ready | | | | | (PR |
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Setting Up Results Options

You can individually select the types of results and options you want to
display in your results report, whether it is displayed in the regular Univer-
sal Analysis Report Editor or in a spreadsheet by setting up the results

options as follows:

1.

Analyze your data files as desired.

2. Select View/Results/Options from the menu. The Results Op-
tions window (shown here) is displayed.

Result OpEHEIE X 3. Check or uncheck the desired result
Select result values to display: — values from the list that you want to
rDigplay options; 3 A
Peak Start = . display in your results report or
Peak Onset [~ Report heading Jsheet
[] Peak Onset'y [ Resul ype Spreadsneet.
[ Peak Onset Time [v Result separator .
g Peak Dnset Temperature % Resul notes 4. Check or uncheck the desired result
Peak Onzet =-Signal . . .
Bk Masimur % Column name options that you want to display in
[ Peak Height [ Column urnits your results report or spreadsheet.
[ Peak width at Half Height i
ook Stop o % Muliples value See the figure below (Multiplex value
Peak Araa ™ Signal name and Signal name not shown) to
Peak Envelops Area I File Name identify the “Display options” parts of
Peak Special Area the report.
Peak Type [~ Sample D p
Peak Conected Area
Al M . .
[ Step Start hd| il 5. Click Save to save the settings to the
initialization file or OK to save the
Save | Defauk | Cancsl | Help | settings for this session only.

You can click the All button to turn on all options and values or click the
None button to turn off all options and values.

Weight Change

File: CATADatatTGANT GA-Cao, 001
Program: Universal %308 Run Mumber: 41

T4 Instruments Thernal Analysiz -- TGA 1000 °C

Sample: Calcium Cxalate Monohydrate
Size: 17 EO070 my

Operstor; Applications Laborstory
Method: RT--=1000°C @ 20°Chnin
Comment: M2 Purge=100mLAnin

Fun Date; 10-May-935 0753

Report heading

Figure 6.3
Parts of the Results Report

san s n\:\;elgm «m Column name
204 &1 1207 2 &89 16.41 Column units
20461 51207 2539 16.4
1207 JE0.41 sa75 3LE6 .
Eeigm —— Result separator
Tempersture  Wigight Wigight Result tyrpe
s g kS
512.00 5050 2868

#1 5.580 mg between 5120 and 760 .4 “C\
Result notes
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Viewing Data Table Information

After you open a data file

you can get the data table
information in either a

report form or opened in a
Microsoft Excel® spread-
sheet by using the Data

Table options found in the

View menu (shown here).

Data Table Report

Beszultz
Data Table

Parameter Block...

tethod Log...

Current kacro Repart...
Autoguene Beport. .

Autoquels Log...

Report..

Spreadsheet. .

Fieport Editor...
Spreadzheet...
Custom Fepart

The View/Data Table/Report function is used to display a report
showing the sample information and raw data points from the data file.

For multiplexed data, such as frequency or amplitude, a separate table is
generated for each multiplexed value.

Follow these steps to perform this function:

L.

W

THermAL ADvaNTAGE UNivERSAL ANALYSIS OPERATOR'S MIANUAL

Select View/
Data Table/
Report from
the main
menu. The
Data Table
Limits
window
(shown here)
isdisplayed.

Enter the
point at

Data Table Limits

Start;

Shop:

[nizrement;

0.0000 T
[100.0000 T

Ok

I'I 0.0000 i

[~ A&l Data Points [T Time and Temperature

Bezolution | Cancel | Help

]|

which the program will start using the data to create the data table

report.

Enter the point at which the program will stop using the data to create
the data table report.

Enter the Increment to set the spacing between the reported values.
For example, an increment of 0.1 causes the program to report a data
point from every 0.1 unit of time or temperature. An increment of
0.0000 selects all of the data points in a file.

Check the All Data Points box to use all of the data points available

in the file.
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Figure 6.4
Example of a
Data Table Report

6. Check the Time and Temperature box to output the time and tem-
perature data to the data table report or spreadsheet. Leave the box
blank to output only the currently displayed x- and y-axis signals.

7. Click the Resolution button, if you want to set the numerical values to
a particular resolution. The Label Resolution window is displayed
to allow you to enter a value.

8. Click the OK button to display the data table report in the Report
Editor window.

& Report Editor - TGA-Caox 001_df [CTO] =]
Eile Edt |nsett Help

SHEG| v § R [Foweten = HB s v |=:
+

S i i i i i i i i i i 2!
Program: TUniwersal VZ.0H Pun Mumber: 41 ;I
Ta Instruments Thermal Analysis -- TGA 1000 °C

Sample: Calcium Oxalate Monohydrate
Bize: 17,6070 my

Operator: Applications Laboratory
Method: RT-->1000°C @ 20°C/min
Comment: N2 Purge=100ml/nin

Temperature Weight Deriv. Ueight
c s 5/°C
0.00

10.00

20,00

30.00 100.0 -0.002730
40.00 100.0 0.001768
50.00 100.0 0.0008110
60.00 100.0 0.001144
70.00 99.99 0.0009393
&0.00 99.98 0.001297
90,00 99,96 0,001521
100,00 99,94 0,002053

|Line: 26 Colk: 1 [

sl

Data Table in Spreadsheet Form

Figure 6.5
Data Table Spreadsheet
Microsoft Excel®
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Use the View/Data Table/Spreadsheet function to open the data file's
data table in a spreadsheet application such as Microsoft Excel®. If you
need help using the program, see the documentation provided with the
program.

X Microsoft Excel - Sheetl =1 E3
ﬁﬁile Edit Yiew Insert Format Tools Daka Window He
NeEERY t2a<c o o

”nrial -1 =B I gl%é

1 | =]
& | B C o

| 1 |Temperature Heat Flaw

12| °C Wiy

R

EREENE

5]

6

| 7 | 40 -0.2459

| 8 | 50 -0.2357

EN G0 -0.2441

| 10 | 70 -0.2459

|11 a0 -0.3081

|12 | 90 -0.3039

113 100 -0.3046

4 ¥ ]\ Sheet3 {Shestz  Sheetl 7 K1l LlJJ
Ready | NoME T
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Viewing the Parameter Block

The View/Parameter Block function is used to view a listing of the
experimental parameters that were used when obtaining the data stored
in the data file. When you select this item from the View menu, the
Report Editor program is automatically opened, displaying the parameters
(see the figure below) and allowing you to edit and print the report using

the Report Editor functions.

& Report Editor - TGA-Caox. 001 _rtf M=l E3
File Edit Inzet Help

ﬁ“,n@|ﬂé{]gltourierl‘lew jlﬁ ::IBfH|§E
f'. 1 I 1 I 1 I 1 I I 1 I 1 1 I 1 ﬁ

[

CLOSED

VERSION 0.4

Fun 41

Module TGA 1000 °C

Sample Calcium Oxalate Monohydrate

Size 17.607 ng

Method RT--=1000°C B Z0°C/nin

Operator Applications Laboratory

Comment NZ2 Purge=100nL/min

Hoomment Pan: Platinum Fasl: Nitrogen R100wL min Gasz: None

Text

Ecell 1.0000

TempCal 1 pts 355.81 357.%98

Threshalds 0.050 0.0000

Controls Gas 1 Ewent 0£ff Sampling 2.0 sec/pt

N=ig 3

Sigl Time (min)

3igZ Temwperature (°C)

31g3 Weight (mg)

Date 10-May-95

Time 07:55

File C:%\Ta%tga2950hdata) CalX-TS.001

=

|Line: 29 Cal 1 [ v

Figure 6.6
Example of a
Parameter Block Report
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Viewing a Method Log

The View/Method Log function is used to view a listing of the method
segments that were used to obtain the data file. Each experimental
method is made up of a group of segments, which are preprogrammed
instructions that are sent to the analytical instrument.

When you select this item from the View menu, the Report Editor
program is automatically opened, displaying the segments in the method
(see the figure below) and allowing you to edit and print the report using
the Report Editor functions.

& Report Editor - TGA-Caox. 001 rtf Mi=] &3
File Edit Inset Help
@H§|ﬂ%ﬁltourierf¢ew jIS ::Ing|§
T 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 [
Program: Uniwversal VZ.0H Fun Numher: 41 -~
Th Instruments Thermal Analysisz -- TGA 1000 °C
Ramp 20.00 °"Cswin to l000.00 °C
End of method
-
|Line: 3 Cal 1 | p
Figure 6.7
Example of a Method Log Report
V' ' th A | ! @ Report Editor - Purity.00Z.rtf ] 3
IeWIng e na ySIS File Edit Insert Help
L =S ‘ Sl B | Courier News - ||1U_j B 7 U
+ n N N N R R R \ \ ' '
. . Analysis log for C:%Ta\Data\D3IChPurity.002 =
Select VleW/AnalySlS Universal Analysis V3.54
. Analysis Steps: 13
LOg to view all of the Start: 1-May-02 14:04:50
: End: 1-May-02 14:05:34
Steps used tO manlpu- Original Data: C:\TAyData\D3ChPurity.002
late and view the data _ .
1: Function Cpen Data File
Z: File MName "C:\Ti\Data'D3ChyPurity.00zZ"
.for eaCh Open data ﬁle 3: Button OK Data File Information
mn the Report Edltor 4: Function Analysis Log Report
. . 5: Button Close Report Editor
window. The analysis 6 // Contirm
log (example shown 1n 7: // Save changes to CYTA\Data\DSC\Purity.00Z.rtf?
8: Button Mo Save Changes Confirmation
: 9: Function Integrate Peak Linear
the ﬁgure tO the rlght) 10: Cursor Foint 1 (130.041, -.0544573)
11: Cursor Point 2 (135.52, -.0392514)
Captul‘es these Steps 12: Function Accept Cursor Limits
and allOWS you to VICW 13: Tunction Analysis Loy Report EI
and print them. You et et | | 7
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can also convert the

analysis log to a program macro using the Macros/Copy/Analysis Log
menu item.
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NOTE: The analysis log will hold up to 80O steps. Any additional steps are lostand a
warning message is displayed, “Maximum number of analysis steps already defined.”
Analysis steps from an executing macro are natincluded in the log and, therefore,
do not affect the 800 step maximum. Only the name of the macroisincluded inthe

log.

Looking at the Current Macro

The View/Current Macro function is used to view a listing of the steps
contained in the currently open macro.

When you select this item from the View menu, the macro is automati-
cally opened, displaying the steps in the macro. You can edit the text
using this window for display purposes only. The macro can only be
modified using the Macro Editor. See Chapter 8 for information on the
Macro Editor.

it Beport Editor - TGA-Caox. 0071 _rtf [_ (O] x|

File Edit Inzet Help

= & §| LI 2 ||EDurierNew j”m
|* i i i i i i | : ; e

FProgramw: Uniwversal Analysis VZ.5C
Macro: tga analyses

Steps: V6

Created: 2=Dec-95 13:Z28

Revised: 2=Dec-95 13:41

File Name ™C:%WTL)Datah Tgah TGL-Caox.001™ G
Button 3ignals

Jelect Item
Jelect Item

1

2

3 ¥1 3ignal Weight (%)
g:

5: Select Item

f

-

g

a

Y& S3ignal Weight (%)
Y2 Twype Derivative [(Limne)
¥3 S3ignal Not Used

[l S I -

Jelect Item

: 2elect Item 2 ¥3 Type EZnd Deriwv. [(Line)
Button QK 3ignal 3Jelection
Button OK Data File Information

10 Function Weight Change

11 Function Cancel Cursor Input

12 Function Weight Change

13: Cursor Point 1 (62.00581, 99.9953)

14: Cursor Foint 2 (Z64.2584, S7.6621)

15 Function Auto Cursor Limits

16 Button Derivative Fraction 1 _J:J
Figure 6.8 l | 4
Example of a Macro |Line: 1 Caol 1 | "
Report
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Viewing an Autoqueue Report

The View/Autoqueue Report function is used to view a listing of the
steps contained in the Autoqueue file. (The Autoqueue file is created
from the Instrument Control functions. See the documentation accompa-
nying the Instrument Control portion of 7hermal Advantage.)

When you select this item from the View menu, the Autoqueue Report
file is automatically opened, displaying the data files and macros used in
the autoanalyses. Any editing that you do here will not be saved to the
autoqueue. Editing must be performed using the Autoqueue window.
See Chapter 8 for more information on the Autoqueue.

E¥ Report Editor - TGA-Caox. 0071 _rtf [_ (O]
Eile Edit Inzet Help

E";E%| o E”Enurierl‘*\lew j”ﬂ:l ﬂB S U H
e : : : : : : : : : : : .

hniversal Analysiz VE.5C lutogqueue 16-Dec-9 14:56

"Cih\Program Filesh\ TA Instrumentsh TahDatah TGLY TGA-Caox.001™ "C:%Progr
"Cih\Program Filesh\ TA Instrumentsh TahDatah TGLY TGA-Caox.001™ "C:%Progr
"Cih\Program Filesh\ TA Instrumentsh TahDatah TGLY TGA-Caox.001™ "C:%Progr

4| | i
o

|Line: 1 Cok 1 |

Figure 6.9
Example of an Autoqueue Report
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Viewing an Autoqueue Log

NOTE:

The View/Autoqueue Log function is used to view a listing of the
records contained in the Autoqueue Log file. (The Autoqueue Log file is
created by the Universal Analysis Autoanalysis program when a record is
processed.)

When you select this item from the View menu, the Autoqueue Log file is
automatically opened, displaying the autoanalysis records (data files and
macros used in the autoanalyses) along with an indicator that the record
was processed successfully (OK) or unsuccessfully (!!). Any editing that
you do here will not be saved to the autoqueue log.

Records may be copied, then pasted back into the Autoqueue window
to processed again.

The entire record must be selected (highlighted) ta be copied and successfully added
to the Autoqueue window.

Periodically you should clear this log to avoid having too many entries
listed. To clear the log, select Edit/Select All, then Edit/Delete from
the menu. See Chapter 8 for more information on the Autoqueue.

Report Editor - TGA-Caox_001_rtf

File Edit Insett Help
BEHSE o & & @ |[Covertew =l e - v = =
4 n n N n n N . . . . . . . .
1. [l [l 1 [l [l 1 [l [l 1 1 [l [l 1 [l ﬁ
Universal Analysis Autoqueue Log File. Created S-Dec-95 14:14.
IorCiyProgram Filesy Th Instrumentsh TAYData\DSCyDsc-pet.001™ "C:YProgram
OF "Ci:wProgram FileshTA Instrumentsh TAYyDatalDIChDac-pet.001" "C:%Program
OF "C:WwProgram Files'TA Instrumentsh TAYDatalD3IChDsc-pet.001" "C:%\Program
OF "C:WProgrsm Filesh Th Instrumentsh TiyData\D3IChDsc-pet.001" "C:i4WFrogram
QE "C:WwProgram Filesh TL Instrumentsh TLAYDatalDIChDac-pet.001" "C:YProgram
QE "C:WwProgram Filesh TL Instrumentsh TLAYDatalDIChDac-pet.001" "C:YProgram
VorCiyProgram Filesh TA Instrumentsh TASData\DSChDsc-pet. 001" "C:Y\Program
PEoMC:y Program FileshTA Instruments' TASDatalD3ICyDsc-pet.001" "C:Y% Program
VLo Program Filesh TA Instruments' TADatalD3ICh Dac—-pet.001" "C:Y% Program
PEo My Program FileshTA Instruments' TADatal TGAY TGA-Caox.001™ "C:%Programr
oSy Program Filesy TA Instrumentsh TAYDatah TGAY TGA-Caox.001" "C:'% Program
OF "Ci:WwProgram FileshTA Instrumentsh TAhDatal TGAY TGA-Caox. 001" "C:% Prograr l
OF "C:WwProgram FileshTA Instrumentsh TAhDatal TGAY TGA-Caox. 001" "C:% Prograr
OFK "C:WwProgream Files'TA Instrwmentsh TAData) TGAY TGA-Caox. 001" "C:% Progrsam
1
Figure 6.10 4 ! :
gure 0. - =
8 |Line: 17 Col: 1 [

4

Example of an
Autoqueue Log File
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Using the Report Editor

NOTE:

The Report Editor program is an independent program contained within
Universal Analysis that is used to display, edit, and print reports. It can
also be used as a text editor to write and print your own text report files.

Only one Report Editor window at a time is available within the Universal Analysis
program. If this window is minimized or opened, and the View options are accessed
again, the currentinformation displayed in the window is replaced with the newly
selectedinformation.

You can select the font type, size, and effects (bold, underline, and italics)
from the items found below the menu bar.

The Report Editor menu bar (shown
here) contains four menus. Turn to the
follow pages to obtain more information
on each one. ﬁ'n§|ﬂ BN =)

k..

=ah Beport Editor - Untitled
File Edit Insert Help

File Menu (Report Editor)

226

The Report Editor File menu (shown here) is

used to open a text file and perform various Hew Clil+
. . . Open... Chrl+0
functions such as closing any open files, saving a
L. Cloze
and printing files, etc. Save CiE
. Save bz
Refer to the table on the next page for a brief
description of each option found in the menu. Erint Ctrl+F
Print Setup...
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Table 6.1
Report Editor
File Menu Items

Menu Item

Description

New

Open

Close

Save

NOTE:

Save As

Print

Print Setup

Use the New menu item to start a new text file.

Use the Open option to open an existing text file.
Choosing this function accesses the Open File
window, allowing you to browse and locate a text
file.

Use the Close option to close the current file.

Use the Save option to save the current text file.
The default text file format is Rich Text Format
(.rtf). Use Rich Text Format to save the font, text,
size, etc. Use ordinary test format (.txt) to save
only the text characters and not the format infor-
mation. Always use ordinary text format (.txt) to
save ASCII or spreadsheet data files.

Thefile extension [.rtf or.txt) determines the save format.
Any extension otherthan .rtf will save as plain text . txt).

Use the Save As option to save the current text
file to a different directory or in a different file
format. This function accesses the Save As
window.

Use this command to print a document. This
command presents a Print dialog box where you
may specify the range of pages to be printed, the
number of copies, the destination printer, and other
printer setup options.

Use this command to select a printer and a printer
connection. This command presents a Print
Setup dialog box, where you specify the printer
and its connection.
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Edit Menu (Report Editor)

Undo Chrl+2
Cut Chrl+
The Report Editor Edit menu is used to perform Copy Ctrl+C
various editing functions on the current graph. Paste il
You can use it from the menu bar or by right Delete Ctrl+D
clicking to display the Edit pop-up menu. Select Al Chlwh
Refer to the table below for a brief description Find...
of each option found in the menu. Replace »
Table 6.2 Fant...
Report Editor Word ‘Wrap

Edit Menu Items

Menu Item

Description

Undo

Cut

Copy

Paste

Select All

Find

Replace

Font

Word Wrap

228

Use the Undo option to cancel the last action
performed.

Use the Cut option to remove information and
place it on the clipboard for retrieval by the Edit/
Paste option.

Use the Copy option to copy the information to the
clipboard for retrieval by the Edit/Paste option.
This information can also be pasted into the
Annotation window to be added to a plot.

Use the Paste option to retrieve any information
placed on the clipboard.

Use the Select All option to highlight all of the text
in the current file. You can then copy it to the
clipboard for retrieval or delete it, etc.

Use the Find option to locate a string of characters
in your document. See the next section for details.

Use the Replace option to locate and replace a
string of characters in your document. See the
next page for information.

Use the Font option to access the Font window,
which allows you to select a font, font type, font
size, and effects.

Use the Word Wrap option to turn on (checked) or
turn off (unchecked) the word wrapping capability
in the text editor.
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Finding Text

Use the Find option to locate a particular string of characters within your
document. When you select this option the Find window, shown in the
figure below, is displayed.

Find |
Find what; |
[T Match whole word only Cancel |

[T Match case

Figure 6.11
Report Editor Find Window

Follow these instructions to locate a string of characters:
1. Type the desired string of characters in the Find what field.

2. Check Match whole word only, if you want to find that exact word
without any prefixes, suffixes, etc.

Check Match case, if you want to find that exact set of characters in
only the case typed.

98]

4. Click the Find Next button to find and select the next occurrence of
the text specified.

NOTE: ‘ Searching begins fromthe position of the cursor within the document to the end of
the document.

Replacing Text
Use the Replace menu (shown here) to | 7aut
locate and replace a string of charac- gpace Separators With Tabs
ters in the open document with another Space Separators With Commas
string (Text option) or to replace the
space separators in the document with either tabs or commas. Some
spreadsheet programs will not separate the numerical data in a row
unless there are either tabs or commas between the numerical data.
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Text

When you select the Replace/Text option the Replace window, shown
below, is displayed. Use this window as follows to locate a string of
characters within the open document.

Replace
Find what:  |plat Find Mest
Replace with: I Beplace

Replace Al
™ atch whols word only

adad

Cancel
[T Match caze

Figure 6.12
Report Editor Replace Window

1. Type the string of characters you want to locate in the Find what
field.

2. Type the string of characters that you want to use to replace the
existing string.

98]

Check Match whole word only, if you want to find and replace that
exact word without any prefixes, suffixes, etc.

4. Check Match case, if you want to find and replace the given set of
characters in only the case typed.

5. Click the Find Next button to locate the characters.

6. Click the Replace button to replace the selected instance of the
search criteria, find the next occurrence, and then stop.

NOTE: After you have completed bath entry fields, you can use the Replace All button to
automatically locate and replace all occurrences of the search criteria inyour
document. To replace the occurrences one at atime, use the Replace button.

Space Separators With Tabs

Use this menu option to automatically replace the space separators in the
document with tabs. Some spreadsheet programs will not separate the
numerical data in a row unless there are tabs between the numerical
data. After choosing this option, you can copy and paste or export the
data in the report to another application, such as a spreadsheet program.
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Space Separators With Commas

Use this Replace menu option to automatically replace the space separa-
tors in the document with commas. Some spreadsheet programs will not
separate the numerical data in a row unless there are commas between
the numerical data. After choosing this option, you can copy and paste or
export the data in the report to another application, such as a spreadsheet
program.

Insert Menu (Report Editor]

FRepaort Heading

The Report Editor Insert menu is used to add

. . . Bezultz Repart
the items shown in the menu (listed below) to Diata Table
your text file. This can allow you to create one Parameter Block
file that contains all of the information gath- Method Lag
ered from the current data file. an elehlLeg)

) ) ) Current Macro Report

Refer to the pages listed beside each item Autoqueus Repart
below to obtain more information on what will Autoqueue Log

be added to your report.

* Report Heading - page 232

* Results Report - page 216

e Data Table - page 219

*  Parameter Block - page 221

*  Method Log - page 222

* Analysis Log - page 222

e Current Macro Report - page 223
* Autoqueue Report - page 224

* Autoqueue Log - page 225.
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Report Heading (Report Editor)

Figure 6.13

Report Heading

Use the Report Heading option on the Insert menu to insert the
information contained in the report heading of the current data file into the
open text file. The report heading contains the following information: file
name, experiment run date, name of the program used for analysis, run
number and the type of file. See the example below.

& Report Editor - Untitled H=E
Fil= Edit Ingett Help

EEHE v i EE [Couetew =] [ B 7 u
‘\lﬂ L L L L L L L L L L L L L L

pr ] ] ] 1 1 1 ] ] 1 1 1 ] ] ] 1}
File: E: Ti'Data'Dl3ChDsc—-pet. 001 Fun Date: 10-May-95 14:44

Program: Universal VZ.0C Fun MNumber: 63

TL Instruments Thermal Analysis -—- DEC Standard Cell

|Line: & Cal 1 | Modified | p

Help Menu (Report Editor)

232

The Report Editor Help menu is used to access help topics and help on
the Report Editor.

* Help Topics (Report Editor): Use this menu item to display the
topics available in the online help associated with the current
application.

* Help on Report Editor: Use this function to access help on the
Report Editor program.
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Opening the Spreadsheet Program

Use this function to open the Microsoft Excel® program with a blank first
sheet.

NOTE: If you want to bring the data file into Microsoft Excel, select View/Data Table/
‘l Spreadsheet from the menu.

If you need help using the program, see the documentation provided with
the program.

Creating a Custom Report Template

The Custom Report Editor is used to create and edit customized Univer-
sal Analysis report templates. The templates are created using any
number of report objects such as plots, results, parameters, method log,
data tables, etc. The report object boxes (which represent the plots,
results, etc.) can be sized and positioned as desired to fit on a single piece
of paper. After a template file is created and saved, it can be used over
and over again with different data files and can even be linked to an
Autoanalysis macro to further automate the process of analysis and
report generation.

The Custom Report Editor program requires that you have Microsoft
Word® 97 or Word 2000 installed on your computer. In order for the
spreadsheet function to operate, Microsoft Excel® must be installed on
your computer.

You can create templates that call for only one file or templates that use
multiple files. A template using one file will create the report from the
current file. A template that requires multiple files will prompt you to
select the files desired.

NOTE: ‘l Only ane Custom Report window at atime is available within the Universal Analysis
program.

Universal Analysis generates custom report documents by directly
running Microsoft Word and Microsoft Excel from within Universal
Analysis. Each report object inserted is dynamically created at run time
and inserted into a single integrated Word document. Once the Word
document is created, you can edit any spreadsheets within the document
by double-clicking on the object to open Excel with Word.

You can insert, edit, import, export, and print the report objects using the
menus and tool bar buttons. For further information see the following

pages.

Microsoft Word® and Microsoft Excel® are registered trademarks of the Microsoft
Corporation.
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Starting the Custom
Report Editor Program

There are several options
available in the View/Custom

Repo

rt menu (shown here)

that can be used to start the
Custom Report Editor program
with either a blank (new)
report template or to open/print
an existing report template.

Use the Custom Report/New

menu

item to create a new

custom report template or
choose Custom Report/Edit
to edit an existing report. When
you select this menu item the
Custom Report Editor window
is displayed either with a blank
window (new) or with the custom report last created (edit).

& Custom Report Editor - Untitled

Eile Edit |nzert Help

Bezults 3
Data Table k
Parameter Block...
tethod Log...

Current Macro Repaort...
Autoguene Feport. .
Autoquene Log...

Repart Editar...

Spreadzhest...

Cuztom Report Mew. ..
Edit...
examplel
examples
exampled
exampled

=EEwE BEa

SEEREIA Y
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Select the name of an existing
report template from the Cus-
tom Report list to either open
the report in Microsoft Word® or
send the report directly to the
printer.

When the Custom Report Editor
program opens, the window
shown to the left is displayed.

For instructions on how to use
this program and customize it to
your own preferences, turn to the
next several pages.
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Basic Instructions on Creating a Template

NOTE:

There are many different ways to create a report template in Universal
Analysis. The set of steps that follows is intended to give you a basic idea
of the steps involved with creating a custom report template.

1. Open the desired data file(s) and analyze the data to obtain the
results you want.

You can create a report template with nofiles open (which creates empty report
objects). The report objects will be filled in when a data file is open and the appropri-
ateinformation is supplied. For example, there can be no results report created if
no analysis is done on the openfile.

2. Select View/Custom Report/New from the main menu. The
Custom Report Editor program opens.

98]

Select the desired object to insert in your template from the Insert
menu or from the tool bar.

4. Size the object block by positioning the cursor over the border of the
block and hold down the mouse while moving the cursor.

5. Drag-and-drop the object anywhere you desire on the template
window. This window represents

&85 Custom Report Editor - examplel_uat M=l E3 an 8 %2 by 11-inch page.

Fil=  Edit Inzet Help

TR 6. Repeat steps 3 through 5 for

EHwrE BEEE

as many objects as desired.

Some objects, such as Text
and Data Table insertion,

- Pustom Report Universal Analysis 2000 c

Data Report 1

require that you enter

: information to configure that
Method Log 1 Results Sheet 1 - &
object.

Parameter Report 1

7. Format the objects as
desired. See “Setting Up
Options™ for information. See
the figure to the left for an

Data Sheet 1

example of a finished tem-

plate.

8. Click the [& button or

select File/Save from the
menu to save your template.
Once you save this file, it will
appear in the View/Custom

Mormal Plot 1

Report menu.
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9. Export the report to Microsoft Word® by clicking on the [## button
or by selecting File/Export to Word from the menu. If you have
more than one version of an object placed in your template (for
example, Normal Plot 1 and Normal Plot 2) the program will prompt
you to select the data file that should be linked to each object. If there
is only one data file open, the program will assume that this is the
source for the object.

See the figure below for an example of a finished report.

Custorn Report Universal &nalysis 2000

Ramp 1000 " Cimin ko Feak IEgIakon
Telpeialie. e ) : lnmn—
. - Flow 0o =1 Treel I =R
D‘-‘%MMM Erel o vl T = T =
1000 TE o= T =0 | 15+
000 TS N = R
000
4000 et EERETRIED
%E ﬁﬁ T e el |, 7= LI .= 5 LGEl
T o T Wl

TODD 02488 == = =
fmbn oate T2E5 TGS T = ﬁ

aninn A

AlrBeairg G Temperakre [Heal Flow
Ampl Lde Sweep: T
Baelre Ot |2 -7 100
Baelre Sop: 00035
Calbralon PARE : -4 51
Cel Core bk b G214

R E R E

Cel Humber, 348 T |

Clamp Tape: AT

Commenl: He Purge=Z23n Lmin 2441

Cross Tdk Core Inl: T |

Daka Com) :

e R TS s 0.5 0o T
EEE]
R

0o

Figure 6.14
Example of a Completed
Custom Report in Word
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Setting Up Options

Once a report object has been inserted into a template it can be moved
anywhere on the page that you wish. You can also set up various options
associated with that particular report object. For example, if you have
inserted a Parameter Block object, you can choose which parameters to
include. Some options are applicable to all objects, such as whether or not
you want a box around the object and the line weight of the box, font, etc.

This section provides basic instructions on setting options for the objects.
For details on a particular option, highlight the menu item and press F1 or
click the associated dialog's help button.

1. Highlight the desired object to format or choose Edit/Select All from
the menu.

2. Right click to display the pop-up menu or select the desired option
from the Edit menu. (The functions that do not apply to this object
will be grayed out.)

98]

Choose the desired options from the dialog displayed and click OK.

Additional set-up features:

*  You can choose to have all inserted objects line up exactly with the
grid by selecting Edit/Snap to Grid.

* You can set up certain program options that will apply to all inserted
objects and to the layout of the template window by selecting File/
Options.

*  You can layer the objects on top of each other and place a specific
object behind another by highlighting the object and selecting Edit/
Send to Back.

* You can lock an object in its current position on the page by
highlighting the object and selecting Edit/Position Locked.

» To remove an object, highlight it, then select Edit/Delete from the
menu.

* To copy an object, highlight it, then select Edit/Copy from the menu.

» To paste an object, highlight it, copy it (see above), then select Edit/
Paste from the menu.
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*  To change the file number source of an object, highlight it, then
select Edit/File Number from the menu.

For more detailed information see the remainder of this chapter or consult
the online help in the program.
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Using the Custom
Report Editor File Menu

The File menu (shown here) is used to
open a template file and perform various
functions such as closing any open files,
setting up options, saving and printing
files, etc. See the following table for a
description of the menu items available. Export bo tword. .

Table 6.3
Custom Report Editor
File Menu

Mew Ctrl+
Open... Ctrl+0
Cloze

Save Chil+5
Save s .

Whord Template...
Mext Feport Fage. ..
Options...

Erint Ctrl+F
Frint Setup...

Menu Item

Description

New

Open

Close

Save

Save As

Use the New menu item to create a new template
file.

Use the Open menu item to open an existing report
template file.

Use the Close menu item to close the current
report template file.

Use the Save menu item to save the current
custom report template to a template file. The
template files are saved with the extension .uat.
The program will place the template files in the
report directory specified on the Main Options -
Directory Page.

Once a template file is saved, the filename will be
added to the View/custom Report menu.

Use the Save As menu item to save the current
custom report template with a new name or in a
new location. The template files are saved with the
extension .uat. The program will place the template
files in the report directory specified on the Main
Options - Directory Page unless a different
directory is specified.

(table continued)
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Table 6.3
Custom Report Editor
File Menu (cont'd)

Menu Item

Description

Export to
Word

Word
Template

Next Report
Page

Options

Print

Print Setup

240

Use the Export to Word menu item to open the
report template file in the Microsoft Word®
program. Once it is opened in that program, all of
the functions in Microsoft Word will be available to
edit the report further as desired.

Use the Word Template function to base your
custom report, when it is generated, on an existing
Microsoft Word® template file. When this menu
item is selected you can browse for and select a
Word (.dot) file using the Word Template window.

Use the Next Report Page function to select the
filename of another Universal Analysis template
file to be used as the next page of the custom
report. This option links two or more templates
together to produce one report.

Use this menu item to access the Custom Report
Options window that allows you to select settings
for the program. The types of options available are:
set up for the object box, format of the editor grid,
units used in the printed report, number of report
copies, and various spreadsheet options. See the
next section for more details.

Use this command to print a document. This
command presents a Print dialog box where you
may specify the range of pages to be printed, the
number of copies, the destination printer, and other
printer setup options.

Use this command to select a printer and a printer
connection. This command presents a Print Setup
dialog box, where you specify the printer and its
connection. You can also specify the page orienta-
tion of both the Custom Report Editor template and
the final printed custom report.
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Setting Up the Custom Report Options

You can set up default options that will apply to both the Custom Report
Editor program and the way that objects are formatted when first inserted
using the Custom Report Options window. If you set up these options
from this dialog, you can save yourself time when each new custom
report template is created.

NOTE: These default options will not be applied to any existing report template. They will only
be applied to a new report template that is created after the options are set up.

If you want to individually change the options applying to a specific
object, highlight that object, right click to display the pop-up menu and
change the desired option.

Custom Report Options |
—Repart autput: —Spreadzheet object defaults:
W Autarnatic ko IDefault Printer ;I ¥ Show arid
™ Show report creation W Auto fit colurnns

Umits: Ilnches "I Copies: |1 Text alignment: IEenter "'I
Faper sizec— Orientation:— Start columm: |1
- i+ Partrait
I Letter _I = Start row; |'|

8.5 %11 inches " Landscape
—Editor grid —Object box defaults:
W isible W “isible in report

Haorizontal zpacing: IEI2— inches [~ Transparent

Wertical spacing: IEI2— inches ¥ Snap to grid

Harizanktal origir: IU-U— inches Line color: m
Werhical anigin: IEIU— inches Line thickness: W inches

Ok I Save

Cancel | Help |

Figure 6.15
Custom Report
Options Window

Follow these instructions to set up the Custom Report Editor program:

1. Seclect File/Options from the Custom Report Editor window.
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2. Select the desired default conditions that will apply to the final printed
report:

Automatic: Check this box to have the program automatically
print a custom report when a template name is selected from the
View/Custom Report menu.

If this option was checked when the report template was saved,
the custom report will automatically print to the specified report
destination when the template filename is selected from the
View/Custom Report menu.

If this box was not checked when the report template was saved,
selecting the template filename from the View/Custom Report
menu list will open that custom report in Microsoft Word®, but
not automatically print it.

Show Report Creation: Check this box to have the program
show the creation of a custom report in Microsoft Word®
regardless of whether the custom report is printed automatically.

If this option was checked when the report template was saved,
the custom report is shown in Microsoft Word whenever the
custom report is printed either automatically or manually.

If this box was not checked when the report template was saved,
the custom report is not shown in Microsoft Word before it is
printed it either automatically or manually.

Measurement Units: Click the arrow to the right of the list to
select the measurement units to be used in the Custom Report
Editor program. These measurement units will apply to the box
line thickness, grid spacing and grid origin, which are all selected
on the Custom Report Options window.

Copies: Enter the number of copies that will be automatically
printed when the checkbox Automatic is selected on the Custom

Report Options window.

Paper Size: Click the arrow to the right of the list to select the
paper size to be used when the custom report is printed.

Orientation: Select the radio button desired to print your reports
vertically (portrait) or horizontally (landscape).
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NOTE:

98]

Select the desired default options that will apply to any spreadsheet
objects that are inserted into the report template. Please note that
these options will not be displayed on the template, they will appear in
the final printed report:

Show Grid: Check this box to show a grid on your final custom
report when a Microsoft Excel® spreadsheet object is inserted in
a new template.

Auto Fit Columns: Check this box to automatically provide the
best fit for the columns and rows generated on your final custom
report when a Microsoft Excel® spreadsheet object is inserted in
a new template.

Text Alignment: Seclect the alignment of the text contained in
the cells of a Microsoft Excel® spreadsheet when it is placed in
a custom report. Choose from general, left, center, or right text
alignment.

Start Column: Enter the number of the first column that should
receive entries when a Microsoft Excel® spreadsheet is gener-
ated in a custom report.

Start Row: Enter the number of the first row that should receive
entries when a Microsoft Excel® spreadsheet is generated in a
custom report.

The Start Column and Start Row items are best used when you have an Excel
template that you want to pull data into. For example, you may have set up pre-
defined columns with certaininformationin them and want to insert the Universal
Analysis-generated spreadsheet to fit that template. So you maynot wantto starta
column 1, you maywant to start at column 2, leaving column 1 forthe pre-defined
infarmation.

4.

Set up the Custom Report Editor grid that is displayed. Select from
the following options:

Visible (Editor Grid): Check this box to have a dotted grid
displayed on the Custom Report Editor window. This grid
help you align the object boxes when creating a template.

Horizontal Spacing (of Grid): Enter the desired numerical
value for the amount of space left horizontally between grid dots.
(In order to see the grid, you must check the Editor Grid Visible
box.)

Vertical Spacing (of Grid): Enter the desired numerical value
for the amount of space left vertically between grid dots.
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NOTE:

NOTE:
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Horizontal Origin (of Grid): Enter the desired numerical value
for the horizontal origin of the grid on the Custom Report Editor
window. For example, if you enter the horizontal origin of 0.2
inches, the grid will start 0.2 inches down on the template page.
This option can be used to set a top margin for the custom report.

Vertical Origin (of Grid): Enter the desired numerical value for
the vertical origin of the grid on the Custom Report Editor
window. For example, if you enter the vertical origin of 0.2
inches, the grid will start 0.2 inches from the left side of the
template page. This option can be used to set a left side margin
for the custom report.

You can select the units used for the grid entries abave from the Measurement
units list on the top left side of this window.

5. Choose the desired default options that will affect the object boxes
that can be inserted into your custom report from the following:

Visible in Report: Check this box to make the object box lines
appear around the perimeter of the inserted object in the final
Microsoft Word® custom report. For example, if this is checked,
a box will be drawn around a Normal Plot in the final custom
report.

Transparent: Check this box to make the background of an
object transparent or "see-through" for any objects behind it in the
final Microsoft Word® custom report. For example, if you check
this box for a Text object, you can position the text label over a
curve and the curve will show through the background of the text
characters. Leave this box blank to make an object opaque.

The Transparent setting does nat apply to Microsoft Excel® Spreadsheets. They
must always remain opaque.

Snap to Grid: Check this box to have the object boxes automati-
cally aligned with the grid dots when inserted. The boxes will
"snap" to line up with the grid dots. This function is good for
aligning object boxes more precisely. Leave this box blank to be
able to move the object boxes anywhere on the template page.
The boxes can be positioned between grid dots, if desired.

Line Color: Click on the arrow to the right of the list to select
the desired color for the object box line that will be displayed and
printed in the final custom report when exported to Microsoft
Word®. (This color will not be displayed on the report template.)

Line Thickness: Enter the desired thickness for the object box
line that will be displayed and printed in the final custom report
when exported to Microsoft Word®. (This color will not be
displayed on the report template.)
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NOTE: You can select the units used for the Line Thickness entry from the Measurement
units list on the top left side of this window.
6. Click OK to apply these options to this session only or click Save to
save these options to the initialization file for the program.
NOTE: ‘ | The Default button will recall the default factory settings for this dialog.
. Unda Clrl+£
Using the Custom
. . Cut Chrl+
Report Editor Edit Menu Coy Cular
Fazte Chrl+
The Edit menu (shown here) is used to Delete Chrl+D
make changes to an existing report tem- Select Al el
plate. You can cut, copy, paste, delete, and
. . Box...
select all report objects; you can make
. .. Font...
changes to specific characteristics of a Params
report object; and you can make the o
. . . File Mumber. ..
objects snap to the grid or lock their
.. Ovwerlay Mumber. ..
position. Spreadzheet...
Select (highlight) the report object(s) to be Send to Back
edited and then choose the desired function Snap to Grid

from the menu. See the table below for a
brief description of the first six menu items.

Positon Locked

The remaining menu items require more extensive explanations and are

explained further in this section after the table.

NOTE: Tomake global changes to report object parameters, which will be applied each time

anew objectis inserted, select File/Options from the menu and make changes

using the Custom Report Options window.

Table 6.4
Custom Report Editor
Edit Menu
Menu Item Description
Undo Use the Undo option to cancel the last action
performed.
Cut Use the Cut option to remove information and

Paste option.
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place it on the clipboard for retrieval by the Edit/

Copy Use the Copy option to copy the information to the
clipboard for retrieval by the Edit/Paste option.
(table continued)
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Table 6.4
Custom Report Editor

Edit Menu (cont'd)

Menu Item Description

Paste Use the Paste option to retrieve any information
placed on the clipboard.

Delete Use the Delete option to delete the selected report
object.

Select All Use the Select All option to select (highlight) all of
the report objects displayed.

Please refer to the next several pages for information regarding the

remaining Edit menu items.

Editing Box Properties for the Report Objects

After inserting a report object you can make changes to the box around
the perimeter from the Edit menu.

NOTE: Tomake changes to the box that will be in effect each time a new repart object is
inserted, select File/Options and make the changes on the Custom Report
Options window.

Follow these instructions

. . Box Opti
to edit the report object e —— |
box: ~Object box:
¥ “isible in repart
1. Select the report [ Tiansparent
. . h
object desired on the  Postion locked
template.

Line colar: I- Elack "'I

2. Select Edlt/B,OX frgm Line thickness: IW inches
the menu or right click

and select Box from

h Th —Pozition [inchesz):
the pop-up menu. lhe _ o
Box Options window Top: I'l 597 Height: |2.EI
(shown here) is Left: |u.4nza Width: |3 i

displayed.

ak | Cancel |
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3. Choose the desired options that will affect the selected object box to
be inserted into your custom report from the following:

*  Visible in Report: Check this box to make the object box lines
appear around the perimeter of the inserted object in the final
Microsoft

Word® custom report. For example, if this is checked, a box will
be drawn around a Normal Plot in the final custom report.

*  Position Locked: Check the Position Locked box to make the
select report object stay in its current position. You will notice
that the position entry fields are grayed out when this box is
checked-this it to prevent moving the object. This locks the object
in position, even if you select Edit/Select All and attempt to drag
all of the object boxes—the locked box will stay in its position.

* Line Color: Click on the arrow to the right of the list to select
the desired color for the object box line that will be displayed and
printed in the final custom report when exported to Microsoft
Word®. (This color will not be displayed on the report template.)

e Line Thickness: Enter the desired thickness for the object box
line that will be displayed and printed in the final custom report
when exported to Microsoft Word®. (This color will not be
displayed on the report template.)

4. Enter/edit the exact position of the report object in inches:

e Top: Enter the amount of inches from the top of the page that
you would like the report object to be positioned. For example, if
you enter 2 inches here, the box will be positioned two inches
down from the top of the page.

e Left: Enter the amount of inches from the left side of the page
that you would like the report object to be positioned. For ex-
ample, if you enter 2.25 inches here, the box will be positioned
two and one half inches from the left side of the page.

* Height: Use this field to enter the length of the report object
box-this value will set the height of the box in inches. For ex-
ample, if you enter 4 inches here, the report object will be four
inches long when printed.

e Width: Use this field to enter the width of the report object box-
this value will set the width of the box in inches. For example, if
you enter 4 inches here, the report object will be four inches wide
when printed.
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5. Click the OK button when finished. The box options will be shown on
the final custom report.

Editing Fonts for the Report Objects

Select the Edit/Font option to access the Font window (shown here),
which allows you to select a font, font type, font size, font color, and
effects that will be applied to the highlighted report object.

Font HE

To change the

Eant: Fant style:
fOI'.lt toall report I.t’-‘«rial IHeguIar 0k I
objects at once, 2] T
select Edit/ !! Aial Black |t e |

B Avrial Marmow Bold
Select All from Ashley Script MT Bold Italic

AuvaniGard

the menu, then B ackenile BE Bold
select Edit/Font Baskerville BE Frequla ™|
orrightclickand = pgene ~ Sample
select Font from I Stikeout
the pop-up menu. [ Underline PelBlyLe
Then the font Calar
specifications | I Black =] | Seipt
chosen will apply [Westem [ |
to all highlighted
report objects.

Editing Parameters for the Report Objects

248

Select this option to edit the parameters of the report object. The window
that is displayed when Edit/Params is selected depends on the report
object being edited.

* Results Report Object—displays the Result Options window. See
page 218 for information.

» Data Table Report Object—displays the Data Table Limits
window. See page 219 for information.

» Parameter Report Object—displays the Parameters Options
window. See the next page for information.

*  Method Log Object—editing parameters function is not available.

*  Plot Object—displays the Plot Options window. See page 250 for
information.

» Image Object—displays the Select Image File window. See page
258 for information.
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e Text Object—displays the Report Text window. See page 247 for
information.

Editing Parameter-Type Report Objects

Use this window to selectively choose the parameters that you want to
display in your finished custom report. Follow these instructions:

1. Highlight the desired parameter report object box on the report
template.

2. Select Params from the Edit menu or from the pop-up menu. The
Parameter Options window is displayed as seen below.

Click in the square box next to the parameter(s) that you want to
include in your custom report. You can click the All button to select
all of the parameters listed or click the None button to select no
parameters. As each parameter is selected the name is displayed in
the Arrange parameters area.

W

=] E3

ah Parameter Options

—Select parameters: —Arrange parameters:

Air Bearing Gas j -

Amplitude Sweep -g-mli'ﬁlt_UdEDS”W'EtED
Bazeline Offzet azeline Ultse

) Bazeline Slope
B azeling Slope Calibration Paints

Calibration Pointz Cell Conztant

Cell Constant Cell Mumber

Cell Murnber Clarmp Type
Comment

Clarip Type
Comrnent

Crogz T alk Congtant
Drata Comprezzion Thresholds

Cross Talk Constant
Data Compression Thresholds

Drata File Wersion
Drate of Experiment

[ |

Data File Yersion = ¥ Show name | List wertical
Figure 6.14
Custom Report Al MNone | = | b ove annl Delete |
Parameter
Options Cancel | Help |
Window
4. Highlight each parameter in turn and set it up individually as desired:
(a) Show the parameter name by checking Show name, if desired.
(b) List multiple numerical values vertically by checking List vertical,
if desired and applicable.
5. Arrange the parameters in the list by highlighting the parameter name
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6. Remove any undesired parameters by highlighting it and clicking the
Delete button or unchecking the box next to its name.

5. Click the OK button when finished.

Editing Plot-Type Report Objects

To edit the header, axis, footer, etc. that will be placed on the Normal or
Overlay Plot included in the custom report follow the steps below:

1. Highlight the desired plot report object(s) on the template.

2. Select Params from the Edit menu or from the pop-up menu. The
Plot Options window seen below is displayed.

Plot Options Ed |

—Show standard header: —Header lwpe;
[¥ Sample | Module [V Eile v Directaries {+ Standard header
¥ Size v Operatar Al " Cuztam et
v Method ¥ Bun date " Blark header
¥ Comment ¥ lrnstiument None " Ma header
T Show axiz: —Pen:
M ame:
MYl Y2 MYE Ve K &l IDark colars only j
~Tick lahels: Nare | with: [3 pirels
Vil WYz VY3V yd R
—Tick marks: Chow foote
I.
g o o o oo ol Fizne ¥ Ezodirecton ¥ Program version
Cancel Help

Figure 6.16
Plot Options Window
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Check the options that you want to appear in the heading on the
printed plot: Sample, Size, Method, Comment, Module, File, Operator,
Run Date, Instrument, or Directories. You can also click on the
buttons to select All or None of these header options.

98]

4. Check the options that you want to appear on each axis (Y1 to Y4
and X) of the exported plot: Axes names, tick labels, or tick marks.
You can also click on the buttons to select All or None of these
header options.
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5. Select the radio button for the desired header type: Standard, Cus-
tom, Blank, or No Header.

6. Check the frame option if you want the plot to be printed with a
boxed frame around it.

7. Check the options that you want to appear in the footer on the
exported plot: Exotherm direction and/or Program version.

8. If you are exporting your plot to an HPGL plotter, perform the
following steps: (a) Select the desired pen setting from the drop-
down list. (b) Enter the pixel width of the pen.

9. Click the OK button.

Editing Text-Type Objects

To edit the text that will be included in the custom report follow the steps

below:

1. Highlight the desired text report object on the template.

2. Select Params from the Edit menu or from the pop-up menu. The
Report Text window seen below is displayed.

T ~

Custom Report Uniwversal Analysis

Tesxt alignment; IEenter VI Fill calar; II:| white: "I
o [

Make the desired changes to the text or font.

LClipboard | Cancel | Help |

W

4. Use the Clipboard button to import any text from the clipboard, if
desired.

5. Apply the desired Text alignment or Fill color from the drop-down list
of choices.

6. Click the OK button when finished.
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Editing the File Number of a Report Object

To enter or change the file number that is used to generate the selected
(highlighted) report object follow the steps below. The files are numbered
in the order that they are opened.

1. Highlight the desired report object on the template.

2. Select File Number from the -
. File Number _ (O] |
Edit menu or from the pop-up

menu. The Flle Number File nurber: I
window shown here is dis-

played, 0k I Cancel | Help |

Enter the desired file number.

W

4. Click the OK button when finished.

Editing the Overlay Number of a Report Object

NOTE:

To edit the number of the curve overlay plot inserted as an object in a
custom report follow theses instructions: First highlight the curve overlay
object, then either select Edit/Overlay Number or right click and select
Overlay Number. The Overlay Number window is displayed to allow
you to change the plot number that will be used when the custom report is
output.

Enter zero (O) for the current overlay plot (the last averlay plot accessed). Zerois
the defaultt.

Editing a Spreadsheet Report Object

252

To edit the parameters of a i
Microsoft Excel® spread-

Sheet:
¥ Shaw grid

sheet object on the current
template follow these
steps:

[V Auta fit columns

Text alignment; I Cetiter hd I
1. Highlight the desired scnedre

spreadsheet object(s) Stat o —

on the template.

—Template file:

2. Select Spreadsheet [
from the Edit menu or
from the pop-up menu.
The Spreadsheet
Options window shown here is displayed.

Browse | Cancel Help
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3. Select the desired options that will apply to the highlighted spread-
sheet object(s). Please note that these options will not be displayed on
the template, they will appear in the final printed report:

4. Enter the location and name of a Microsoft Excel® spreadsheet
template file, if you want to place the spreadsheet report into an
existing Excel template for the final custom report. NOTE: You can
browse for the Excel template file by clicking the Browse button at
the bottom of the window.

5. Click the OK button when finished.
Layering the Report Objects

You can place one report object behind another, effectively layering them
by using the Send to Back menu item found in the Edit menu. Just
highlight the report object that should be behind another and select Edit/
Send to Back.

For example, you can insert a plot report object, then insert a text report
object to go on top of the plot when printed. If the plot report object ends
up on top, just highlight it and select Edit/Send to Back and the text
object will be printed on top of the plot object.

When you create a template, one report object can become hidden behind
another. Use Send to Back to bring the hidden object forward so that you
can reposition it by dragging and dropping it.

Snaping Objects to the Grid

Select (check) Edit/Snap to Grid from the Custom Report Editor menu
to have the object boxes automatically aligned with the grid dots when
inserted. The boxes will “snap™ to line up with the grid dots. This function
is good for aligning object boxes more precisely. This option may also be
set using the Custom Report Options window.

This function toggles between checked (on) and unchecked (off).
Uncheck this menu item to be able to move the object boxes anywhere
on the template page. The boxes can be positioned between grid dots, if
desired.
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Locking an Object's Position

Select (check) the Edit/Position Locked menu item to make the
selected report object stay in its current position. You will notice that the
position entry fields are grayed out when this box is checked—this it to
prevent moving the object. This locks the object in position, even if you
select Edit/Select All and attempt to drag all of the object boxes, the
locked box will stay in its position.

This function toggles between checked (on) and unchecked (off).
Leave this menu item unchecked to move the report object box at will.

Creating a Custom
Report with Multiple Files
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When you export a file that contains multiple file numbers to Microsoft
Word® (by selecting File/Export to Word or clicking the E button on

the tool bar), the Select
File window (shown here)
is displayed. This window
enables you to direct the

Select File 1 X|

Dsc-cure. 001 Thermoset

program to the filename to 41 Cal pp03.010 Aluminum
In Cal ppl2. 001 Indium
be used for each file number Zn Cal pp03.001 Zine

in the template. You do not
have to numerically select
the files according to the
order in which they were
opened.

If you want to use a report
template that calls for more
files or overlays than you
need to output, you can limit
the number of files or ok | Las | Cancel Help
overlays by clicking the
Last button when selecting
the last file or overlay for output. Any report blocks for files or overlays
beyond the last will be supressed.

The title of the window reflects the file number to be applied-for example,
if you have a template that uses files numbered 1 and 2, the window
displayed when the report is exported will prompt you to “Select File 17
and then “Select File 2.”
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1. Click on the filename that corresponds to the file number displayed in
the window title bar.

2. Click the OK button when finished. If there are multiple file numbers
used in the template, a window will be displayed for each file number.
When all file numbers have been accounted for, the custom report is
generated in Word.

Using the Custom
Report Editor Insert Menu

NOTE: ‘

Inserting a Results

Use Insert menu shown here (or the tool bar buttons) Fesylts N
to insert a variety of report objects into a custom report Data Table
template. You can then resize, move, and format the B

-

Parameter ¥

objects as desired and save them to a template file. Method Log

. . Eliat 3
Universal Analysis generates custom report documents Image...
by directly running Microsoft Word® and Microsoft Test..

Excel® from within Universal Analysis. Each report
object inserted in the template file is dynamically
created at run time and inserted into a single integrated Word document.
Once the Word document is created, you can edit any spreadsheets
within the document by double-clicking on the object to open Excel with
Word.

Tomake global changes to report object parameters, which will be applied each time
anew objectis inserted, select File/Options from the menu and make changes
using the Custom Report Options window.

For information on the contents of a particular report object, see the
explanations earlier in this chapter in the section “Getting Results Infor-
mation.”

Report Object

Select Insert/Results/Report from the Custom Report Editor menu to
insert an object into the template that represents the results of your
analysis in a written report form.

When you select this item, the object block is inserted into the template. It
can then be moved, resized, and formatted as desired.
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Inserting a Results Spreadsheet Object

Select Insert/Results/Spreadsheet from the Custom Report Editor
menu to insert an object into the template that represents the results of
your analysis in a Microsoft Excel® spreadsheet.

When you select this item, the object block is inserted into the template. It
can be moved, resized, and formatted as desired.

When the custom report is dynamically created in Microsoft Word®, the
spreadsheet can be further edited and modified by double clicking to start
Microsoft Excel®.

Inserting a Data Table Report Object

Select Insert/Data Table/Report from the Custom Report Editor menu
to insert an object into the template that represents the data table in a
written report form. When you select this item, the Data Table Limits
window is displayed. After you enter and accept the values on this
window, the object block is inserted into the template. It can be moved,
resized, and formatted as desired.

The data table report shows the sample information and raw data points
from the data file. For multiplexed data, such as frequency or amplitude, a
separate table is generated for each multiplexed value.

Inserting a Data Table Spreadsheet Object

Select Insert/Data Table/Spreadsheet from the Custom Report Editor
menu to insert an object into the template that represents the data table in
a Microsoft Excel® spreadsheet form. When you select this item, the
Data Table Limits window is displayed. After you enter and accept the
values on this window, the object block is inserted into the template. It
can be moved, resized, and formatted as desired.

The data table spreadsheet shows the sample information and raw data
points from the data file. For multiplexed data, such as frequency or
amplitude, a separate table is generated for each multiplexed value.

Inserting a Parameter Report Object
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Select Insert/Parameter/Report from the Custom Report Editor menu
to insert an object into the template that represents a report listing of the
experimental parameters (which were used when obtaining the data
stored in the data file).
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When you select this item, The Parameter Options window is displayed
to allow you to select the parameters to be included. After selecting the
parameters and clicking OK, the object block is inserted into the template.
It can be moved, resized, and formatted as desired.

Inserting a Parameter Spreadsheet Object

Inserting a Method

Inserting a Normal

Select Insert/Parameter/Spreadsheet from the Custom Report Editor
menu to insert an object into the template that represents, in a Microsoft
Excel® spreadsheet form, the experimental parameters (which were
used when obtaining the data stored in the data file).

When you select this item, the Parameter Options window is displayed
to allow you to select the parameters to be included. After selecting the
parameters and clicking OK, the object block is inserted into the template.
It can be moved, resized, and formatted as desired.

Log Object

Select Insert/Method Log from the Custom Report Editor menu to
insert an object into the template that represents a report listing the
method segments that were used to obtain the data file. Each experimen-
tal method is made up of a group of segments, which are preprogrammed
instructions that are sent to the analytical instrument.

When you select this item, the object block is inserted into the template. It
can be moved, resized, and formatted as desired.

Plot Object

Select Insert/Plot/Normal from the Custom Report Editor menu to
insert an object into the template that represents a normal plot of the
current state of the plotted data file.

When you select this item, the object block is inserted into the template. It
can be moved, resized, and formatted as desired.
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Inserting an Overlay Plot Object

Select Insert/Plot/Overlay from the Custom Report Editor menu to
insert an object into the template that represents a curve overlay plot,
which was generated using the Graph/Overlay functions. See Chapter
4 for information on creating a curve overlay plot.

When you select this item, the object block is inserted into the template. It
can be moved, resized, and formatted as desired.

Inserting an Image File Object

258

Select Insert/Image from the Custom Report Editor menu to locate and
select a graphics file to insert into your custom report template.

When you select

this ftemn the
Select Image Lookjn: | 4 Data = =i
File window | 1Dea [ 1Tga

(shown here) is jg;“: ETma

displayedto T

allow you locate || _IRheclogy
the desired file.  |-*%
When you click

the Open bU»tton> File name: I Dpen I

the object block
L. i Files of twpe: | &l Pictures [* emf* wenf* oo jpeg® pros® b vI Cancel
is inserted into ! —I

the template. It Help |
can be moved,
resized, and

formatted as desired.
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Inserting a Text Object

Select Insert/Text from the Custom Report Editor menu to enter or
import text that will be inserted as a report object into your custom report
template, then printed on your custom report.

When you select this item, the Report Text window (shown here) is
displayed to allow you to enter text or import it from the clipboard. After

entering/

obtaining
the text Custom Report Universal Analy

you can

click the

font

button to

format it. Text alignment. [Center | Fil calor: [ ‘whi= =]
To place oK. 0 7] Ciboad | cancel | bep |
the text

ina

particular position, choose from the Text alignment drop-down list. You
can also choose a Fill Color from the list. This will be used to fill in the
text block on the final report with the chosen color. When you click the
OK button, the object block is inserted into the template. It can be moved,
resized, and formatted as desired.

THermAL ADvaNTAGE UNivERSAL ANALYSIS OPERATOR'S MIANUAL 259



Getting Reports

Using the Custom

Report Editor Tool Bar

The tool bar contains buttons that allow you to perform the some of the
major functions available in the menus. See the table below for the button

and its function.

Table 6.5
Custom Report Editor
Tool Bar

Button

Description

|8 W

o o (o

7] @

B @

L=

[
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Used to locate and open an existing report tem-
plate file.

Used to save a report template file.

Used to export the current custom report to
Microsoft® Word.

Used to print the report.
Used to insert an analysis results report.

Used to insert an analysis results report in spread-
sheet form.

Used to insert a data table report.

Used to insert a data table report in spreadsheet

form.

Used to insert a parameter block report.

Used to insert a parameter block report in spread-

sheet form.

Used to insert a method log.
Used to insert a normal plot.
Used to insert a curve overlay type of plot.

Used to locate and insert a graphics image from a

graphics file.

Used to enter text to insert in your template.
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Chapter 7

Getting Help

Introduction

There are several different types of help that you can get for the Univer-
sal Analysis program—context-sensitive help within the program, help
from the Help menu, and help from the TA Instruments company itself.

This chapter provides you with some information regarding the types of
helpavailable.

Context-Sensitive Help

Most Windows® programs contain some form of help for their programs.
You may be already familiar with these types of help from the use of
other applications. For detailed information on the help available within
the Thermal Advantage programs, refer to the Getting Started Guide
that you received when you purchased the program.

In general, context-sensitive help refers to help that is available for in a
specific context within the use of the program. For example, when you
have the Data File Information window open in Universal Analysis, you
will notice that a Help button is available on that window. Clicking on that
button brings up a help topic specifically dealing with the open window.
Context-sensitive help is also generally available by pressing the F1 key
on your keyboard when an item (button, field, etc.) in question is high-
lighted.

Help Menu Options

Universal Analy‘51s also con‘Falns a Help [ fites
menu on the main menu. This allows access Haw To?

to several different types of help. User Manual

Glozzamny

The Universal Analysis Help menu is used
to access help and product information. About Universal Analysis
Select Help from the main menu and the

menu shown here is displayed.

* Help Topics opens a table of contents specific to the current
program. See the figure on the next page for an example. You can
use the contents, index, or find functions to locate information.
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2 Univerzal Analysiz for NT Contents
File Edit Bookmark Optiohs Help

II=] B3

Help Topice  Eack | Frirt | %4

| i | See bl |

I Contents |@% Indenl i Searchl

- EQ] Introducing Universal Analpsiz
- [2] Universal Analysis for Windows N1
@ Getting aszsistance while you work,
@ Using the b ain bMenu

@ Using the Zoom Box

{ @ Tipz on Using Markers

I - Using the File Menu

- Using the Edit Menu

@ Rescaling the Graphs

@ IJzing the Graph Options

@ Analyzing Data Files

=@ Using the Tooks

@ Yiewing and Editing Reparts

@ IIzing the Macro Menus

@ Ilzing Autoanalysiz

@ Ananging the Windows

=@ Using the Help Menu

=@ Enor and Information Messages
@ Running LA from a DOS Camnmand Li

4| | F

Universal Analysis for Windows NT

Intraducing TA Instruments powerful tool for analyzing data
obtained frarn any of the following instruments:

OSC (Differential Scanning Calarimeter)
High-Terperature OTA (Differential Thermal Analyzer)
OhdA (Dynarnic Mechanical Analyzer)

SOT (Simultaneous Differential Technigue) Analyzer
TGA (Thermogravimetric Analyzer)

ThA (Thermomechanical Analyzer)

DEA (Dielectric Analyzer)

pTA (Micro Thermal Analysis)

Using Universal Analysis you take any combination of signals for
plotting and analyzing. You can select the type and number of
curves, region to be graphed, the type of transition analysis,
which transitions to analyze, and the limits of transitions.

See also

Using the Main bMenu

Figure 7.1
Help Topics

*  How To? opens an online help document that provides step-by-step
instructions on how to perform certain functions in the Universal
Analysis program.

* User Manual opens an online instructional manual that contains
step-by-step instructions on the use of the Universal Analysis

program.

*  Glossary opens an online alphabetic glossary of terms commonly

262

used in thermal analysis. See the figure on the next page.

About Universal Analysis displays the copyright notice, software
key information, and version number for your copy of Thermal
Advantage Universal Analysis.
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> 1 [Help Author On)
File Edit Bookmark Option: Help

Help Topics Hack Frint e B

struments.

Select the starting letter of the gl

A-

Select any entry listed under the letter A by clicking on the term.

Figure 7.2
TA Instruments Glossary
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Obtaining a
Printed Manual

If you wish to use a hard copy manual to learn how to use the Universal
Analysis program, you can print the manual you are viewing now by
selecting File/Print from the Acrobat Reader main menu. This displays
the default printer window and allows you to print some or all of this
manual.

If you print this entire manual, it could take some time, depending upon the speed of

NOTE:
your printer and computer.
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TA Instruments Offices

For information on our latest products and more, see our web site at:
www.tainst.com.

TA Instruments, Inc.

109 Lukens Drive

New Castle, DE 19720

Telephone: 1-302-427-4000 or 1-302-427-4040
Fax: 1-302-427-4001

HELPLINE—U.S.A.

For assistance with thermal analysis applications, please call the
Thermal Analysis Help Desk at 1-302-427-4070.
SERVICE—U.S.A.

For instrument service and repairs, please call 1-302-427-4050.

BELGIUM / LUXEMBOURG

TA Instruments a Division of Waters N.V./S.A.
Raketstraat 60 Rue de la Fusée

1130 Brussel / Bruxelles

Belgium

Phone: 32/2 706 00 80

Fax:32/2706 00 81

EUROPE

TA Instruments Ltd

Cleeve Road

Leatherhead, Surrey KT22 7UQ
United Kingdom

Phone: 44/1372360363
Fax:44/1372360135

FRANCE

TA Instruments France SARL
1-3, Rue Jacques Monod
78280 Guyancourt

France

Phone: 33/1 30 48 94 60
Fax:33/1304894 51
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GERMANY

TA Instruments Germany
Max Planck Strasse 11
63755 ALZENAU
Germany

Phone: 49/6023 96470
Fax:49/6023 964777

ITALY

Waters S.p.A.

Via Achille Grandi, 27
20090 Vimodrone (Milano),
Italy

Phone: 39/02 27421 283
Fax:39/02250 1827

JAPAN

TA Instruments Japan

No. 5 Koike Bldg.

1-3-12 Kitashinagawa

Shinagawa-Ku, Tokyo 140

Japan

Phone: 813 5479 8418 (Sales & Application)

Fax: 813 5479 7488 (Sales & Application)

Phone: 813 3450 0981 (For Service & Accounting)
Fax: 813 3450 1322 (For Service & Accounting)

THE NETHERLANDS

TA Instruments

A Division of Waters Chromatography bv
Postbus 379 / Florijnstraat 19

4870 AJ Etten-Leur

The Netherlands

Phone: 31/76 508 72 70

Fax:31/76 508 72 80

SPAIN

Waters Cromatografia S.A.
Entenza 24 Planta Baja
08015 Barcelona

Spain

Phone: 34/93 600 93 00
Fax:34/93 32598 96
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SWEDEN/NORWAY
Waters Sverige AB

TA Instruments Division

PO Box 485 Turebergsvigen 3
SE-191 24 Sollentuna

Sweden

Phone: 46/8 59 46 92 00

Fax: 46/8 59 46 92 09

AUSTRALIA

TA Instruments

C/O Waters Australia Pty. Ltd.
Unit 3, 38-46 South Street
Rydalmere NSW 2116
Australia

Phone: 6139553 0813

Fax: 61395530813
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Chapter 8

Autoanalysis

Introducing Autoanalysis

NOTE:

Autoanalysis is an option for the Universal Analysis program that is
designed to streamline the data analysis process. Using Autoanalysis you
can automatically retrieve the data files from completed experiments and
perform a predetermined analysis without operator intervention (this is
called Autoqueuing). When used in this fashion, Autoanalysis provides
increased productivity, particularly when combined with a DSC or TGA
autosampler.

Autoanalysis is based on the use of macros, which capture and store a
series of data analysis steps that are later recalled and replayed upon
command. These steps can include specialized features such as message
boxes, pauses, branching, and beeps. These features can be valuable in
the “semi-automated” mode. In a “semi-automated” mode the number of
operator interactions required to perform an analysis is reduced. The
interactions can be limited to those where operator judgment is critical
(e.g., determination of peak integration limits), or to increase the ease-of-
use (e.g., quality control using established procedures).

Autoanalyzing is the process where one or more multiple analysis records
(containing the data filename, macro filename, and applicable macro) are
added to an autoqueue and automatically processed. Analysis records
may be added to the autoqueue either from the controller or manually
through Universal Analysis (use the Macro/Autoqueue menu).

\When a macro is being executed, Universal Analysis must run in the
foreground (e.g., switching to anather program will result in an error in
the macro).

Description of Macros

Macros are created, edited, and managed within the data analysis pro-
gram. They may be executed two ways: either locally, within the
analysis program, or from the controller. You can create up to 30 macros
per macro file, each macro can contain up to 800 steps.

The macro functions provide the following features:
*  You can “capture” almost all of the functions of the data analysis

program in a macro for replay. This can include both typing
keystrokes and mouse functions.
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NOTE:
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*  You can define up to 30 available macros, each with up to 800 steps
in a macro file.

e Any step within a macro can play another macro. (Therefore, the
maximum number of steps available is actually 30 x 800 = 24,000
steps.)

*  You can edit a macro as you build it or after the macro has been
completed, without repeating all of the steps.

*  You can set up a macro to contain specialized message boxes that
ask you to make decisions as the macro runs.

*  Macro functions can be accessed at any point in the analysis
program by using the control keys shown in the menus. For
example, you can turn on the capture function by pressing Ctrl+T on
any window.

e Macros are stored as files. The default macro subdirectory for
Universal Analysis is named \TA\Macros.

Universal Analysis is shipped with two demonstration macro files -
WinUA.mac and Demo-Vxx.mac. These two files have the same con-
tents. These files are used to demonstrate the macro functions and, in
some cases, can be used with your own data files.

- If you already have a WinUA.mac file, when you installed the soft-
ware, it was not replaced by the demo WinUA.mac file, just the Demo-
Vxx.mac file was installed. You can review the macros contained in the
demo WinUA.mac file by loading this file using Macro/Load and select-
ing the file. You can then use Macro/Import to import one or more of
the demonstration macros into your own macro file.

- If you did not have a WinUA.mac file, both of the demo files will be
installed and the macros contained in the WinUA.mac file will automati-
cally be displayed in the macro menu.

Toremove these demanstration macrofiles, select Macro/Delete All or selectively
delectthe unwanted macros.

THermAL ApvanTace UniversaL ANALYSIS OPERATOR'S MIANUAL



What is a Macro Variable?

Naming Variables

Defined Variables
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Macro variables provide the ability to store, manipulate, and test numbers

inside an executing macro. Each variable can store a single floating-point

number or an array of numbers. Up to 200 macro variables and/or array
elements can be defined at one time. Three macro steps (Assign
Variable, Assign Clipboard, and Test Variable) in the Insert menu
of the Macro Editor provide access to the user defined variables.

Use the following guidelines when entering the variable names:

* Variables names can only have alphabetic characters, numbers,
underline character (underbar), and square brackets (to enclose an
optional index which must be a simple variable name or number).

*  The first character in a variable name must be alphabetic. Alphabetic

characters are not case sensitive (i.e., Capital "A" is the same as
lower case "a.")

*  The variable name cannot exceed a total of 30 characters.
Imbedded spaces are not permitted in macro variable names. A
macro variable array element is specified by following the variable
name with an array index enclosed in square brackets ("[<index>]").
The array index may be an integer constant or a simple variable
name (no index).

Examples: X, Sum, Tg35, average][i],
long_name_with_underbars, Name WithoutUnderbars,
array _name[subscript], array_name[123], data_3[index 2]

The running macro cannot have any more than 200 defined variables.
This total includes both the current macro and any macros called from
within that macro containing additional defined variables.

If a variable is never assigned a value in a running macro, then the
variable is not considered to be defined and therefore is not counted as
one of the 200 variables. Variables become defined at macro run time,
only. All previous variables are set as undefined when a macro starts
executing from the beginning.
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Using the Macros Menu

Table 8.1
Macros Menu

272

The Macros menu, which can be accessed from the Universal Analysis
main menu (shown below), contains options that let you create and edit
macros that are used to automatically analyze data files. This automatic
technique is called autoanalysis.

- - [ i
ah Univerzal Analysis o

Eile Edit Rescale Graph Analyze Tool: iew Macro: Window Help

The menu items found on the Macros menu Mew...
(shown here) or on the Macro Editor/ Open 3
Macros menu are described in the table Copy 3
below and detailed on the following pages. Import...
Delete
Delete Al
Information. .
Menu Item Description New Eile...
. Load File...
New Displays the Macro Gave File
Infprmation window, S ave File A
which allows you to enter a
name and description for Capture On  CtilT
the newest macro before Bun Ctr+R
you begin to capture the Single Step Chil+G
first step. Execute C
Stop
Open Selgct the Open menu item Macro Editor,.. CilE
to display a list of the
.. Autogueus...  Chil+
existing macros to allow

Copy

Import

you to open a different
macro to edit and/or execute.

Select the Copy menu item to copy the current
macro information into a new macro. The Macro
Information window is displayed to allow you to
rename the copied macro.

Select Import to import a macro that will be added
to the current macro file. This function displays the
Open (file) window. After you select the macro
file to open, you will see the Macro Import
window. Check the desired macro(s) to import to
the current macro file and select OK.

(table continued)
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Table 8.1
Macros Menu
(continued)

Menu Item

Description

Delete

Delete All

Information

New File

Load File

Save File

Save File As

Print

Select Delete to delete the current macro.

Select Delete All to delete all of the macros
contained in the current macro file. You can use
this option to create a new, empty, macro file by
selecting Save As, then renaming the file with a
new name.

Select Information to display the Macro Infor-
mation window for the currently open macro.

Select New File to create a new macro file. When
you select this function, a new, empty macro file is
set up in memory by deleting all currently-loaded
macros. The Save As window is displayed. Enter a
new name for your macro file, then click the Save
button. You will then be ready to create new
macros to be stored in this new macro file.

Select Load File to load a different macro file.
This function displays the Open (file) window,
allowing you to specify an existing macro file.

Select Save File to save all of the macros cur-
rently available (as seen in the list displayed next to
Macro/Open) to the current macro file.

Select Save File As to save all of the current
macros to a macro file. This option is useful when
you want to create a new macro file containing a
specific set of macros that exist in the current file.
When you select Save As, a window is displayed
that allows you to select an existing macro file or
create a new one. The filename that is shown
when the window is opened is the one that is
currently loaded.

Use this command to print a macro. This com-
mand presents a Print dialog box, where you may
specify the range of pages to be printed, the
number of copies, the destination printer, and other
printer setup options.

(table continued)
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Table 8.1
Macros Menu
(continued)

274

Menu Item Description

Print Setup Use this command to select a printer and a printer
connection. This command presents a Print Setup
dialog box, where you specify the printer and its

connection.
Capture Use the Capture On function to begin (checked)
On/Off or stop (unchecked) the capture process to build to

macro. The option toggles on and off. You can use
either the Capture On menu option or the short-
cut, Ctrl+T, to toggle the capture function on and
off. For more details see “Capturing a New
Macro.”

Run Select Run or its shortcut, Ctrl + R, to execute, or
run, the current macro. You can choose to begin at
step 1 of the macro or continue the macro from its
current position as seen in the Macro Editor
window.

Single Step Select Single Step (or its shortcut, Ctrl+G) to run
the current macro one step at a time. When you
choose Single Step, you will need to press any
key (except Escape) to proceed to the next step in
the macro. If the macro is not currently on the
first step, you have the option to go to the begin-
ning or continue the macro from its current posi-
tion.

Execute Select Execute to run (or execute) a macro that
you select from the list of macros available in the
current macro file. This function can be included
as a macro step that executes another macro
within the current macro.

Stop Select Stop (or press the Escape key) to halt the
currently executing macro. The process will stop
immediately and a confirmation message will be
displayed. To continue the macro, select Macros/
Run. A message is displayed if you are not
starting the macro from the first step. This mes-
sage allows you to execute the macro beginning at
the first step (select Yes) or from the current step
(select No).

(table continued)
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Table 8.1
Macros Menu
(continued)

Menu Item

Description

Macro Editor

NOTE:

Autoqueue

Select Macro Editor (or its shortcut, Ctrl+E) from
the Macros menu to display the Macro Editor
window for the current macro. This window
displays a list of all of the steps contained in the
macro as they are captured and provides valuable
information when you capture, view, edit, and
debug the macro steps. For more information see
“Editing a Macro.”

If the Macro Editor window gets covered up by
another window, you can bring it back to the front
by pressing Ctrl+E two times.

Use this menu item to open the Autoqueue
window, which is used to edit the autoqueue. For
more information see “What is an Autoqueue?” or
“Using the Autoqueue Menu.”
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Creating a New Macro

The first time that you create a macro requires patience along with trial-
and-error, until you are able to create a macro that will perform all of the
steps that you require, without error. Macros are based on keystrokes
and mouse actions. With this in mind, it is important to remember that the
success of a macro depends on starting the macro from the same posi-
tion, and using the same conditions that were in place when the macro
was created. Follow these basic steps to create a new macro.

1. Select Macros/New from the main menu. The Macro Information
window is displayed.

Macro Information |

W ET = || Steps: 0

D eszcription:

Figure 8.1

Macro Information Window oK Cancel Help

2. Enter a name for your macro that will help you to remember what the
macro will do if you run it (limit is 30 characters). For example: tga
analyses

3. Enter a description of the steps that will be performed in your macro
(limit 300 characters). You can recall the name and description at
any time by selecting Macros/Information from the menu, when the
macro is open.

4. Click the OK button. An almost empty Macro Editor window is

displayed (as shown
here) and the capture &¥ Macro Editor - Sample 1 | O] =]
function is automatically Macros Edit nset Help

turned on. The only step
displayed is the last step
of the macro. This step is
automatically placed in
each macro to signify the
end and cannot be
removed. IMPORTANT:
From this point on, any
operation that you
perform will be captured in your macro, unless you turn the capture
function off (use Macros/Capture On or Ctrl+T).
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Figure 8.2
Example of Finished Macro

Proceed through the steps that you want to capture in your macro.
Remember that each action you take is captured in the macro. But,
you can go back later and edit any mistakes that are captured.
IMPORTANT: Each new macro step that is captured will be
inserted between the current (highlighted) step and the next step
displayed on the Macro Editor window.

Turn off the capture function (uncheck Macros/Capture On or
press Ctrl+T again) when you have finished capturing your steps.

Edit your macro as desired. You can insert message boxes, jumps,
beeps, and other functions in your macro using the Insert menu. For
more information on editing macros, turn to “Editing a Macro.” See
the figure below for an example of a finished macro.

Test your new macro by selecting Run from the Macros menu.

s Macro Editor - tga analyses |_ O] x|

Macros  Edit  Insert Help

2 Buttan Signalz

I Select tem 4 51 Signal Weight [%]

4: Select ltem 4 %2 Signal “Weight [%]

A Select tem B2 Type Derivative [time)
6: Select tem 1 %3 Signal Mot Used

¥ Select Item 3%3 Type 2nd Deriv. [time]
3 Buttan OF. Signal Selection

3 Button Ok, D ata File Information

10 Funchion Weight Change

11 Function Cancel Curgor Input

12 Function ‘Weight Change

13 Curgor Paint 1 [52.0087, 99.9953)

14: Curzor Point 2 [264.284, 87 6621

15 Funchion Auto Curgor Limits ;I
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Toggling Between
Capture On/0ff

The Macros/Capture On function is used to begin (checked) or stop
(unchecked) the capture process to build to macro. The option toggles on
and off. You can use either the Capture On menu option or the shortcut,
Ctrl+T, to toggle the capture function on and off.

The capture function will capture the end result of the changes made to
a dialog. It will not capture the whole dialog. For more information, see

NOTE: ‘
“Tips on Capturing Macros.”

When the capture function is on, a message appears in the lower left
corner (status line) of the program to tell you that capturing is active,
which macro is currently open, and the currently selected step in the
macro.

Shortcut Keys
Ctrl+T
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Tips on Capturing Macros

The successful completion of a macro, from beginning to end, depends on
a continuous selection of steps that have a logical fit. Errors can arise due
to changes in the state of the program. Listed below are some hints to
help you produce a successful macro.

*  Macro Editor: View the Macro Editor window when creating
macros. This way you will be able to see what items are captured
and have a better understanding how this process works.

* Dialogs: The capture function will capture only the changes made
to a dialog. It will NOT capture the other selected (unchanged)
items. To ensure the 'default state' of the dialog, you may want to
select the desired items again. Many times this may involve (1)
selecting a different item then (2) reselecting the desired item. [The
extra step (1) may be deleted without affecting the macro.]

*  Program Settings, Parameters, Options, and Units: To ensure
that these settings are in the same state each time a macro is run,
capture the following sequence: Select the desired settings window,
select the Default button, then make the desired changes. You can
also insert an initialize step in your macro to make sure your setting
remain the same.

* Labels: When capturing moving or editing labels, it is important to
make these changes right after you add them to the graph (versus
after multiple analyses and annotations are displayed). The actual
label location (mouse coordinates) may change from run to run, the
previous mouse coordinates may not longer be valid. In order to
capture a step that moves a label, it must be captured immediately
using the most recent analysis result.

*  Menus: It is always more reliable to select items from the standard
menu or tool bar versus using their equivalent pop-up menu. For
example, deleting an analysis can be accomplished either using Edit/
Delete Results/Last from the standard menu or Delete Results
from the analysis pop-up menu. The former is more reliable since
exact label placement may vary from run to run.

* Filenames: When selecting specific files to be used in a macro, it is
helpful to make sure that the path listed is not one that will be subject
to change. The macro will not be able to locate a file if the path
entered is no longer accurate.
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NOTE:

280

Resolution: Changes in computer resolution may alter the ability to
perform macro steps involving mouse selection.

File Dialogs: Functions which involve saving or opening a file (e.g.,
Save Analysis, Save Session, Export Data File, etc.), when
captured in a macro routine, will stop at the file dialog and wait for
the operator to select the desired path and filename. Once this
window is dismissed the macro will proceed with the remaining
steps. (If the autoanalyze record is added to the queue from the
controller, then the macro will automatically continue on an "Open
File" step.) You can insert a filename step after a "File Open" or
"File Save" step to avoid this problem. For more information, see
“Inserting a Filename” to specify a filename.

Printing: A macro containing the File/Print and File/Print Setup
windows, will stop at these windows and wait for the operator to
make the desired selections. Once this window is dismissed the
macro will proceed with the remaining steps. [Tip: When printing to
the default printer, use the Print tool bar button instead to obtain a
continuous analysis macro because the tool bar button will not post a
Print dialog that requires a click of the OK button to proceed.]

To avoid losing your macros, periodically save them to the macro file
(default selection is made on the Main Options - Directory Page. Before
editing a macro, you may want to make a backup copy so that you canrestore the
original, if necessary.
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Editing a Macro

Macros can be edited from Macro Editor window shown in the figure
below. The editing process is normally done after you have captured the
steps that you want to include in your macro. There are several editing
functions that can be performed. Two menu options are available that
allow you to change your macro—the Edit menu or the Insert menu.
This section describes these menu options.

Figure 8.3
Macro Editor Window
(with Macro already captured)

Use care when editing a macro. Be sure that you do not remove any

&8 Macro Editor - tga analyses M= E3

Macros Edit  [nset Help

Z Button Signalz
3 Select ltem 4 %1 Signal ‘weight [%]

4: Select ke 4 %2 Signal Weight [5]

B Select lkem 52 Tupe Denvative [time]

E: Select lterm 1 %3 Signal Mot Used

¥ Select Itern 353 Type 2nd Deriv. [time]

3 Button OF Signal Selection

9 Button OF. Drata File Information

10 Function Yeight Change

11 Function Cancel Cursor [nput

12 Funchion "'eight Change

13 Curzar Paint 1 [62.0081. 99.9353)

14: Cursor Point 2 [264.234, 87 B621]

15 Function Auta Curzor Limits ﬂ

steps that are necessary to perform the desired function.

NOTE:
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Ifyour macro contains a "Jumpto step X" function, then the step number param-
eter will be modified automatically to reflect the steps deleted or added.
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Using the Macro Edit Menu

Cutting a Step

Copying a Step

282

Cuik Chrl+#
The Macro Edit menu (shown here) is used Copy Chrl+C
to copy, cut, and paste a step from one Easte Ctrl+
position to another, delete one or more steps, Delete Chil+D
or modify a step that was already captured. Select Al Chil+,
The following pages provide details on the EZ:Z:Z l;? o
steps needed to perform each one of the =
macro editing functions. Modify Step...

Watch List...

To remove a selected step from a macro and simultaneously copy it to
the clipboard for retrieval by pasting, follow these steps:

1. Ensure that the macro you want to edit is active by opening the
desired macro.

2. Select Macro Editor from the main Macros menu to display the
Macro Editor window.

3. Click on the macro step that you want to cut. To select multiple
steps, hold down the Shift key while you click on the desired series of
steps or click on a step and drag over a range of steps.

4. Select Edit/Cut from the menu (or press Ctrl+X). The step will be
cut from the current macro list of steps and copied to the clipboard
for retrieval, if desired.

To copy a step from a macro to the clipboard for retrieval by pasting,
follow these steps:

1. Ensure that the macro you want to edit is active by opening the
desired macro.

2. Select Macro Editor from the main Macros menu to display the
Macro Editor window.

3. Click on the macro step that you want to copy. To select multiple
steps, hold down the Shift key while you click on the desired series of
steps or click on a step and drag over a range of steps.

4. Select Edit/Copy from the menu (or press Ctrl+C). The step will be
copied to the clipboard for retrieval, if desired.

To copy a step from one macro to another macro, open the first macro,
copy the desired step, then open the second macro and paste the step in
at the desired position.
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Pasting a Step

To insert a macro step, which was previously copied to the clipboard
(using either Cut or Copy), into the macro at the selected place, follow
these steps:

1.

Deleting a Step

Ensure that the macro you want to edit is active by opening the
desired macro.

Select Macro Editor from the main Macros menu to display the
Macro Editor window.

Cut or copy the desired macro step. To select multiple steps, hold
down the Shift key while you click on the desired series of steps or
click on a step and drag over a range of steps.

Click on the place where you want to insert the macro step.

Select Edit/Paste from the menu (or press Ctrl+V). The step will be
copied from the clipboard at the numbered position selected.

To remove a step from a macro, follow these steps:

1.

Ensure that the macro you want to edit is active by opening the
desired macro.

Select Macro Editor from the main Macros menu to display the
Macro Editor window.

Click on the macro step that you want to delete. To select multiple
steps, hold down the Shift key while you click on the desired series of
steps or click on a step and drag over a range of steps.

Select Edit/Delete from the menu (or press Ctrl+D or press the
Delete key). The step will be removed from the macro.
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Deleting Steps From a

Certain Position to the End

Deleting All Steps

Modifying a Step

284

To remove the steps from a selected point to the end of the macro, follow

these steps:

1.

Ensure that the macro you want to edit is active by opening the
desired macro.

Select Macro Editor from the main Macros menu to display the
Macro Editor window.

Select the first step that you want to remove.

Select Edit/Delete to End from the menu. All of the steps will be
removed from the first step chosen to the end of the macro.

To remove all of the steps from a macro, follow these steps:

1.

Ensure that the macro you want to edit is active by opening the
desired macro.

Select Macro Editor from the main Macros menu to display the
Macro Editor window.

Select Edit/Delete All from the menu. All of the steps will be
removed from the macro.

You can modify macro steps that contain a text entry, insert parameter,
cursor or mouse coordinate, checkbox or radio button selection, or color
selection. You cannot, for instance, change a button selection; you must
delete, then recapture these steps.

To modify a macro step, follow these steps:

1.

Ensure that the macro you want to edit is active by opening the
desired macro.

Select Macro Editor from the main Macros menu to display the
Macro Editor window.
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3. Select the macro step you want to modify. Select Modify from the
Macro Edit menu or double click on the macro step. Depending
upon the type of step you want to modify, a specific window (see the
figures below for the different types of windows) is displayed.

4. Make the desired corrections and select OK. If you are uncertain as
to how to proceed with the corrections on these modification win-
dows, click the Help button for more information.

Macro Mouse Position Macro Curzor Position |
e IEI.EEEEEIE! T I'IEIIJ.IZI

] Cancel | Help | Q. Cancel | Help |
Macro Mouse Position Window Macro Cursor Position Window
Macro Checkbox |
, Macro Text |
~Toolbar Button Close DiataFile—————
= Uncheck
AIENSE Text: IThis iz a zample of editing text in a ma
* Check
k. Cancel | Help |
k. Cancel | Help |
Macro Checkbox Window Macro Text Window

Macro Grid | Macro Color |

Fiow: Calurnr; |'|3— Color: ----
11 |
W T
I

Macro Grid Window |

0k, Cancel | Help |

k. Cancel | Help |

Macro Color Window

Extended Text |

b Accept Limitz from the analyzsis popup menu.

k. Cancel | Help |

Macro Extended Text Window

Figure 8.4
The Different Modify Macro Windows
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Watching the Macro List

Figure 8.5

Macro Watch List Window

286

The Watch List function, selected from the Macro Edit menu is used
after you have added variables to your macros. When you select Edit/
Watch List from the Macro Editor window, a stay-on-top window is
displayed to observe the variables that occur while a macro is running.
This can help you to find out where problems exist within the macro
steps.

The Macro Watch List window permits examination and modification of
variables while a macro executes. The window is blank when it is first
opened. The variable names to be "watched" are added to the watch list
in the window. As the macro executes each step, any variables in the
watch list are updated with their current values. A right click popup
menu may be used to add and delete variable names from the list, or to
modify the current value of a variable while the macro is stopped or
single stepping. Variables which have not been assigned a value are
shown as "Undefined." If a variable is never assigned a value in a macro
then it is not considered to be one of the 200 maximum variables permit-
ted. A variable becomes defined at macro run time, only. When a macro
starts execution from the beginning of the macro, all macro variables are
initialized as undefined.

Peaktrea? = Undefined
PeakAreal = Undefined

To use this window:

1. Rightclick to display the pop-up menu. Select the desired option from
the first three items on the menu:

e Add Variable: This is used to access one variable from the list
of variables that are available within the current macro. The
Macro Watch Add Variable window is displayed to allow you to
choose from the drop-down list of variables.

e Watch Macro: This is used to access all of the variables found
in the current macro.

«  Watch All Variables: This is used to access all of the variables
found in all of the macros in the current macro file.
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2. Run the macro. As it runs the variables will be assigned values that
you can use to determine whether or not the macro is running as
desired.

3. You can delete variables (select Delete Variable or Delete All
Variables) or modify the values (select Modify Value) using the pop-

up menu, as desired.

4. Close the window when finished.
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' Iniialize...
Using the Macro Insert Menu | Dilog. .
. Bssign Clipboard. ..
The Macro/Insert menu (shown here) is used ":‘5.5“5"". Variable...
to insert a variety of special options into an Edft Cl'p_b':'ard' a
already-captured macro. EElE Bt oy
Test Variable. ..
The following pages provide details on the steps ngp. 5
. File: Marne. ..
needed to perform each one of the macro insert Eee
functions. p
Delay. ..
Carment, .,
Inserting an Initialization Step ait Ok
Wait Accept
Sometimes when you run a macro you can Clase All Files
encounter errors because the state of the Skop Macro
program has changed since the macro was ' Exit Program

created and the macro will no longer operate
correctly. You can insert a step that will open an initialization (.ini) file
into your macro to help eliminate these problems.

Before you start to capture your macro, save the program settings to an
initialization file, then load that .ini file. Insert an Initialize step using the
saved .ini file as the first step in your macro. This will eliminate problems
that can occur due to a change in settings or dialogs made before this
macro is run.

To setup your initialization step, follow these steps:
1. Select File/Options from the main menu and access the Main
Options - Initialization Page. Click the Save As button and

rename the current .ini file.

2. Select Macro/New. The Macro Information window is displayed.
Enter the macro name and description and click the OK button.

3. Select Initialize from the Macro Insert menu. The Macro Initial-
ize window is displayed.

e Macro Initiahize [_ (O]

File: IE:HF‘ngram Filezh T Instrumentz\Thermal Saolutionsiwinlls, ini

k. Browse. .. | Cancel | Help |

Figure 8.6
Macro Initialize Window
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4. Use the Browse button to locate and select the .ini file created in
step 1.

5. Click the OK button. The initialize step will be inserted as the first
step in your macro.

6. Capture and save the macro steps desired.

7. Save the macro.

Inserting Dialogs

When you create a macro, you may want to add a message box that will
help the person who runs the macro make decisions about the analysis or
display a message providing important information about the macro. For
example, a message box giving the allowable range for a specific analysis
can be displayed, allowing comparison with the experimental result just
obtained.

A dialog can be customized with several different options to make it
perform the actions you desire.

To set up your macro dialog, follow these steps:
1. Open the desired macro.

2. Select the position in the macro steps for the message box to be
inserted into.

3. Select Dialog from the Insert menu. The Macro Dialog window is
displayed.

Macro Dialog |

Dizplay text:

[ fppend clipboard [T Leadingspace [ Beep

Dialog bype: I Information ll

hMezzage responze: I ak. i I

Action: IEDntinue macro execution vI

Jurmnp step: I'I Drelay time: IW seconds
Figure 8.7 ITI Cancel | Help |

Macro Dialog Window
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Table 8.2
Macro Dialog Types

290

4. Enter the desired message text in the Text field. You can enter up to
10 lines of 60 characters each.

5. Check the Append clipboard box to append the current contexts of
the clipboard to the dialog's display text.

6. Check the Leading space box to insert a space between the display
text and any appended clipboard text.

7. Check the Beep box to sound a beep as the dialog opens.

8. Click on the drop-down list button to display a list of the Dialog

types. Select

the desired type from the table below.

Dialog Type

Description

Information

@

Confirmation

2

Warning

N

Error

Q

No Type

When you select this type of message, the word
“Information” is displayed in the title bar of the
dialog and the icon is displayed.

When you select this type of message, the word
“Confirmation” is displayed in the title bar of the
dialog and the icon is displayed.

When you select this type of message, the word
“Warning” is displayed in the title bar of the dialog
and the icon is displayed.

When you select this type of message, the word
“Error” is displayed in the title bar of the dialog and
the icon is displayed.

When you select this type of message, no icon is
displayed with your text.

9. Click on the drop-down list button to display a list of the Message
Responses to the text contained in the message. Select the desired
response from the list below.

* OK: When you select this type of response, the message dialog
will display an OK and a Cancel button. After OK has been
clicked, the chosen action will be initiated.

* Yes: When you select the “Yes” response, the message dialog
will display a Yes, No, and Cancel button. After Yes has been
clicked, the chosen action will be initiated.
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* No: When you select the “No” response, the message dialog will
display a Yes, No, and Cancel button. After No has been clicked,

the chosen action will be initiated.

* None: When you select the “None” response, no buttons will be
displayed on the message dialog. The dialog will close when the
delay time has expired or when the window is closed by clicking

in the upper right-hand corner.

NOTE: Ifthe person responding to your macro dialog chooses the buttonthat is opposite of
the response you are asking for (the expected response is Yes and they choose No)
the macro will keep on going and will not perform the action you requested for your
dialog. IfCancelis chosen onthe macro dialog, the macro will stop running at that

paint.

10. Click on the drop-down list button to display a list of the Actions that

Table 8.3
Macro Dialog Actions
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will occur after the response chosen in step 6. Select the desired
action shown in the table below. If you selected “Jump to macro
step” as your action, continue with step 8. If you do not select this
Jump type of action, skip to step 9.

Action Type

Description

Continue
macro
execution

Stop macro,
wait for run

Stop macro,
wait for
Accept Limits

Stop macro,
wait for
next OK

When you select this action, after the appropriate
response has been selected, the macro will
continue.

When you select this action, after the appropriate
response has been selected, the macro will stop
and you must select Run from the Macro menu
(or type Ctrl+R) to continue the macro.

When you select this action, after the appropriate
response has been selected, the macro will stop
and you must select the cursor limits on the curve
and accept the limits. (In this case, the dialog
replaces the standard Accept Limits function that
can be captured during an analysis.)

When you select this action the macro will stop the
running of the macro to wait for the operator to
press the OK button on a window. Once the OK
button has been pressed, the macro will continue.

(table continued)
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Table 8.3
Macro Dialog Actions
(continued)

Action Type Description

Jump to When you select this action, after the appropriate
macro start response has been selected, the macro will jump to
its first step and begin running again.

Jump to When you select this action, after the appropriate
macro end response has been selected, the macro will jump to
its last step and end.

Jump to When you select this action, after the appropriate
macro step response has been selected, the macro will jump to

a step number that you have entered in the Jump
Step field.

11. For a “Jump to macro step” action only: Type the number of the
macro step that the program will jump to, after the message response
has been clicked.

12. Check the Beep box, if you want to hear a beep when the message
response has occurred.

13. Enter the Delay Time depending upon the response chosen in step 6
as follows:

* If“None” is selected as a response in step 6, enter the desired
Delay Time that the message dialog will be displayed.

» If any response other than “None” is selected in step 6, you can
enter a nonzero Delay Time to use the response chosen after
the entered delay time has passed. You can enter a Delay Time
of zero to cause the message to be displayed indefinitely while
the program waits for a response to the dialog.

14. Select OK when completed. An example of a resulting message
dialog is shown in the figure below.

Information [ x|

zelect Accept Limits from the pop-up menu to continue

@ Pazition the analysis limits at the desired location, then
with the macra.

Figure 8.8
Example of a Resulting
Message Dialog

292 THerMAL ApvanTAGE UNivERsAL ANALYSIS OPERATOR'S MIANUAL



Inserting an Assign Clipboard Step

Figure 8.9
Assign Clipboard Window

When you create a macro, you may want to add a macro step that will
copy the current value of a macro variable and/or a text string to the
clipboard. This is useful for building custom annotations and tables that
are placed on a plot or added to a report. To copy values to the clipboard

L.

Select (highlight) the desired position (step number) for the macro
step insertion.

Select Insert/Assign Clipboard from the Macro Editor menu.
The Assign Clipboard window is displayed.

Macro Assign Clipboard x|

W aniable:
I

Significant figures: |4_ [~ Bound tointeqer

Text:

¥ Line terminator

—Action:
{* Clear clipboard before assigring value

{ Append value to existing clipboard test

Ok I Cancel | Help |

Enter a Variable name, if desired. A macro variable name may
consist of up to 30 characters. The first character must be alpha-
betic. The remaining characters may be alphabetic, digits, or the
underline (underbar) character. Imbedded spaces are not permitted
in macro variable names. A macro variable array element is speci-
fied by following the variable name with an array index enclosed in
square brackets ("[<index>]"). The array index may be an integer
constant or a simple variable name (no index).

Enter the number of Significant figures for the copied value.

Check the Round to integer box, if you want to round the value to
the nearest integer.

Enter a Text string of up to 30 characters, which will be appended to
the end of the value when it is copied. If no variable name is speci-
fied, then only the text string is copied.

Check the Line terminator box, if you want to append an optional
carriage return and line feed (<crlf>) line terminator to the copied
text.
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8. Choose an action: Select Clear clipboard before assigning value

to replace any text currently on the clipboard with the entered text.
Select Append value to existing clipboard text to append the
entered text to any text already on the clipboard.

Click OK when finished. The step will be inserted at the selected
position.

Inserting an Assign Variable Step

Figure 8.10
Macro Assign Window

294

The Assign Variable macro step is used to store a numeric value into a
macro variable. The numeric value to be assigned may come from a
numeric constant, a number already stored in another macro variable, or a
number loaded from the clipboard. The assign step can also be used to
add, subtract, multiply, or divide the value of a variable by another value,
or to apply a function (such as square root) to the value of a variable.

L.

Select (highlight) the desired position (step number) for the macro
step insertion.

Select Insert/Assign Variable from the Macro Editor menu. The
Macro Assign window (shown below) is displayed.

Enter a Variable name. A macro variable name may consist of up to
30 characters. The first character must be alphabetic. The remain-
ing characters may be alphabetic, digits, or the underline (underbar)
character. Imbedded spaces are not permitted in macro variable
names. A macro variable array element is specified by following the
variable name with an array index enclosed in square brackets
("[<index>]"). The array index may be an integer constant or a
simple variable name (no index).

Macro Assign |
Y ariable: I
Operation: I.-'l'-.ssign wvalue j
W alue: I
] Cancel Help |

4. Click on the Operation drop-down list and select the function that

will be applied to the value of the variable.

5. Enter the Value assigned to the variable.
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NOTE:

Figure 8.11

Macro Example with Variables

Ifthe operation is "Assign Clipboard (value), " then the value specifies the nth number
found onthe clipboard. If the operation is "Assign Clipboard (variable, value)" thenthe
value specifies the nth number found on the clipboard after the first occurrence of
the variable name onthe clipboard.

6. Click OK when finished. The step will be inserted at the selected
position.

Operations

Most of the operations listed in the drop-down list are straight-forward
mathematical functions. The operation “Clipboard (variable, value)” or
“Clipboard (value)” is used to copy a specific number from a list copied
to the clipboard and ignore the remaining numbers. For example, you can
first copy the parameter block from the Report Editor to the clipboard.
The first dimension of the sample size parameter can then be obtained
from the clipboard by assigning a variable named “size,” selecting “Clip-
board (value),” and entering “1” as the value.

Example:

For an example of a macro that contains an Assign Variable step and
the other steps needed to make this work, see the figure below. See step
#22 in the first example.

& Macro Editor - Test PET Peak Area =] E3
Macros  Edit Inzert Help

2 Flle MHame "C ‘-.T.-'-‘«‘-.Data'\DSE'xDsc -pet. 001"
3 Button OF. D ata File Information
4: Function Intearate Peak Linear
5 Curzor Paint 1 (126.735, -0.278528)
B Curzor Point 2 (148,307, -0.272285)
7 Wwhait For Accept Limits
9 Select Label 4
9 Mouse Dawn Right (0396825, 0.460526)
10: Function Copy Text
'|1 Agzign peak_area = Clipboard[2)
2. If peak_area > 30.0 Then Jump To Step 19
13 Dialog (Beep ‘Warmning OF. Continue] "Area too small. Ty again.”
14: Select Label 4
15 Mougze Down Right [0.331947, 0.451754)
16: Function Delete Result
17: Function Integrate Peak Linear
18: Jump To Step 7
19: Function Parameter Block Report
20 Function Select Al
21: Function Copy
220 Bezign gzize = Clipboard(size . 1)
23 Aszzign unnomalized_area = peak_area
24: Aszign unnomalized_area = unnormalized_area * size
28: Azzign Clipboard = unnormalized_area [Real 4] " " <crlf:
26: Function &innotate Plot
27: Buttan Clipboard Annotation
28 Uncheck Amow To Point
29: Button OF, Annotation
30 Curgor Point 1 [127.234, -0.506002)
: Function Accept Cursor Limits
End of Test PET Peak Area
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Inserting an Edit Clipboard Step

296

Clipboard window
(Shown to the rlght) 1s [~ &ppendclipboard [~ Leadingspace [~ Beep
displayed. [~ Horizontal Serall Bar [~ Vertical Scroll Bar
Edit field:
To use this window: Lines: [1 Columns: [10 [ Clear
. —Achion:
Enter the Dlsplay * Clear clipboard before azsigning edit text
Text to be used in the " Append edit text to existing clipboard test

The Edit Clipboard macro step is used to initialize or edit the contents of
the Windows clipboard.

If the clipboard contains text at the time that the Edit Clipboard step
is executed, then the current text is displayed in a multi-line edit field
for the user to accept or modify using the Macro Edit Clipboard
window.

If the clipboard contains no text, or if the Clear checkbox is checked,
then the edit field is cleared prior to opening the dialog. There is no
program-imposed limit on the amount of text that can be edited or
entered.

Select (highlight) the desired position (step number) for the macro
step insertion.

Select Insert/Edit Macro Edit Clipboard Ed
Clipboard from the Display text

Macro Editor menu.

The Macro Edit

dialog.

kK I Cancel Help

Check the Append
clipboard box to
append the current contexts of the clipboard to the dialog's display
text.

Check the Leading space box to insert a space between the display
text and any appended clipboard text.

Check the Beep box, if you want the beeper to sound as the dialog
opens.

Check the Horizontal Scroll Bar box, if you want the edit field to
have a horizontal scroll bar.

Check the Vertical Scroll Bar box, if you want the edit field to have
a vertical scroll bar.
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9. Enter the number of Lines to display in the edit field (this defines the
vertical size of the edit field).

10. Enter the number of Columns to display in the edit field (this defines
the Horizontal size of the edit field).

11. Check the Clear box, if you want to clear the edit field (discard any
existing clipboard text).

12. Select Clear clipboard before assigning edit text to replace any
text currently on the clipboard with the entered text. Select Append
edit text to existing clipboard text to append the entered text to
any text already on the clipboard.

13. Click OK when finished. The step will be inserted at the selected
position.

Inserting an Edit Variable Step

The Edit Variable macro step is used to initialize or edit a macro variable.

e If the variable name is already defined at the time that the Edit
Variable step is executed, then the current value is displayed in an
edit field to accept or modify.

e If the variable name is undefined, then the variable is created and
initialized to zero prior to opening the Macro Edit Variable window
The numeric value entered on the window may be an integer or a
floating-point number.

1. Select(highlight) Macro Edit ¥ariable x|
the desired position _
(step number) for  Display text:
the macro step [
insertion.  Beep
2. Select Insert/Edit iariable:
Variable from the
Macro Editor I
menu. The Macro Significant figures: |4_ [T Bound tointeger
Edit Variable
window (shown to
the right) is k. I Cancel | Help
displayed.

THermAL ApvanTAGE UNivERsAL ANALYSIS OPERATOR'S MIANUAL 297



Autoanalysis
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To use this window:

Enter the Display Text to be used in the dialog (up to a maximum of
30 characters). NOTE: If more than 30 characters of text must be
displayed, or if more than one value must be entered in a single
dialog, then consider using the Macro Edit Clipboard step instead.
After the Macro Edit Clipboard window is accepted, the individual
values that were entered can be extracted from the clipboard by
using one or more Macro Assign Variable steps, specifying Clipboard
(value) or Clipboard (variable, value) as the operation.

Check the Beep box, if you want the beeper to sound as the dialog
opens.

Enter a Variable name. A macro variable name may consist of up to
30 characters. The first character must be alphabetic. The remain-
ing characters may be alphabetic, digits, or the underline (underbar)
character. Imbedded spaces are not permitted in macro variable
names. A macro variable array element is specified by following the
variable name with an array index enclosed in square brackets
("[<index>]"). The array index may be an integer constant or a
simple variable name (no index).

Enter the number of Significant figures for the entered value.

Check the Round to integer box, if you want to restrict the user's
entry to an integer value.

Click OK when finished. The step will be inserted at the selected
position.
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Inserting a Test Variable Step

Figure 8.12
Macro Test Window

The Test Variable macro step is used to compare the current value of a
macro variable with another variable or constant for conditional branching
inside the macro. If the test condition is true then the macro will jump to
the specified next step, otherwise macro execution will continue with the
macro step immediately following the test variable step.

L.

Select (highlight) the desired position (step number) for the macro
step insertion.

Select Insert/Test Variable from the Macro Editor menu. The
Macro Test window (see below) is displayed.

Macro Test ]|
Variable: |
Conditior: | Equal to =l
Value |
dction:  [Jumptostep x| Stem [1 |
oK Cancel |  Help |

Enter the name of the Variable that will be tested for the condition.

Click on the Condition drop-down list and select the condition that will
be applied to the value of the variable.

Enter the Value to test with.

Select the type of Action that will be applied when the condition is
met from the drop-down list: Jump to start, Jump to end, or Jump to
step.

If “Jump to step” is selected, enter the number of the Step that will
jumped to.

Click OK when finished. The step will be inserted at the selected
position. See the following for an example of a completed Macro
Test window and resulting step.
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Inserting Jumps

Figure 8.13
Macro Jump Window

300

Example:

The resulting Test Variable step is displayed in the macro step worded
like this: “If peak area > 30.0 Then Jump To Step 19.” This step was
inserted in the first example macro, shown in the figure on the previous
page (step #12), to make sure that the peak area obtained during the
running of the macro is greater than 30.0.

You can insert a macro step that will jump to a different step in the
macro. This can be useful if you want the macro to repeat a step over
again or to skip a set of steps. Select the desired position for the jump
before selecting this option.

To insert a jump step into a macro follow these steps:

1. Open the desired macro.

2. Select the position that you want to insert a jump step into.

3. Select Jump from the Insert menu displayed on the Macro Editor
window. The Macro Jump window is displayed.

Macro Jump |
Jurmnp to: [ v Step: |'|
0k, Cancel | Help |

4. Select one of the following Jump To options from the drop-down list:

*  Step: When you select this option, the macro will jump to a step
number that you have entered in the Jump Step field.

» Start: When you select this action, the macro will jump to its first
step and begin running again.

* End: When you select this action, the macro will jump to its last
step and end.

5. Enter the desired step that the macro will jump to, when it is run.

6. Select OK when completed. The jump will be inserted into the macro
at the point selected.
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Inserting a File Name

Figure 8.14
Macro File
Name Window

When you want to open or save a file as part of your macro operation,
you will need to direct the program to the correct file and location. To

consistently open or save the correct file, it is best to insert a filename

and path into the macro.

Follow these steps to insert an File Name identification step into your
macro:

1. Open the desired macro.

2. Capture the desired open or save function.

3. Select the desired step position for the File Name macro step. The
position should be immediately after the “Open File” or “Save File”

step.

4. Select File Name from the Insert menu found on the Macro
Editor window. The Macro File Name window is displayed.

Macro File Hame |

" Use default file name

= File: |

[T Dwverwrnte existing file on save

Browse. .. Cancel | Help |

5. Choose one of the radio buttons: Use default file name (inserts the
default filename that is displayed when the macro runs) or File
(requires that you enter the path and filename for the desired data file
or use the Browse button to locate and select a data file).

6. Check the Overwrite existing file on save box, if you want the
system to replace the existing file with the new file that is created if

the macro performs a save file function.

7. Select OK.
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Inserting Beeps

You can setup your macro to alert the operator by inserting a beeping
sound at a certain point in the macro's operation. To insert a beep, first
select the desired step position for the beep. Then select Insert/Beep
from the Macro Editor window. The beep step will be immediately
inserted at the selected position.

To test your beeping sound, execute (or run) the macro.
Inserting Delays

You may want to customize your macro to allow some time between two
steps in the macro. This could be a delay time to allow the person running
the macro time to look at the analysis results, or time to turn on a printer,
etc. When the delay time has passed, the macro will continue.

Follow these steps to insert a Delay step into your macro:

1. Open the desired macro.

2. Select the desired step position for the Delay macro step.

3. Select Delay from the Insert menu found on the Macro Editor
window. The Macro Delay window is displayed.

Macro Delay |
Delay time: zecondsz
Figure 8.15 0K Cancel | Help |
Macro Delay Window

4. Enter the time, in seconds, that you want the macro to pause before
the next step is executed.

5. Select OK.
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Inserting a Comment

To help you understand what the macro is doing, you can add a comment
line anywhere in the currently displayed macro. Comment steps in an
executing macro are skipped over and produce no action or display. They
are for documentation purposes only.

Follow these steps to add a comment to your macro:

1.

2.

Open the desired macro.

Select the desired step position for the Comment.

Select
Insert/
Comment
from the
Macro
menu. The
Macro
Comment
window
(shown
here) is
displayed.

& Macro Comment oy ] |

Ok I Cancel Help

Enter the desired text in the comment entry field. The maximum
length of each line is 60 characters and up to 30 lines of text can be
entered for a single comment.

Click the OK button when finished. The comment is added to the
macro and is identified by “//” in front of the entered text.

Inserting a Wait OK Step

You may want your macro to stop running and wait for the operator to
give the approval to continue. To do this, select the position for the step
using the Macro Editor window. Then select Insert/Wait OK. This
will immediately insert a step that will stop the running of the macro to
wait for the operator to press the OK button on a window. Once the OK
button has been pressed, the macro will continue.

This step replaces the standard “Button OK....” step captured for a
window. If you want to post a dialog that tells the operator to make
certain selections on a window and press OK, it is best to use the Insert/
Dialog function instead of the Insert/Wait OK function. When you set
up the dialog, select “Stop macro, wait for next OK” as the action to get
the desired results. See “Inserting Dialogs” for more information.
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Inserting a Wait Accept Limits Step

You may want your macro to stop running and wait for the operator to
select analysis limits before the macro continues. To do this, select the
position for the step using the Macro Editor window. Then select
Insert/Wait Accept Limits. This will immediately insert a step that will
stop the running of the macro to wait for the operator to choose Accept
Limits from the analysis pop-up menu. Once the Accept Limits option
has been selected, the macro will continue.

This step replaces the standard “Function Accept Cursor Limits” step
captured as part of an analysis series of macro steps. If you want to post
a dialog that tells the operator to select the desired analysis limits and
select Accept Limits to continue, it is best to use the Insert/Dialog
function instead of the Insert/Wait Accept Limits function. When you
set up the dialog, select “Stop macro, wait for Accept Limits” as the
action to get the desired results. See “Inserting Dialogs” for more
information.

Inserting a Close All Files Step

Select the Close All Files option to insert a macro step that will auto-
matically close any open data files without prompting the person running
the macro. If no files are currently open, the Close All Files step will have
no effect.

This step is best placed at a point when you have finished all other
operations on the open data files and need to either open a new file or
complete the macro. If you have a macro that opens and then analyzes

and overlays a series of curves, then you can include the Close All Files
step as an easy way to close all of the open files before the macro
proceeds. You can also insert a macro dialog step before closing the files
to ask if it is acceptable to close all files.

Inserting a Stop Macro Step

304

You may decide that you want the macro to completely stop during its
execution to allow the operator to perform some action before manually
restarting the macro. To insert a stop macro step, first select the desired
step position for the stop. Then select Insert/Stop Macro from the
Macro Editor window. The stop macro step will be immediately inserted
at the selected position.

This insert option is helpful when you need to troubleshoot a problem
macro. You can temporarily put a Stop step before the suspected prob-
lem area in a macro, then continue the macro by single stepping through
the remaining steps to help you determine the cause of the problem.
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To restart the macro you can perform the run, execute, or single step
operation.

Inserting an Exit Program Step

You can insert a step in your macro that will cause the Universal Analy-
sis program to close when desired. First select the position desired for the
exit program step (usually the last step). Then select Insert/Exit Pro-
gram from the menu on the Macro Editor window. The exit program
step will be immediately inserted at the selected position. When the
macro is run, any messages that are needed, such as the option to save
any changes to the macros, will be displayed as usual.
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Running a Macro

When you have finished capturing all of the steps that you want in your
macro, you are ready to run it. The success of a macro depends on
starting the macro from the same position and using the same conditions
that were in place when the macro was created. (See “Tips on Capturing
Macros” for information.)

There are four ways to run a macro.

*  Macros/Run (Ctrl+R): Runs the current macro, as seen in the
Macro Editor window.

*  Macros/Execute: Displays a list of all of the macros contained in
the current macro file. This allows you to select one from the list.

* Macros/Single Step: Runs the current macro, as seen in the
Macro Editor window, one step at a time. You must press any key
(except Escape) to proceed to the next step.

* Autoanalyzing: Automatically runs the macro contained in the
autoqueue. See “Using Macros to Autoanalyze Data” or “What is

an Autoqueue?” in this chapter for more information.

If the macro is not at the beginning, you will see the following message:

Confirm |
The nest macra step iz nat the first step.
Do you want ko ztart with the first step?

Ho | Cancel | Help |

Choose Yes to start at the beginning of the macro or No to start the
macro from its current (highlighted) step.

NOTE: Whenamacro s being executed, Universal Analysis must runin the fareground
(e.g., switching to another program will resultin an error in the macra).

306 THerMAL ApvanTAGE UNivERsAL ANALYSIS OPERATOR'S MIANUAL



Stopping a Running Macro

To stop a running macro simply press the Escape key or select Macros/
Stop from the menu.

To restart a macro after it has been stopped, select Macros/Run or
Macros/Execute (or Macros/Single Step to move through the macro
one step at a time).

Debugging a Macro

After you have finished capturing a macro, you may run it only to find
that it does not execute the way you expected. Errors can occur with the
macro process due to the following:

* A change was made in the state of the program. A dialog or option
may have been changed and that change affects the way the
program operates.

* [Editing was done to the macro that has resulted in a now incorrect
sequence of macro steps for the current state of the program.

e An insert option is not referencing the correct step number, is
positioned in an improper place, or was inserted to replace a step that
was not removed.

*  When a macro was being executed, Universal Analysis was not run
in the foreground (e.g., switching to another program will result in an
error in the macro).

One of the ways to debug a macro is to observe the point in the macro
file where an error is reported.

e Open the macro and display the Macro Editor window. Run the
macro. If you encounter an error when the macro runs, the macro
will halt at the point of the error. The step above the highlighted one
is the step that couldn’t be executed. Make sure that the step
displayed can be conducted based on the current state of the
program.

e Temporarily insert a Stop Macro step just ahead of the problem.
When the macro execution stops, proceed through the macro, one
step at a time from the stopping point, using the Single Step function
to locate the problem. When you use the Single Step function, the
highlighted step as shown in the Macro Editor is the next step to be
executed. The executing step is the step before the highlighted one.
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*  You can also stop execution of the macro by pressing Escape when
you are close to the error point and answer "Yes" to stop the macro.
When the macro execution stops, proceed through the macro, one
step at a time from the stopping point, using the Single Step function
to locate the problem.

* An entry for every analysis record processed through the autoqueue
is recorded in the Autoqueue Log. An indicator next to the record
shows whether that record was successful (OK) or not successful

(.

Managing Macros

After a macro has been created and edited, you can take whole macros
and perform various functions with them. Most of these functions affect
the current macro file only.

The following pages provide details on how to perform the following
functions on your macros:

e Selecting/Opening a Macro

*  Copying a Macro

e Deleting a Macro

e Importing Macros

e Saving a Macro

* Loading a Different Macro File.

Selecting,/0Opening a Macro

Copying a Macro

308

Only one macro can be open at any time. To open the desired macro,
first load the desired macro file. Then select the Macros/Open to
display a list of the existing macros in the current file. Just click on the
macro you want to open and the steps will be displayed in the Macro
Editor window. Now you can add to the macro, edit it, run it, etc.

When you copy a macro using the Macros/Copy function, you are
actually duplicating the macro under a different name and description.
You cannot use this option to selectively copy steps from one macro into
another because all steps are duplicated. To copy steps from one macro
to another, use the copy and paste options in the Edit menu. To duplicate
a macro, select Macros/Copy. The Macro Information window is
displayed to allow you to rename the copied macro.
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Deleting a Macro

To remove one or more macros from a macro file, you can use one of the
following options: Macros/Delete or Macros/Delete All.

*  Macros/Delete: Select Delete to delete the current macro. A
message box is displayed to confirm removal of this macro.

*  Macros/Delete All: Select Delete All to delete all of the macros
contained in the current macro file. A message is displayed to
confirm deletion of all macros in the file. You can use this option to
create a new, empty, macro file by selecting Save As, then
renaming the file with a new name.

NOTE: If you select Save (rather than Save As) after using Delete All, you will overwrite
the current macro file with a new, empty, macrofile.

To remove only the macro steps in a selected macro, use the Edit/
Delete All function in the Macro Editor menu.
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Importing Macros

You can place macros within other macro files by importing them using
the Macros/Import option as follows:

1. Load the macro file that you want to alter.

2. Select Macro/Import to display the Open Macro File window.

Open WagroFile |
Loak in: | _4 Macros B ﬁl Be

Winla& mac
WinUaZ mac

File narne: W inUA mac Open

Files af tpe: | Macra Files [* mac) j Cancel

Help

Pl

Figure 8.16
Open Macro File Window

3. Locate the macro file that contains the macro you want to import.

4. Click OK. The Macro Import window is displayed as seen here.
Use this window to select the macro(s) that you want to import and
add to the current macro file.

Import M acros |
Select macroz to impart;
O ——————— oK
Sample Test 1
[ Autoqueus 2 Al
None
Cancel
Figure 8.17 ﬂ
Figure Macro Import Window
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NOTE:

Saving a Macro

5. Check the desired macro(s) to import. You can use the All button to
check all of the macros or the None button to uncheck all of macros.

6. Then select OK. The new macro(s) will be added to the list of
macros contained in the current file, provided there is enough room in
the macro file (30 maximum macros per file).

To view the additions, use Macros/Open or Macros/Execute to
display a pop-up list of the macros in the current file.

Universal Analysis can only open one macro file at atime. A maximum of 30
macros can be contained in any one macro file. Make sure that you do not exceed
thislimit whenimporting macros into your current macraofile.

You can save the a macro to the current macro file using one of two
options: Save or Save As.

*  Macros/Save: Select Save to save the all of the macros currently
available (as seen in the list displayed next to Macro/Open) to the
currently loaded macro file. To load a different macro file, select
Macros/Load.

* Macros/Save As: Select Save As to save all of the current macros
to a selected macro file. This option is useful when you want to
create a new macro file containing a specific set of macros that exist
in the current file. When you select Save As, a window is displayed
that allows you to select an existing macro file or create a new one.
The filename that is shown when the window is opened is the one
that is currently loaded. After using Save As, the macro file
becomes the currently-loaded macro file.

Loading a Different Macro File

If you want to load a different macro file from the one currently loaded
(the default macro file is selected on the Main Options - Directory
Page), use the Macros/Load option. When you select this function, the
Open (file) window is displayed, allowing you to specify an existing
macro file to load.
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\WWhat is an Autoqueue®?

Record

Figure 8.18
Autoqueue Window

B Autoqueue M=l &3

Autoanalyzing is the process where one or more multiple analysis
records (containing the data filename, macro filename, and applicable
macro) are added to an autoqueue and automatically processed. Analy-
sis records may be added to the autoqueue either from the controller or
manually through Universal Analysis (use the Macro/Autoqueue menu
to display the Autoqueue window).

tacro File

How the Autoqueue Works

Figure 8.19

When a record is added to the autoqueue from the controller, a message
box is displayed (see figure below) asking if you wish to process the
autoqueue (autoanalyze) at this time.

Univerzal Analyzis

There iz a new data file in the autogueue.
Co you want ko process the autogueue now'?

Mo | Help |

Process Autoqueue Message

NOTE:

312

If you select No, then the record will be added to the autoqueue, but not
processed. If you select Yes, then the record will be added to the
autoqueue and the queue will begin to process starting with the first entry.
If no response to this message box is made, after 60 seconds it will be
assumed that Yes is the response and the autoqueue will be processed.

Ifyou decide not to autoanalyze when the message is displayed, you can manually
run the autogueue using File/Run from the Autoqueue window or you can wait
untilanother record is added to the queue fromthe controller and the message is
displayedagain.
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How Autoanalysis Affects the
Universal Analysis Program

Because processing the autoqueue takes over the operation of the
Universal Analysis program, the state of that program when the auto-
queue is processed affects the way it will be handled.

* Universal Analysis Closed—If the program is closed when the
autoqueue is run, then after the last record has been processed
(autoanalyzed), the program will be closed again.

* Universal Analysis Open—If the program is open when the
autoqueue is run, then after the last record has been processed
(autoanalyzed), the program will be left open.

NOTE: ‘I To stop autoanalysis of the autoqueue, press the Escape key.
NOTE: \When amacro s being executed, Universal Analysis must runin the fareground
(e.g., switching to another program will resultin an error in the macra).

What is the Autoqueue Log?

When a record is processed through the autoqueue, it is added to the
Autoqueue Log (shown in the figure below). An indicator is displayed
with each record to let you know whether the record was processed
successfully or not. An “OK” is displayed when the record was pro-
cessed successfully and double exclamation marks “!!” are displayed
when an error was encountered. If an analysis record cannot be pro-
cessed due to an error, then the next record in the queue will be pro-

cessed.

& Repont Editor - TGA-Caox_ 007 .ntf M=l E
File Edit Insert Help

ﬁn§|ﬂ & E,“CourierNew j||1u ::IB P || ”g%
.'n ] ] 1 ] ] 1 ] ] ] ] 1 ] ] 1 ?

Universal Analy=is Autodgqueue Log File. Created &-Dec-95 14:14.

'UomCihProgram Filesh TA Instrumentsh T DatahD3ChDsc-pet.001" "C:h%Program
OK "C:\Program Files\Thi Instruments) TiyDatahD3IChDsc—per.001™ ™C:% Program
OK "C:\Program Files%Ti InstrumentshTa)DatalD3ChDac-pet. 001" "C:hProgram
OF "C:\Program Files'\Ti Instruments) TAYDatalD3ChDsc-pet.001" "C:%Program
OK "C:\Programm Files“ Tia Instrumentsh TA)Data\D3ChDsc-pet.001™ "C:% Program
OK "C:\Program Files%Ti InstrumentshTa)DatalD3ChDac-pet. 001" "C:hProgram
'rorCehProgram Filesh Th Instrumentsh TahDatahDSChDsc-pet.001™ "C:hProgram
VEorCehProgram Filesh Th Instrumentsh TAYDatalD3ChDec-pet. 001" MC:h Program
VoS Program Filesy Th Instrumentsh TayDatalD3ChDec-pet. 001" "C:h Program
'rorCehProgram Filesh Th Instrumentsh ThAhDatah TGAYTGA-Caox.001" "C:'\ Progrsm
Yoy Programw Filesh Th Instrumentsh T Datal TGAY TGA-Caox.001™ "C:\FPrograw
OFK "C:\Program Files'Ti Instruments)Ti'\Data' TGLYTGL-Caox.001"™ "C:\Progranl
. OF "C:\Program Files\Ti Instruments) TAhDatah TGAYTGA-Caox.001" "C:'\ Progrsm
Flgure 8'20 OK "C:\Programm Files' Ta Instrumentsh TA)\Data' TGAYTGA-Cacx.001" "C:%Program

Autoqueue Log . |
|Line: 17 Cal 1 [ [ Z
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How is an Autoqueue Made®?

The Thermal Advantage software can be used to create an autoqueue
file for autoanalysis of your data files in two ways—either automatic
generation of the autoqueue or manual creation of the autoqueue. The
following pages provide instructions needed for both methods.

Creating an Autoqueue Automatically

Thermal Advantage has been designed to allow you to take advantage of
a technique that can be used to completely automate the collection and
analysis of multiple data files. This Autoanalyze technique can be set up
to automatically run as follows:

(1) Create an Analysis Macro:

The first thing you need to do is to open the Universal Analysis program
to create the macro that will be used to analyze your data files. For this
macro to work successfully, it must start with an “Open File” step (File/
Open). When you create the macro you should use a file similar to the
type to be autoanalyzed (e.g., DSC, MDSC, TGA, etc.). Later, when the
experiment is complete, the autoanalysis record (containing the finished
data filenames) will be appended to the autoqueue.

(2) Set Up Autoanalysis in Instrument Control:

Open the Instrument Control program for the desired instrument. Set up
your experiment as you normally would. Access the Experimental
Parameters window (for Autosamplers, use the Sequence Page). At
the bottom of the window, check the Autoanalyze box, use the Browse
button to select the macro file desired, then select the macro you created
in step (1) above. After you have finished setting up the experiment(s)
and loaded the sample(s), start the experiment. As the controller finishes
performing the experiment, it will create the record and add it to the
autoqueue. See the Instrument Control online manual or User Reference
Guide for more information.

When a record is added to
the autoqueue from the

controller, a message box There is a new data file in the autogqueue,
(shown here) is displayed Do pou want to process the autogueus now’?
asking if you wish to process

the autoqueue (autoanalyze)
at this time. If you select

Univerzal Analysis

Ho | Help |
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No, then the record will be added to the autoqueue, but not processed. If
you select Yes, then the record will be added to the autoqueue and the
queue will begin to process starting with the first entry. If no response to
this message box is made, after 60 seconds it will be assumed that Yes is
the response and the autoqueue will be processed beginning with the first
record. The results will be collected in the Autoqueue Log.

Creating an Autoqueue Manually

You can also use existing data files to manually create and run an
autoqueue. This is a good way to take a collection of similar data files and
perform the same analysis on each one.

(1) Create an Analysis Macro:

The first thing you need to do is to open the Universal Analysis program
to create the macro that will be used to analyze your data files. For this
macro to work successfully, it must start with an “Open File” step (File/
Open). When you create the macro you should use a file similar to the
type to be autoanalyzed (e.g., DSC, MDSC, TGA, etc.). Later, when the
experiment is complete, the autoanalysis record (containing the finished
data filenames) will be appended to the autoqueue.

(2) Manually Create an Autoqueue:

Open the Universal Analysis program. Select Macros/Autoqueue to
open the Autoqueue window (shown in the figure on the next page).
This window should be empty if there are no records currently in the
autoqueue. If there are records in the autoqueue already, you can either
delete them or append your new records to the existing list.

B Autoqueue M=l &3
File Edit Help

tacro File

Figure 8.21
Autoqueue Window
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Figure 8.22

To create a new record, select Edit/Append from the Autoqueue
menu. The Autoqueue Parameters window (shown in the figure
below) is displayed. Use the Browse button to locate the first data file
you want to add to the queue. Use the second Browse button to locate
the macro file used in step (1) on the previous page. Click on the arrow
next to the list of macros and select the macro created in step (1). Click
the OK button. Your new record will be created and appended to the list
(if any) in the autoqueue. You can reorder the list of records using the
cut and paste options found in the Edit menu.

Autoqueue Parameters

b acra fi

b acro:

Cammett: I'EI-D ec-38 091324

]
NE R [ T A0 ata DS CAD 2e-pet. 00 Browse. .. |

e IE: WTaAMD ataywinllA mac Browse. ..

I.-’-‘-.utn:nqueue 1 j

k. Cancel | Help

Autoqueue Parameters Window

NOTE:

316

When you have finished adding all the records that you want, select File/
Run from the Autoqueue menu. The data files will be automatically
processed (autoanalyzed) beginning with the first record. The results will
be collected in the Autoqueue Log.

To stop autoanalysis of the autoqueue, press the Escape key.
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Using the Autoqueue File Menu

When you select Macros/Autoqueue from the Bun

main menu, the Autoqueue window is displayed. v Auto Bun
This shows you a list of the records available in the

autoqueue. You can then perform various functions Josfoic..

on these records using the Autoqueue menus, File Export...
and Edit. Use the Autoqueue Help menu to Print
access help for the autoqueue functions. The File Erint Setup...
menu (shown here) is used to perform various

functions using the entire autoqueue file Clear Log

(AutoQ.txt).

The following pages describe, in detail, what you need to do to use the
Autoqueue File functions.

Running the Autoqueue

To process (autoanalyze) the records contained in the autoqueue, begin-
ning with the first record, select File/Run from the Autoqueue window.
Each record will be processed using the data file and macro named. The
results of the analysis will be gathered into the Autoqueue Log.

NOTE: ‘I To stop autoanalysis of the autoqueue, press the Escape key.

Automatically Bunning the Autoqueue

The File/Auto Run menu item toggles on and off (check/uncheck) to
select or cancel the time out feature used for automatic processing
(autoanalysis) of the autoqueue records. The Auto Run feature works
as follows:

With Universal Analysis Open:

» If Auto Run is checked, the Autoqueue Process message that
appears (shown here), prompting you to process new records added
to the autoqueue, will automatically time out after 60 seconds and the
autoqueue records will
be processed. When you
check this option,

Universal Analysis will There iz a new data file in the autogueue.

be taken over (after the Do pou want o process the autogueue now'?
time out) to allow the

autoanalysis of the
autoqueue records.

Umiversal Analysiz

Ho | Help |
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* If Auto Run is not checked, the Autoqueue Process message that
appears, prompting you to process new records added to the
autoqueue, will not time out after 60 seconds. The message will be
displayed indefinitely, until you select either Yes or No. This allows
you to continue to work in Universal Analysis when No is the
response to the message.

With Universal Analysis Closed:

The Auto Run feature has no effect. The controller will automatically
open Universal Analysis and process the autoqueue when needed.

Importing an Autogueue File

To import records from an exported (and renamed) autoqueue file into
the autoqueue (AutoQ.txt), use the Import menu item. When you select
File/Import, the Import Autoqueue Records window is displayed.
This allows you to locate and open an exported autoqueue file. The
imported records will be appended to the bottom of the existing records.

NOTE: ‘ There can only be one autoqueue file (AutoQ.txt). Thisis why an exported autoqueue
filemust be renamed.

Import Autoqueue Records

Look irn: I _4 Data

| _|Dea bold. bt
| 10ma Z] deleteme bt
| |Dsc
| |5dt
| |Tga
| _|Tma

Filz name: |.ﬁ.utl:||1t:-:t Open

Filez af bype: I.-'l'-.utcuqueue Files [*.tat) j Cancel

Figure 8.23
Import Autoqueue
Records Window

Help

Pl
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Exporting an Autogueue File

To export the autoqueue file to save it for later recall or reuse, use the
File/Export menu item. When you select Export, an Export Auto-
queue Records window is displayed, allowing you to rename and save
the autoqueue file. (This window is very similar to the Import Auto-
queue Records window shown on the previous page.) You must
rename the exported autoqueue file because there can only be one
autoqueue file (AutoQ.txt).

To add the exported records back into the autoqueue, use the
Autoqueue File/Import menu item.

Printing the Autoqueue

Use the File/Print command to print the autoqueue records. This
command presents a Print dialog box where you may specify the range of
pages to be printed, the number of copies, the destination printer, and
other printer setup options. The format of the printed plot is determined
by the current settings for the Printer Destination on the Export Plot
window.

Print Setup for the Autoqueue

Use the File/Print Setup command to select a printer and a printer
connection. This command presents a Print Setup dialog box, where you
specify the printer and its connection.

Clearing the Autogueue Log

Use the File/Clear Log command to delete all entries in the autoqueue
log.
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Using the Autoqueue Edit Menu

When you select Macros/Autoqueue from
the main menu, the Autoqueue window is
displayed. This shows you a list of the records
available in the autoqueue. You can perform
various functions on these records using the
Autoqueue menus, File and Edit. Use the
Autoqueue Help menu to access help for the
autoqueue functions. The Edit menu (shown
here) is used to perform various editing func-
tions on the autoqueue records.

Cut Chrl+
Copy Chrl+C
Paste Chrl+4f
Faszte At End

Delete Chrl+D
Select Al Ctrl
todify....

Append...

The following pages describe, in detail, what you need to do to use the

Autoqueue Edit functions.

Cutting Autoqueue Records

To remove a selected record(s) from an autoqueue and simultaneously
copy it to the clipboard for retrieval by pasting, select Edit/Cut from the

Autoqueue window. This process of cutting and pasting can be used to

rearrange the records contained in the autoqueue. The records are
processing beginning with the first record in the list when File/Run is

selected from the Autoqueue menu.

Shortcut Keys
Ctrl+X

1. Select Autoqueue from the main Macros menu to display the

Autoqueue Window.

2. Click on the record(s) that you want to cut. (Use Edit/Select All to

cut all records.)

3. Select Edit/Cut from the menu (or press Ctrl+X). The record will be
cut from the autoqueue list and copied to the clipboard for retrieval, if

desired. (Use Paste or Paste At End to retrieve the record on the

clipboard.)
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Copying Autoqueue Records

To copy a record(s) from the autoqueue to the clipboard for retrieval by
pasting, use the Edit/Copy menu item on the Autoqueue window.

Shortcut Keys
Ctrl+C

1. Select Autoqueue from the main Macros menu to display the
Autoqueue Window.

2. Click on the record(s) that you want to copy. (Use Select All to
copy all records.)

3. Select Edit/Copy from the menu (or press Ctrl+C). The record will

be copied to the clipboard for retrieval, if desired. (Use Paste or
Paste At End to retrieve the record on the clipboard.)

Pasting Autoqueue Records

To insert a record, which was previously copied to the clipboard (using
either Cut or Copy), into the autoqueue at the selected place, use the
Edit/Copy menu item on the Autoqueue window.

Shortcut Keys
Ctrl+V

1. Select Autoqueue from the main Macros menu to display the
Autoqueue Window.

2. Cut or copy the desired record. (Use Select All to copy all records.)
3. Click on the place where you want to insert the record(s).

4. Select Edit/Paste from the menu (or press Ctrl+V). The record will
be copied from the clipboard at the numbered position selected.
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Pasting Autoqueue Records at the End

To insert the record, which was previously copied to the clipboard (using
either Cut or Copy), into the autoqueue at the end of the list of records,
use the Edit/Paste At End menu item.

1. Select Autoqueue from the main Macros menu to display the
Autoqueue Window.

2. Cut or copy the desired record(s). (Use Select All to cut/copy all
records.)

3. Select Edit/Paste At End from the menu. The record(s) will be
copied from the clipboard to the end of the list of records in the
autoqueue.

Deleting Autogqueue Records

To delete the selected record use Edit/Delete from the Autoqueue
menu. (If you want to copy a record to the clipboard rather than delete it,
use the Edit/Cut option in the Autoqueue menu.)

Shortcut Key
Delete

1. Select Autoqueue from the main Macros menu to display the
Autoqueue Window.

2. Click on the desired record to select it. (Use Select All to select all
records.)

3. Select Edit/Delete from the menu (or press the Delete key). The
record(s) will be deleted from the list of records in the autoqueue.
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Selecting All Autoqueue Records

Use the Edit/Select All option to highlight all of the records contained in
the autoqueue. You can then cut, copy, or delete all of the records.

Shortcut Key
Ctrl + A

To select all records follow these steps:

1. Select Autoqueue from the main Macros menu to display the
Autoqueue Window.

2. Choose Edit/Select All to select all records.

3. Select the desired operation from the Autoqueue Edit menu.

Modifying Autoqueue Records

To edit a record use the Edit/Modify function. You can use this option
to change the data file, macro file, or macro used in a particular record.

To modify a record, follow these steps:

1. Select Autoqueue from the main Macros menu to display the
Autoqueue Window.

2. Click on the desired record.
3. Select Edit/Modify from the menu. The Autoqueue Parameters
window is displayed to allow you to select a different data file, macro

file, or macro to be used in the record. Make the desired changes,
then click on OK.

THermAL ApvanTAGE UNivERsAL ANALYSIS OPERATOR'S MIANUAL 323



Autoanalysis

Appending Autoqueue Records

To add a record to the end of the list in the autoqueue, use the Edit/
Append function. You can use this option to change the data file, macro

file, or macro used in an appended record.

To append a record, follow these steps:

1. Select Autoqueue from the main Macros menu to display the

Autoqueue Window.

2. Select Edit/Append from the menu. The Autoqueue Parameters
window is displayed to allow you to select a different data file, macro
file, or macro to be used in the record or to add the record as it is

shown.

Autoqueue Parameters

Crata file:

Macro file: IE:"-.T.MD ataiiwfinld. mac

b acror I.ﬁ.utuqueue 1

-

Comment: IH-DEC-HE 091924

Ok

Cancel |

Browse...

X
Browse. .. |
_Browse.. |

Help

Figure 8.24
Autoqueue Parameters Window

3. Select OK when the record appears as desired, the new record will

be appended to the end of the list of records.
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Using the Autoqueue Help Menu

Universal Analysis also contains a Help menu on the Autoqueue
window. This allows access to several different types of help.

Select Help from the Autoqueue window and Help Topics
the menu shown here is displayed. Help On Autaquele

* Help Topics opens a table of contents specific to the current
program. You can use the contents, index, or find functions to locate
information.

* Help on Autoqueue displays the help available on how to use the
Autoqueue functions.
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Appending,/Modifying
Autoqueue Records

NOTE:

NOTE:

326

After you have created an Autoqueue for autoanalysis purposes, you can
go back and change the records to suit your needs. Perhaps you might
like to change the macro that the files will use or run the same files on a
different macro. You can also append a new record to the end of the
autoqueue using the steps below.

Some of these procedures have already been described inthis chapter. This
material is repeated here to show you the different ways to modify autoqueue
records.

To append or change a record, follow these steps:

1. Select Macros/Autoqueue to open the Autoqueue window. You
should see a list of the current records in the Autoqueue.

2. Select (highlight) the record you wish to change.

3. Select Edit/Modify from the menu (or select Edit/Append). The
Autoqueue Parameters window is displayed.

4. Use the Browse button to locate the first data file you want to include
in the record.

5. Use the second Browse button to locate the macro file desired.

6. Click on the arrow next to the list of macros and select the macro
desired.

7. Edit the comment text, if desired. This information is for display
purposes only. The comment usually (by default) reflects the date
and time the record was added to the autoqueue. It can be edited as
desired.

8. Click the OK button. Your record will be created or modified and
placed in the autoqueue according to the function already chosen. (A
modified record does not have a change in position. An appended
record is added to the end of the list.)

When you have finished adding/modifying all the records that you want,
select File/Run from the Autoqueue menu. The data files will be
automatically processed (autoanalyzed) beginning with the first record.
The results will be collected in the Autoqueue Log.

‘l To stop autoanalysis of the autoqueue, press the Escape key.
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About Universal Analysis 262

Accept Limit 148

Acrobat Reader 264

Adjust Results 27

All 27

Alphaat X 167

Alpha Fit X1 169

Alpha X1to X2 168

analysis
adjusting results
alphaat X 167
alpha fit X1 to X2
alpha X1 to X2
basic steps 145
curve value at X/Y 199
dimension change 170
integrate peak 171 to 181
modify size 162
using graphic finish
using graphic limits
using graphic start
using manual limits
onset point 183
oxidation time/temperature
peak max 181
purity 185, 187
partial area options 189
purity calculation page
results label page 193
results plot page 192
range 150 to 153
entering limits
full 150
selecting a cycle 151
selecting a frequency 152
removing results 213 to 214

213

169
168

166

164
165

163

184

190

150
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analysis (cont'd)

residue 161

running integral

saving 52

setting additional parameters

setting options 202 to 213
special areas 209

signal change 182

signalmax 181

slope 196

step/glass transition 155
choosing midpoint 204
choosing step change options

temperature/time at Weight %

using markers 153

weight at temperature/time

weight change 157

weight loss temperature/time

179, 197

211

205
159

160

160

Analysis pop-up menu 148

Analyze menu 147

Annotate 27

annotations 101

repositioning 102

appending

records 324, 326

area correction factor 190
Area Percent 180, 198
Arrange Icons 61

array index 293

arrow

in annotations 101
ASCII format 55
Auto Configure 124

Auto Launch 77
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Index

Auto Page axis differentiators 111
configuring 137 i
axis names
Auto Run 317 editing font 69
Auto Scale New Data 98 Axis-1,2,3, 27
Autoanalysis Axis/Axes 106
description 269
b B
autoanalysis 272
automaticmode 155, 172 baselipe
adding 50
autoqueue 269 linear 173
adding records 314 sigmoidal 174
appending records 326 sigmoidal horizontal 174
creating 314 sigmoidal tangent 175
creating automatically 314 to 315 subtracting 50
creating manually 315 types 171

cutting records 320
description 312
exporting 319

Baseline File 118

Binary format 55

file 318
how it works 312 buttons
importing records 318 setting 65

modifying 326
porcessing message 312
printing 319

processing 317 Calculate peak onset versus 207
running 317

running automatically 317
stop processing 316

C

capture on/off 278
tips on capturing 279

Autoqueue Edit Menu 320 Cascade 61
Autoqueue File Menu 317 cell constant 31, 33
Autoqueue Log 313, 316 Clipboard 140
clearing 319 Close 23
Autoqueue Parameters window 316 Close All 23
Autoqueuing 269 Close All Files

axes inserting a step in a macro 304

stacking on graph 93 close button 19

Axes Page colors
configuring 133 choosing 105 to 107
axis

transformation 123
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comments 32

Common Scale 92
context-sensitive help 261
copies 242

Copy Plot 26

copying
file settings 34
macros 308

Create PDF file 76

crystallinity
percent 209

cure
percent 210

Curve 96

curve. See also graph
labeling point 199
selecting 145

Curve Value at X/Y 199

Curves 106

curves
offseting 138
overlaying 124 to 140

rotating 121
smoothing 119

Curves Page
configuring 130

Custom Report Editor
Editmenu 245 to 254
editing parameter-type report objects
editing plot-type report objects 250
editing text-type report objects 251
example of completed report 236
Filemenu 239 to 245
Insert menu 255 to 260
inserting results report object 255
new 234
printing custom report 240
saving a template 239
settingup grid 243
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Custom Report Editor (cont'd)
setting up options 237
setting up printed report options 242
setting up program options 241 to 245
starting 234

Custom symbol list 106

D

data
analyzing for purity 187
choosing limits 45
temperature 46
with cursors 46
choosing spacing between points 106
collecting for purity analysis 186
multiplexed 49, 219
selecting amplitude 49
selecting frequency 49
set up for analysis 45 to 50
setting limits 34
showing table of 219

data file
entering information 31 to 35
graph area 19

data file window
title bar 19

data files
combining 50to 52

Data Limits 96

data limits
fullrange 46

Data Table 219
increment 219

debugging
macros 307

Delete Peak 179
Delete Results 27

Desmear 117
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differentiation
choosing 106

Digits 106

Dimension Change 170
E

Edit Amplitude List 28
Edit Frequency List 28

Edit menu
using 26

Edit menu (Report Editor) 228

editing
macros 281 to 306

Enter Limits 150
Exact Scaling X/Y 92
Exclude Data 28
executing a macro 306
Exit 25

exotherm
direction 31, 32, 34t040

expansion coefficient 169

export
plots 140
setting up options 80

Export Data File 24
Export Plot 24
Export Plot Page 80

exporting
autoqueue file 319
data files 54

F

file
copying settings 34

330

File and Plot Signals 54

File menu (Report Editor) 226
filenumber 252, 254

File Signals Only 54

files
switching between 36 to 37

Flat Buttons 65
Fly-over Help 65
font 248

Font Page 68
Font Window 71

fonts
changing 68

footer
editing font 70

format
ASCII 55
binary 55

for plot exporting 141
spread sheet 55

Full Range 150
G

General equation 209
Glass Transition 155
Glossary 262

graph. See also plot
choosing settings 105
enlarging area 89
parts of 69

graph area 19
Graph menu 95

graphs
annotating 101 to 105
customizing 89
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Grid at all ticks 106
Grid at labeled ticks 106

Grid Page
configuring 136

H

Half extrapolated tangents 205
Halfheight 204

Half minor axis tick 138
Halfwidth 205

header
editing font 69

heat capacity 42, 203
heat of fusion 186
Heat per mole 210

help 261
context-sensitive 261
fly-over type 20

Help menu 261
Help menu (Autoqueue) 325

Help menu (Report Editor) 232

Help Topics 261, 325
Hotlines 14
I

Ignore Breaks in Data 98

importing
macros 273, 310

increment 219

Inflection 155, 204

Insert menu (Report Editor) 231

inserting initialization step
macros 288 to 289

THermAL ApvanTAGE UNivERsAL ANALYSIS OPERATOR'S MIANUAL

inserting Wait OK step
macros 303

inset view
characteristics 112
creating 112to 117
settingup 114

Instrument Parameters 95

instrument parameters
modifying 41
MDSC 41

Integral 180, 197

Integrate Peak 171 to 181

Integration Weight Selection 208

inverted running integral 198

L

Label at X,)Y 201
Last 27

legend
editing font 70
repositioning 110

Legend Page
configuring 135

legends
creating 108

Letters 106
License Agreement 3
Licensing Agreement 2

limits
choosing data limits 45

line types
choosing 105to 107

Linear Transform X Axis 118

Linear Transform Y Axis 118
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linear transformation 123

loading
macros 311

M

Macro Information window 276

macros 269
capturing dialogs 279
capturing labels 279
capturing menus 279
capturing print step 280
capturing settings 279
copying 308
copying astep 282
creating a new one 276 to 278
cutting a step 282
debugging 307
deleting 309
description 269
editing 281t0306
cutting a step 282
deleting a step 283 to 284
deleting all steps 284
deleting from a step to the end 284
modifying astep 284 to 286
pasting a step 283
editingmenu 282 to 288
importing 310

inserting

assign variable 294
beeps 302

clipboard variables 293
delays 302

dialogs 28910293

dialogs, actions 291
dialogs, message responses 290
dialogs, types 290

edit clipboard step 296

edit variable step 297

exit program step 305

file names 301
initialization step 288 to 289
jumps 300

stop macro step 304

Wait OK 303
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macros (cont'd)
loading 311
managing 308
menu 272
Copy 272
Delete All 273
Import 273
Macro Editor 275
Print Setup 273
Single Step 274
Stop 274
number available 270
number of defined variables 271
opening 308
pasting a step 283
running 306 to 307
saving 311
selecting 308
stopping 307
tips on capturing 279
turning capture function on/off 278
variables 271

Macros/Save 311
Macros/Save As 311

main menu
description 19
description of options 21
using 21

Main Options
Data Page 74
Directories Page 82
Export Plot Page 80
Font Page 68
Initialization Page 84
Other Page 78
Pop-up Menu Page 67
Tool Bar Page 63

Major axis tick 138

managing
macros 308

Manual 91

manual
obtaining printed 264
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Manual Limits 148 menus

capturing filenames 279
manual mode 155, 172

) method 31, 32
Manual Onset tangent selection 206

) Method Log 222
Manual Rescaling 93

Microsoft Excel® 253
Manual Setup 124

. Microsoft Word® template 240
Manual tangent selection 202

Midpoint 203

markers
activating 154 midpoint
moving 154 choosing 204

tipsonusing 153 L
minimize button 19

maximize button 19 . o
Minor axis tick 138

maximum . .
peak 181 Modify Size 162
signal 181 modifying

MDSC autoqueue records 326
modifying instrument parameters 41 Module Type 32

phase correction 42 to 45
Multicolor table 109

menu
Analysis pop-up 148 Multicolor text 109
Analyze 147
Analyze/Options 202 N
Autoqueue Editmenu 320
Autoqueue File menu 317 No area 209
Autoqueue Help menu 325 .
Edit 21 Nogrid 106
File 21 No symbols 106
description 23
using 23 to 26 Notes, Cautions, and Warnings 15
Graph 21
using 95 0
Help 22, 261, 325
Macro Edit 282 to 288 object. See report object
Macro Insert 288 to 308
Macros 272 offset
pop-up (main) auto 138
customizing 66 Onset 155
Rescale 21
using 91 to 94 Onset Point 183
Tools 22 .
using 117 Onset/Peak Integration Page 206
View 22, 216 Open 23
Windows 22
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Index

opening a macro 308

operations
assign variable 295

operator 31, 32

options
setting up export 80
setting up print 86

Options (Graph) 97, 105
Options (Main) 24
Options menu 202

Other Page 211

Overlay 97

overlaying
curves 124 to 140
adding curves 131
options 130

Oxidation induction time (OIT) 184
Oxidation temperature (OT) 184

Oxidation Time/Temp 184
P

Parameter Block 221

parameter block
editing 58

parameters

modifying instrument 41
MDSC 41

saving for program 87

Params Same As 96
partial area analysis options 189

partial area page 189
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peak

integration 172
additional 171
deleting 179
firsttime 171
linear baseline 173
perpendicular drop 177
running integral 179
setting options for 206
setting special areas for 209
sigmoidal horizontal 174
sigmoidal tangent 175
tangent 178

onset 172

Peak Max 181

penalty factor 191
Percent crystallinity 209
Percent cure 210
Percent of axis range 138
Perpendicular Drop 177

phase correction
MDSC 42 to 45
range 43

phase lag 42, 43

plot
creating legends 108
exporting
formats used 141
toclipboard 141
heading 134
rescaling
using zoom box 89 to 90
setting up export options 80

Plot Full Range 97

Plot Heading Page
configuring 134

Plot Legend 97
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Plot Signals Only 54

point labeling 199

Poisson's Ratio

modifying instrument parameters 42

pop-up menu
cusotmizing 66

Pop-up Menu Page 67

Previous Limits 91

Print 24

print
preview 143

setting up options 86

Print Preview 25
Print Setup 25

printsetup 143

for autoqueue 319

printing
manual
plots

264
143

program
introduction 17
options 63

saving parameters 87

purge gas 44

Purity analysis 185 to 196

purity calculation page 190

R

range

analysis  150to 153

records
added to autoqueue
appending 324, 326
copying for autoqueue 321
deleting from autoqueue 322
importing 318
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records (cont'd)
modifying 323, 326
pasting to autoqueue 321, 322
printing 319
processing 316
selectingall 323

Refresh 96

Remove Analysis 23

Remove Shifts 118

Reopen 23

report
adding to one file 231
data table 219
editing text font
method log 222
parameter block 221
results of analysis 216
setting up options for custom reports
setting up options for custom spread-

sheets 243

70

242

Report Editor program
Filemenu 226
Help menu 232
Insert menu 231
menu 226
report heading 232
using 226t0233

Report Heading 232

report object
aligning 253
box 244
editing file numbers
editing font 248
editing parameters 248
editing parameters for spreadsheets
editing position 247
inserting data table report type 256
inserting data table spreadsheet type 256
inserting image type 258
inserting method log type 257
inserting normal plot type 257
inserting overlay plottype 258

252

252
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report object (cont'd)
inserting parameter report type 256
inserting parameter spreadsheet type 257
inserting results report type 255
inserting results spreadsheet type 256
inserting text type 259
locking position 254
send to back 253

rescale
reversing 90
using zoom box 89

Rescale menu
using 91to94

Residue 161

results
editing font 70

results label page 193

results labels for purity analysis 194
results plot options 192

Results Report 216

Rotate 117

rotating curves 121

running a macro 306 to 307

Running Integral 179, 197

types
area percent 197
inverted 198
normal 197
normalized 198

S

sample name 31, 32
sample size 31, 32

sample weight
modifying 162
restoring 162
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save
analysis and data 52
analysisonly 52

Save Analysis 23
Save Session 23

saving
macros 311

Select 27

Select All Labels 26
Select Cycle 151
Select Frequency 152
selecting a macro 308
Sensitivity 118

settings
copying 34

Shift 117

shifting curves 120
Show Tool Bar 65

Sig Horizontal 174

Sig Tangent 175

sigmoidal horizontal baseline 174

signal
determining maximum 181

Signal Change 182
Signal Max 181

signals
selecting 37 to 39

size
restoring 162

Slope 196
Smooth 117

smoothing 38
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smoothing interval 119 symbols (cont'd)

using incurves 111to 112
software

license 3 T

spacing

choosing 106 TA Instruments

phone numbers 14

Special Area Page 209
Tangent 178

spread sheet format 55 ] )
Temp/Time at Weight % 159

spreadsheet object 252
Temperature Base 51

spreadsheet objects 243

template
spreadsheet view 99 to 100 creating 235
characteristics 99 editing object boxes 246
copying values into rows, columns, re- editing objects 245
gions 100 example 235
modifying cell values 99 exporting report to Word 240
selecting rows, columns, regions 99 formatting 237
Stack Axes 92 tick labels

editing font 70
stacked axes

example 93 Tile 60
step change 205 Time Base 50
Step change between 203 Time of Day format 79
Step Transition 155 title bar

. data file window 19
Step Transition Page 205

. title baricon 19
Step Transition/Step Change

setting options for 202 tool bar
Custom Report Editor program 260

Step/Change Page 202 customizing 20to28, 63

stopping a macro 307 description 19
setup 63
Subcurves 106 using 20
symbol type Tool Bar Page 63
choosing 106
Tools menu
symbols using 117
choosing 105 to 107 N
editing font 70 transition
spacing phase lag 43
coarse .106 Transition Label 156
every point 106
fine 106

medium 106
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troubleshooting
macros 307

TTS Signals 54

U
Units 95
units 242

selecting 39

Universal Analysis
effect of autoanalysis 313

User Manual 262
VvV

van’t Hoff equation 185, 187

variable
definition 271, 293
naming 271
operations 295
testing 299

View menu 216

W

Wait Accept Limits

inserting in a macro step 304

Weight At Temp/Time 160
Weight Change 157
Weight Loss Temp/Time 160

window
parts of 18
Report Editor 216

window title bar 19

windows
arranging 59, 60
sizing 59
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Windows menu
using 60

X

X Axis 96

Y

Y Axis 96

y-axis

selecting 100 to 103

Year format 79

V4

zoom box
example 89
using to rescale 89

Zoom Out 91

THermAL ApvanTace UniversaL ANALYSIS OPERATOR'S MIANUAL



	Universal Analysis Operator's Manual
	TA Instruments License Agreement 
	Trademarks and Patents
	Table of Contents 
	Hotlines to TA Instruments
	Notes, Cautions, and Warnings
	Chapter 1:  Introducing Universal Analysis
	Introducing Universal Analysis
	Learning the Parts of the Windows
	Understanding the Tool Bar
	Customizing the Tool Bar

	Understanding the Main Menu
	Using the File Menu
	Using the Edit Menu

	Chapter 2: Handling Data Files
	Opening a Data File 
	Entering Data File Information
	Choosing an Exotherm Direction 

	Switching Between Open Files 
	Selecting Signals 
	Selecting Units 
	Units and Unit Conversion 
	Unit Conversions 
	DSC Area Units 
	DTA, TGA, TMA, DMA, DEA, µTA Area and Data Type Units 


	Modifying Instrument Parameters 
	Poisson's Ratio 
	Performing MDSC®  Phase Correction 
	What is Phase Correction? 
	How Do I Perform MDSC Phase Correction? 
	Choosing the Phase Correction Range 


	Setting Up Your Data for Analysis 
	Choosing Data Limits 
	Full Range (Data Limits)
	Cursor (Data Limits)
	Time (Data Limits)
	Temperature (Data Limits) 
	Cycle (Data Limits)

	Excluding Certain Data 
	Selecting a Frequency, Amplitude, Location, or Cycle 

	Adding/Subtracting Baseline Files 
	Saving Analyses 
	Exporting Data Files 
	Saving Program Sessions 
	Saving a Session 
	Recalling a Session 

	Editing Parameter Blocks
	Setting Up Windows for Display 
	Sizing Windows 
	Arranging Windows 
	Using the Windows Menu 


	Chapter 3:  Setting Program Parameters
	Introduction 
	Setting Up Your Own Tool Bar 
	Customizing the Pop-up Menu 
	Changing Fonts 
	Selecting Program Colors 
	Selecting Individual Colors 
	Selecting Color Schemes 

	Choosing Data Handling Options 
	Using the Data Compression Window 

	Selecting More Options
	Setting Up Export Options 
	Choosing Program Directories 
	Setting Program Initialization Options 
	Setting Up Print Options 
	Saving Program Parameters 

	Chapter 4:  Customizing the Graphs
	Introduction 
	Using the Zoom Box to Rescale 
	Rescaling in the X/Y Direction
	Using the Rescale Menu 
	Manual Rescaling 

	Adding a Scale Bar
	Using the Graph Menu 
	Using the Spreadsheet View
	Characteristics of the Spreadsheet View

	Selecting a Y Axis
	Annotating Graphs 
	Using the Annotation Pop-Up Menus 

	Changing Colors, Line Types, Symbols, etc. 
	Adding a Plot Header
	Creating Plot Legends 
	Using Symbols in Curves 
	Creating an Inset View
	Inset View Characteristics
	Setting Up an Inset View

	Using the Tools Menu 
	Smoothing Curves 
	Shifting Curves 
	Rotating Curves 
	Linear Transformation 

	Overlaying Curves 
	What is Curve Overlay? 
	Configuring the Auto Overlay Functions 
	Setting Up the Curve Overlay Options 
	Configuring the Curves Page 
	Configuring the Axes Page 
	Configuring the Plot Heading Page 
	Configuring the Legend Page 
	Configuring the Grid Page  
	Configuring the Auto Page  
	Results of Offset Selections 



	Exporting Plots 
	Printing Plots 
	Print 
	Print Preview 
	Print Setup 


	Chapter 5:  Analyzing the Data
	Introduction 
	Basic Analysis Steps 

	Using the Analyze Menu 
	Using the Analysis Pop-Up Menu 
	Setting the Analysis Range 
	Using the Full Range 
	Entering Limits 
	Selecting a Cycle 
	Selecting a Multiplex Value 

	Tips on Using Markers 
	Active vs. Inactive Markers 
	Moving Active Markers 
	Activating a Marker 

	Step/Glass Transition Analysis 
	Weight Change 
	Temp/Time at Weight % 
	Weight At Temp/Time 
	Weight Loss Temp/Time 
	Residue 
	Modify Size 
	Using Manual Limits to Modify Size 
	Using Graphic Limits to Modify Size 
	Using Graphic Start to Modify Size 
	Using Graphic Finish to Modify Size 

	Alpha At X 
	Alpha X1 to X2 
	Alpha Fit X1 to X2 
	Dimension Change 
	Integrate Peak 
	First Peak Integration 
	Additional Peak Integration Analyses 
	Result of the Integration Analyses 
	Linear Baseline 
	Description of Sigmoidal Baselines 
	Sigmoidal Horizontal Baselines 
	Sigmoidal Tangent Baselines 

	Extrapolated Baseline
	Perpendicular Drop Analysis 
	Tangent Analysis 
	Deleting Peak Integrations 
	Running Integral Analysis 

	Peak Max
	Signal Max 
	Signal Change
	Onset Point 
	Oxidation Time/Temp 
	Purity
	Collecting DSC Purity Data
	Guidelines for Data Collection

	Analyzing for Purity
	Selecting Purity Analysis Options
	Purity Analysis Options - Partial Area Page
	Purity Analysis Options - Purity Calculation Page
	Purity Analysis Options - Results Plot Page
	Purity Analysis Options - Results Label Page


	Slope 
	Running Integral 
	Curve Value at X/Y 
	Label at X,Y 
	Setting the Analysis Options 
	Step/Change Page 
	Choosing the Midpoint 
	Choosing the Step Change Options 

	Onset/Peak  Integration Page 
	List of Integration Weight Options

	Special Area Page 
	Resolution Page
	Other Page 

	Adjusting Analysis Results  
	Removing Analysis Results 

	Chapter 6:  Getting Reports
	Introduction 
	Obtaining the Different Reports 
	Using the View Menu 
	Getting Results Information
	Results Report 
	Results in Spreadsheet Form
	Setting Up Results Options

	Viewing Data Table Information
	Data Table Report
	Data Table in Spreadsheet Form

	Viewing the Parameter Block
	Viewing a Method Log
	Viewing the Analysis Log
	Looking at the Current Maco
	Viewing an Autoqueue Report
	Viewing an Autoqueue Log
	Using the Report Editor
	File Menu (Report Editor) 
	Edit Menu (Report Editor) 
	Finding Text 
	Replacing Text 
	Text 
	Space Separators With Tabs 
	Space Separators With Commas 


	Insert Menu (Report Editor) 
	Report Heading (Report Editor) 
	Help Menu (Report Editor) 

	Opening the Spreadsheet Program
	Creating a Custom Report Template
	Starting the Custom Report Editor Program
	Basic Instructions on Creating a Template
	Setting Up Options
	Using the Custom Report Editor File Menu
	Setting Up the Custom Report Options

	Using the Custom Report Editor Edit Menu
	Editing Box Properties for the Report Objects
	Editing Fonts for the Report Objects
	Editing Parameters for the Report Objects
	Editing Parameter-Type Report Objects
	Editing Plot-Type Report Objects
	Editng Text-Type Objects

	Editing the File Number of a Report Object
	Editing the Overlay Number of a Report Object
	Editing a Spreadsheet Report Object
	Layering the Report Objects
	Snapping Objects to the Grid
	Locking an Object's Positon

	Creating a Custom Report with Multiple Files
	Using the Custom Report Editor Insert Menu
	Inserting a Results Report Object
	Inserting a Results Spreadsheet Object
	Inserting a Data Table Report Object
	Inserting a Data Table Spreadsheet Object
	Inserting a Parameter Report Object
	Inserting a Parameter Spreadsheet Object
	Inserting a Method Log Object
	Inserting a Normal Plot Object
	Inserting an Overlay Plot Object
	Inserting an Image File Object
	Inserting a Text Object

	Using the Custom Report Editor Tool Bar


	Chapter 7:  Getting Help
	Introduction 
	Context-Sensitive Help 
	Help Menu Options 
	Obtaining a Printed Manual
	TA Instruments Offices 

	Chapter 8:  Autoanalysis
	Introducing Autoanalysis 
	Description of Macros 
	What is a Macro Variable?
	Naming Variables
	Defined Variables


	Using the Macros Menu 
	Creating a New Macro 
	Toggling Between Capture On/Off 
	Tips on Capturing Macros 
	Editing a Macro 
	Using the Macro Edit Menu 
	Cutting a Step 
	Copying a Step 
	Pasting a Step 
	Deleting a Step 
	Deleting Steps From a Certain Position to the End 
	Deleting All Steps 
	Modifying a Step 
	Watching the Macro List

	Using the Macro Insert Menu 
	Inserting an Initialization Step 
	Inserting Dialogs 
	Inserting an Assign Clipboard Step
	Inserting an Assign Variable Step
	Inserting an Edit Clipboard Step
	Inserting an Edit Variable Step
	Inserting a Test Variable Step
	Inserting Jumps 
	Inserting a File Name 
	Inserting Beeps 
	Inserting Delays 
	Inserting a Comment
	Inserting a Wait OK Step 
	Inserting a Wait Accept Limits Step 
	Inserting a Close All Files Step
	Inserting a Stop Macro Step 
	Inserting an Exit Program Step 


	Running a Macro 
	Stopping a Running Macro
	Debugging a Macro 
	Managing Macros 
	Selecting/Opening a Macro 
	Copying a Macro 
	Deleting a Macro 
	Importing Macros 
	Saving a Macro 
	Loading a Different Macro File 

	What is an Autoqueue? 
	How the Autoqueue Works 
	How Autoanalysis Affects the Universal Analysis Program 
	What is the Autoqueue Log? 

	How is an Autoqueue Made? 
	Creating an Autoqueue Automatically 
	Creating an Autoqueue Manually 

	Using the Autoqueue File Menu 
	Running the Autoqueue 
	Automatically Running the Autoqueue 
	Importing an Autoqueue File 
	Exporting an Autoqueue File 
	Printing the Autoqueue 
	Print Setup for the Autoqueue 
	Clearing the Autoqueue Log

	Using the Autoqueue Edit Menu
	Cutting Autoqueue Records 
	Copying Autoqueue Records 
	Pasting Autoqueue Records 
	Pasting Autoqueue Records at the End 
	Deleting Autoqueue Records 
	Selecting All Autoqueue Records 
	Modifying  Autoqueue Records 
	Appending Autoqueue Records 

	Using the Autoqueue Help Menu 
	Appending/Modifying Autoqueue Records 

	Index



